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CinePlex® Studio
Part of the CinePlex Behavioral Research System

CAUTION
Camera Damage
Never connect or disconnect the camera
while the power is on. The camera can be
permanently damaged.

This Guide is for use in conjunction with 
a CinePlex System integrated with an 

OmniPlex® System

 



NOTE TO CINEPLEX V1 AND V2 USERS
The V3 version of CinePlex software is not compatible with 
hardware, software, or licensing for prior versions. DO NOT 
ATTEMPT TO INSTALL V3 ON SYSTEMS RUNNING 
PRIOR VERSIONS. It will not operate correctly, or possibly, 
not at all.

Caution
Electrostatic Discharge
Some devices can be damaged by improper handling. Use 
appropriate electrostatic discharge (ESD) procedures when handling 
these devices. See http://www.esda.org/ for additional information on 
ESD procedures.

CAUTION
Camera Damage
Never connect or disconnect the camera while the power is on. 
The camera can be permanently damaged. Please note that any 
damage due to this cause is not covered by the Plexon warranty.

Caution
USB Security Key Damage

Before installing SafeNet® SentinelTM security key drivers remove 
all Sentinel USB keys from the PC. If a system driver is installed 
with a USB key in the port, the key may become unusable.

http://www.esda.org/
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This issue of the user guide incorporates the following clarifications:

• Information about infrared-blocking filters on cameras—See Chapter 1, 
CinePlex Studio Applications and Features.

• Additional details about the Use Calibration checkbox—See Chapter 3, 
Recording Video with CinePlex Studio.

• A section on monitoring dropped frames—See Chapter 3, Recording Video 
with CinePlex Studio.

• Updates to the cabling, camera mounting and troubleshooting procedures—
See Appendix A‚ Cabling Guide, Appendix B‚ Optimizing Camera Mounting 
and Lens Usage and Appendix D‚ Troubleshooting.

This issue of the user guide is based on Plexon® CinePlex® software Version 3.7. 
There are no software or hardware changes to the product. Only the user guide is 
changed.

This user guide is for use in conjunction with a CinePlex System integrated with 
an OmniPlex® System.

Plexon user guides are periodically updated and reissued, typically in conjunction 
with new software releases. You can see a summary of changes that have been 
implemented in the software by accessing the Change Log for this product on the 
Plexon website, www.plexon.com. 

CinePlex Studio User Guide publication history:

• August 2017 — CinePlex Studio v3.7 User Guide

• May 2017 — CinePlex Studio v3.7 User Guide (Studio only)

• October 2014 — CinePlex v3.5 User Guide (Studio and Editor)

• February 2010 — CinePlex v3.0 User Guide (Studio and Editor)

• February 2008 — CinePlex v2 User Guide (Studio and Editor)

Note: The CinePlex Editor v3.6 User Guide was released in December 2015.

http://www.plexon.com
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May 2017
This is the first release of the User Guide for Plexon CinePlex Studio. It is based 
on CinePlex Studio Version 3.7. Prior CinePlex User Guides contained 
information on both the Studio and Editor applications.

Starting with CinePlex System Version 3.6 and in later versions, the CinePlex 
Studio and CinePlex Editor software each have their own independent, dedicated 
installers. This was done so that the user can easily install one application without 
the other, depending on the expected usage of the target computer. Both can be 
installed on the same computer if required according to the following:

• Install the CinePlex Studio software on computers where cameras are 
connected, or where existing video files are to be retracked, or otherwise 
reprocessed.

• Install the CinePlex Editor software on computers where offline processing of 
pre-recorded video and neural data files will be done.
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1.1 Scope of this User Guide

The scope of this user guide is Plexon® CinePlex® Studio software. This 
software is part of the CinePlex Behavioral Research System (CinePlex System). 

CinePlex System Terminology

CinePlex Behavioral Research System (CinePlex System)—An integrated set of 
software and hardware components comprising the following items: 

• Two software components, CinePlex Studio and CinePlex Editor, which can 
be installed separately (or together) on a PC:

— CinePlex Studio—Software that can run in an offline mode on a 
Windows 7 PC, or can be used in an online mode on a Plexon supplied 
Windows 7 PC with the CinePlex System hardware (including one to 
four cameras) to capture video, tracking and behavioral data.

— CinePlex Editor—Software that can run on a Windows 7 PC and can be 
used as an offline tool for analyzing video and/or neural data files.

• CinePlex System hardware—A PC, one to four cameras, associated cables 
and camera mounting kits, and (optionally) a digital output (DO) unit.

The CinePlex/OmniPlex System

This user guide applies to CinePlex Systems that are integrated and synchronized 
with a Plexon OmniPlex® Neural Data Acquisition System (OmniPlex System). 
This integrated configuration is referred to as the CinePlex/OmniPlex System in 
this user guide.

Summary of Additional CinePlex System Configuration Options

Other CinePlex System configurations are available from Plexon, but these 
configurations are not in the scope of this user guide:

• CinePlex System supplied with the Plexon Multichannel Acquisition 
Processor (MAP) System.

• CinePlex System supplied with a third-party neural data acquisition (NDAQ) 
system.

• CinePlex System supplied in the standalone configuration (without an NDAQ 
system).

Note: The OmniPlex System and the MAP System are both examples of NDAQ 
systems.

Note: The capabilities of the CinePlex System are the same, regardless of the 
specific integrated NDAQ system, but some details of installation, data flow, 
usage and file management vary with different NDAQ models.
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1.2 Description and Capabilities of the CinePlex System

The CinePlex System is a video capture (recording), positional tracking and 
behavioral event research system. Using the CinePlex System and one or more 
cameras, you can capture and record video in Microsoft® standard Audio Video 
Interleaved (AVI) format. These files are compatible with Windows® Media 
Player® and many other media players.

In addition to capturing and recording video, you can also

• Track the location (2D or 3D coordinates) of the animal in each video frame

• Synchronize the captured video frames with simultaneously recorded neural 
data files

• Play the synchronized video and neural data recordings

1.3 System Hardware, Software and Cameras

This section provides an overview of the hardware and cameras supplied with the 
CinePlex System.

• Windows 7 computer and monitor(s)

• Associated cables

• Up to four cameras

• Digital output (DO) unit, supplied with the Basic Behavior license

Software

The CinePlex software is factory installed and tested on the computer supplied by 
Plexon. The flash drive with a copy of the software is also included in the 
shipment. The appropriate USB license key is also included.

Cables

For cabling connections, see Appendix A‚ Cabling Guide.

Cameras

The CinePlex System can be ordered with one to four camera assemblies of the 
models listed in Section 1.7, “CinePlex Studio Features” on page 6.

Digital Output Unit

The DO unit and digital output capability are included only with the Basic 
Behavior license. See Section 5.11, “Specifying Digital Outputs” on page 174.

1.4 Camera Repositioning

The CinePlex System allows rapid repositioning of cameras to suit the specific 
needs of each experiment. After mounting the cameras, you can enter new 
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settings for the repositioned cameras, calibrate the new arenas (if necessary) and 
proceed with the experiment. In many cases, this repositioning process and 
resetting of parameters can be accomplished in a few minutes per camera.

1.5 Overview of CinePlex Studio Features and Functions

This section describes the video capture, recording and file processing features of 
the Studio core components and options (CinePlex Tracking, CinePlex Basic 
Behavior and CinePlex 3D). This information assists the experimenter in 
selecting the components and options to use for his or her experiments. The 
figure below provides an overview of the CinePlex System functions.

CinePlex Studio can be deployed in any of the combinations listed below. You 
can select and purchase the combination that meets the needs of the experiments 
to be performed. The Tracking Option is an extension built on top of the Studio 
core function (recording). The Basic Behavior Option and 3D Option are 
extensions built on top of the Tracking Option.

• Video recording—The basic Studio function

• Video recording and tracking—Studio + Tracking Option

• Video recording, tracking and behavior monitoring—
Studio + Tracking Option + Basic Behavior Option

• Video recording and tracking in 3 dimensions—
Studio + Tracking Option + 3D Option

• Video recording, tracking in 3 dimensions and behavior monitoring—
Studio + Tracking Option + 3D Option + Basic Behavior Option

Studio

         CinePlex

Camera Mode (Online) File Mode (Offline)

Video recording

Tracking Option
(LEDs, color markers 

or whole body)

Video playback/re-record

Tracking Option
(LEDs, color markers

or  whole body) –
retrack or use original data

Basic Behavior Option 
(Automated behavioral events 

analysis)

Data extraction

Offline

Browsing of synchronously
recorded neural and/or 

video files

Manual events
creation

Basic Behavior Option 
(Automated behavioral 

events analysis)

Editor

3D Option
for calibrated files

3D Option –
calibration and tracking

Marking up neural data 
files

Note:
Editor is installed
separately
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Note: The 3D Option is described in this chapter, but detailed procedures are not 
within the scope of this document. Information about the 3D Option is available 
directly from Plexon.

The CinePlex Studio features and options described in this chapter meet the 
requirements of a wide range of experiment designs. If assistance is needed in 
determining whether the system best suited to a particular experimental design, 
please contact Plexon at +1-214-369-4957 or support@plexon.com.

1.6 CinePlex Licensing Options

The table below shows the Studio licenses and how they can be combined. 
You can view the list of licenses installed on your system by selecting About 
from the Help dropdown list then clicking on the Licensing button. Note that the 
Studio and Editor licenses are both present on all CinePlex license keys.  

It is acceptable to have some Studio options installed but not used in a particular 
experiment. The screen will display all of the optional functions, but they will not 
affect the performance of the other options.

Each Studio license can be configured (optionally) to handle up to four cameras.

CinePlex Applications 
Required

License(s) 
Required

Label on 
USB Key

Studio and Editora

a. The Studio and Editor applications are installed separately. They can 
both be installed and operating simultaneously on the PC.

CPX V3 CPX v3

Studio and Editor 
+ Tracking Option

CPX V3
CPT V3

CPX-T v3

Studio and Editor
+ Tracking Option
+ Basic Behavior Option

CPX V3
CPT V3
CPB V3

CPX-T-B v3

Studio and Editor
+ Tracking Option
+ 3D Option

CPX V3
CPT V3
3D

CPX-T-3D v3

Studio and Editor
+ Tracking Option
+ 3D Option 
+ Basic Behavior Option

CPX V3
CPT V3
3D
CPB V3

CPX-T-B-3D v3

mailto:support@plexon.com
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1.7 CinePlex Studio Features

CinePlex Studio consists of hardware and software that support capturing, digital 
video recording (DVR) and playing back the video. CinePlex Studio software, 
along with the specified hardware and at least one FireWire camera and lens, 
provides the features and functions described in this section.

• General features and functions

— CinePlex Studio is a Windows 7 application

— CinePlex Studio runs in online mode on the computer supplied by 
Plexon as part of the CinePlex/OmniPlex System

— CinePlex Studio can run on many standalone Windows computers in 
“Files” (offline) mode (i.e., analyzing files originally produced by the 
PC to which cameras are connected)

Note: The standalone computer must have minimum memory, processor 
and instruction set to run CinePlex Studio efficiently. The 
requirements for the computer are summarized in Section 1.13.2, 
“Processing and Analyzing Data” on page 14.

— In combination with the Plexon OmniPlex System, the CinePlex Studio 
functions can be synchronized with neural data recording

— CinePlex Studio hardware, when supplied as part of a CinePlex/
OmniPlex System, consists of 

– A host PC, which runs the CinePlex Studio software and the 
associated Plexon OmniPlex System software

– One or two monitors to display the CinePlex Studio and OmniPlex 
System user interfaces 

– A keyboard to allow user input such as file names

– A mouse, to control the CinePlex Studio and OmniPlex System 
software

– Associated cables and CinePlex System hardware itens

– Up to four digital cameras

– Associated cables and special CinePlex Studio hardware items

• Video

— Provides a video capture capability, which can be synchronized with 
neural recordings from the OmniPlex System

— Produces standard video AVI files in MPEG-4 format

— Allows an essentially unlimited AVI file size (Microsoft extension to 
NTFS format eliminates the 4 GB file size limit)

— Timestamps frames with the corresponding OmniPlex System times. 
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— Generates video file names that correspond to names given to 
synchronized neural data files

— Allows user-specified prefixes for filenames when recording non-
synchronized files

— Enables you to select image quality and file sizes in recordings by 
changing the nominal bit rate

— Records directly to an internal hard drive

— Supports digital imaging with up to four AVT Stingray cameras (640 x 
480 and 320 x 240 customer-selectable resolution) at up to 80 frames 
per second on each camera

— Supports digital imaging with up to four AVT Pike cameras (640 x 480 
and 320 x 240 customer-selectable resolution) at up to 200 frames per 
second on each camera

Note: Support for 200 fps on more than two cameras requires a Plexon 
prepared PC with a PLX-8 System Controller. Please contact your 
Plexon representative if you need this upgrade. (This upgrade is not 
required to run at 200 fps on one or two cameras.)

— Supports digital imaging with one AVT Pike high-resolution camera 
(960 x 960, 640 x 640 and 320 x 320 customer-selectable resolution) at 
up to 60 frames per second

— Supports near IR (infrared) recording and tracking (optionally 
available)

Note: The sensors in AVT Stingray cameras are sensitive to near infrared light. 
Therefore, for systems that will be used in the visible spectrum, Plexon 
provides cameras with an infrared-blocking filter installed. The presence of this 
filter helps the recorded colors appear more natural and realistic to the human 
eye. In Stingray cameras, the infrared filter can be removed with a special tool 
and a special procedure. In some other types of Plexon cameras, the filter 
cannot be removed. Contact Plexon Support if you would like more information 
about the cameras, lenses or filters.

• Offline computation and/or extraction of selected static and dynamic data 
from CinePlex System video files

— Reads MPEG files created by CinePlex System Version 3

— Reads MJPEG files created by CinePlex System Version 1 or 2

— Reads certain MJPEG files that were originally created by tools not 
supplied by Plexon, for example, files with either “mjpg” or “ffds” 
signatures

— Reads MJPEG files of varying resolution if both the frame width and 
frame height are multiples of 16
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— Allows re-recording of MJPEG and MPEG files in the more efficient 
MPEG-4 format resulting in file size reductions of up to 90%

— Allows selection of a time range or all of the file to be extracted

— Generates output files with user-selected content and format (for 
example, tab or comma delimited format or text)

1.8 CinePlex Tracking Option Features

CinePlex Tracking Option extends the capabilities of CinePlex Studio. It provides 
arena definition and automated tracking of an animal’s movement and position 
over time. This option supports both real-time and offline tracking capability. 

• Provides the option of calibrating the video and tracking data in inches or 
centimeters

• Features Smart Tracking that uses robust algorithms for LED tracking, object 
contour tracking, and reflective color tracking

• Allows tracking of up to 12 markers of different colors from up to four video 
streams

• Allows tracking of several markers of the same color, but differing in size, 
from up to four video streams

• Uses strobed word format to deliver tracking coordinates directly to the data 
buffer used by the OmniPlex System

• Analyzes each frame of video data to determine the positions of the objects 
being tracked, and timestamps and saves the data to files on the host PC. One 
or both of the following file types can be chosen:

— Video format (AVI)

— Digital video tracking (DVT) text format

• Analyzes contour motion across adjacent video frames, and generates data 
that experimenters can use to detect “freezing” in an animal’s movements, as 
might be used in fear-conditioning experiments
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1.9 CinePlex Basic Behavior Option Features

CinePlex Basic Behavior Option extends the capabilities of the Tracking Option 
and includes the following features for behavioral analysis and digital events:

• Allows you to define static and dynamic zones of interest within an 
experimental arena

• Allows you to define zone sequences

• Monitors objects traversing zones and sequences to generate logical and 
digital events

• Allows you to define behavioral events from one or multiple cameras to 
generate logical and digital events

• Provides real-time and offline information about behavioral events and 
tracked objects, including such attributes as speed, direction (vector), limb 

Special Conditions

Some experiments might involve challenging conditions that make it 
difficult to track an animal, for example:

Multiple animals of the same color must be tracked

The experiment involves objects that move at very high speeds so 
that they cannot be reliably tracked at the maximum frame rate 
(200 frames per second).

Tracking multiple spots on an animal is desired, but there is no 
way to apply colors (as with a fish, for example)

The camera cannot be positioned to record the animal in the 
region of interest (in a tunnel maze, for example)

The ratio of the size of the trackable arena to the size of the animal 
is such that the animal’s image is too small to be tracked or too 
large to be meaningful

Note: If the experiment requires tracking an animal in the dark (without 
LEDs), use the infrared (IR) capable camera (available from 
Plexon).

If your experiment involves any of the conditions listed above, please 
contact Plexon for assistance at +1 214-369-4957 or 
support@plexon.com.

mailto:support@plexon.com
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angles, presence in particular zones in the arena, proximity to other objects, 
sequence of zones visited, and many similar metrics.

• Monitors vectors between objects to create behavioral events when within/
outside of a customer-defined angle and tolerance

• Monitors animal head direction based on markers or LEDs on a headstage.

• Monitors animal speeds to create digital events when over/under a user-
specified threshold

• Accumulates and displays behavioral event statistics

• Allows specification of up to 24 digital outputs to be generated when specific 
behavioral events occur in the arena

Note: Digital outputs are available for external devices when the digital output (DO) 
unit is attached to a USB port on the CinePlex System PC. The digital outputs 
can be pulsed, high, or low when the event occurs (that is, when the event 
becomes TRUE).

Note: Digital output hardware is included when the Basic Behavior license is 
purchased, and the digital output capability is included only when the Basic 
Behavior license is installed

1.10 CinePlex 3D Option Features

CinePlex 3D Option extends the capabilities of the Tracking Option and includes 
the following features for three-dimensional tracking and analysis:

• Allows tracking of up to 12 markers of different colors from up to four video 
streams in three dimensions

• Allows tracking of LEDs in three dimensions

• Permits three-dimensional reconstructions both online and from files

• Includes an embedded calibration function that does not require complex 
measuring between cameras and points in the experimental area

• Allows cameras to be moved and then recalibrated in a few minutes

Note: The 3D Option is described in this chapter, but detailed procedures are not 
within the scope of this document. Information about the 3D Option is available 
directly from Plexon.

1.11 CinePlex Combined Basic Behavior Option and 3D Option

The CinePlex Basic Behavior Option and CinePlex 3D Option can both be 
installed and operating simultaneously along with the required CinePlex Tracking 
Option.
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1.12 System Architecture and Components

This section describes the architecture and components of the CinePlex/
OmniPlex System.

1.12.1 CinePlex Studio in Synchronous Operation with OmniPlex System

The following illustration shows the basic system architecture. The OmniPlex 
System provides a 1 MHz clock signal that enables CinePlex Studio to timestamp 
each video frame with a time that is synchronized with neural data timestamps.

CinePlex Studio resides on the host PC. CinePlex Studio receives the raw video 
from the camera, compresses it, and stores it as an AVI file on an internal hard 
drive of the host PC. 

The gray Timing Cable connects the OmniPlex System Timing Control Card with 
the ACCES I/O board (a digital input/output device) in the host PC. Through this 
cable, the OmniPlex System signals the CinePlex Studio application to start, stop, 
pause, and resume recording video to AVI files.

The CinePlex digital output (DO) unit, included with the Basic Behavior Option, 
connects to a USB port on the host PC and permits the Basic Behavior Option (if 
installed and licensed) to transmit digital outputs to external devices.



1  CinePlex Studio Applications and Features  

12 CinePlex Studio

1.12.2 Hardware and Software Components

The following illustration shows the major hardware and software components of 
the CinePlex/OmniPlex System. 

The components function as follows:

• OmniPlex System controls CinePlex Studio.

• CinePlex Studio controls the camera(s) and receives video from the 
camera(s). 

• CinePlex Studio writes AVI files (and, optionally, DVT or DV3 files) to file 
storage and sends coordinate data to the circular buffer where the data are 
read by PlexControl (the OmniPlex System control application). The 
CinePlex System can also send coordinate data directly to the OmniPlex 
System via a software interface (controlled by an option in the Studio user 
interface).

• The circular buffer receives coordinate data from Studio and neural data from 
the OmniPlex System server. 

• PlexControl writes PL2 (default) or PLX files, which contain both neural data 
and coordinate data, to file storage.

• CinePlex Editor reads/writes PLX and AVI files from/to file storage. 

• NeuroExplorer reads PL2 or PLX files from file storage and writes NEX files. 
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Note: CinePlex Editor is installed separately. NeuroExplorer is sold separately.

Note: Coordinate data are generated and transmitted only if the Tracking Option is 
installed with CinePlex Studio.

Note: Digital outputs (referred to in the above drawing) are associated with behavioral 
events, and are generated only if the Basic Behavior Option is installed and the 
Basic Behavior license is installed.

1.13 Data Flow, File Processing and Analysis

This section describes the flow of data in the system, and discusses methods that 
can be used for file processing and data analysis.

1.13.1 System Data Flow

The following illustration shows the data flow in a CinePlex/OmniPlex System.

The data flow proceeds as follows:

• If you have selected the AVI checkbox in the digital video recording (DVR) 
area of the Camera 1 Sources pane, CinePlex Studio writes AVI files directly 
to file storage. These AVI files have static headers, time-stamped video 
frames, and dynamic coordinate and event data. 

Note: Coordinate and event data are generated and transmitted only if the Tracking 
Option and Basic Behavior Option, respectively, are installed on the CinePlex 
System.

• If you have selected the digital video tracking (DVT) checkbox in the DVR 
area of the Camera 1 Sources pane, CinePlex Studio writes DVT files 
containing dynamic coordinate data directly to file storage. If the CinePlex 
3D Option is installed and active, DV3 coordinate data files are also written 
to file storage.
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Static headers
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• CinePlex Studio sends selected event data and coordinate data to the circular 
buffer which, in turn, sends the data to PlexControl. PlexControl writes PL2 
(default) or PLX files containing neural and CinePlex data to file storage.

1.13.2 Processing and Analyzing Data

After a recording session, you may perform data analysis on the host PC or 
transfer the files to a different computer (on which CinePlex Studio and/or 
CinePlexEditor are installed) for analysis.

Note: The standalone computer must have minimum memory, processor and 
instruction set to run CinePlex Studio efficiently. These requirements for offline 
operation are CinePlex System Version 3 software and a license key that 
enables the desired capability. However, it is important to determine that the 
computer on which the installation will be done meets the minimum system 
requirements. In general, this means a computer has a dual core Intel 

processor operating at better than 3 GHz with 3 GB of memory, and a NVIDIA® 

GeForce® 9600 GT or better video card. Requirements that are more current 
are available from Plexon Support (support@plexon.com).

With all files and software accessible on a single computer, you can process and 
analyze the data as follows:

• Use CinePlex Studio in “Files” (offline) mode to rerecord and retrack the 
original video data.

If the CinePlex Tracking Option, Basic Behavior Option and/or 3D Option 
are also installed, additional data manipulation can be performed, depending 
on the Option(s) installed. Examples of data manipulation include new or 
changed positional coordinate options, new or changed arenas, zones, and 
logical events.

• Use CinePlex Editor (installed separately) for simultaneously viewing, 
annotating, and processing the video, neural data, and position data. 

CinePlex Editor enables you to add and edit annotations and perform other 
operations on the data, such as artifact removal. When you complete the 
markup process, the results can be saved back into PLX files, or exported into 
text or CSV files. Text and CSV files can be opened in applications such as 
Excel or MATLAB for additional analysis. See the CinePlex Editor User 
Guide, available on the Plexon website.

• You can spike sort the data with Offline Sorter™, or analyze it with 
NeuroExplorer for place cell analysis, and save the results of this processing 
to another PLX file or to a NEX file. Offline Sorter software and 
NeuroExplorer software are sold separately; for more information on these 
applications, go to www.plexon.com.

http://www.plexon.com
mailto:support@plexon.com
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2.1 Installing CinePlex Studio

If the CinePlex® Studio hardware has not yet been cabled, perform the necessary 
procedures. See Appendix A‚ Cabling Guide.

In most cases, the Studio software has already been installed by Plexon®.

If assistance is needed, contact Plexon Support at +1-214-369-4957 or 
support@plexon.com.

2.2  Startup and Operational Testing

The starting sequence for a synchronized CinePlex/OmniPlex® System is 
important for correct operation of CinePlex features. If the correct sequence is not 
followed, video might not be visible or it might not be possible to control and 
synchronize CinePlex Studio with the OmniPlex System.

Follow these steps to start the system and perform an operational test.

1 Turn on power to the OmniPlex System chassis.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.

CAUTION—Startup

The startup sequence is extremely important. The OmniPlex System 
must be started before Studio is started. Otherwise, the CinePlex data 
will not be received by the OmniPlex System (and therefore not 
recorded to the PLX or PL2 file). See Section 4.6.5, “Sending Tracking 
Data to the OmniPlex System” on page 4-90.

If the OmniPlex System exits or is closed for any reason, it should be 
brought back up, then Studio should be closed and restarted, as well.

mailto:support@plexon.com
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2 Power up the computer (Host PC) and log in.

3 Plug in the SafeNet® SentinelTM license (USB key drive) into any USB port on 
the computer. 

Note: Both the OmniPlex and CinePlex licenses must be present.

4 Start the OmniPlex Server program and verify that there are no errors. The 
easiest way is to double-click the OmniPlex Server desktop icon.

If there are no problems, the OmniPlex Server main window appears.

5 Start the PlexControl program and verify that there are no errors. The easiest 
way is to double-click the PlexControl desktop icon.

The PlexControl window displays.
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6 Press the Start Data button on PlexControl toolbar.

7 Wait to ensure that the system is attempting to collect neural data. (Typically, 
at this stage, there is no neural data input, but the system Messages pane 
should report that it is collecting data - “Data Starting.”) If the Message pane 
does not have the “Data Starting” message, refer to the OmniPlex System 
instructions.

8 Start the CinePlex Studio program. The easiest way is to double-click the 
CinePlex Studio desktop icon.

9 View the monitor to see if the CinePlex Studio main window displays. If 
Camera 1 is active, the video should be displayed in the Video 1 window. (It is 
acceptable if multiple cameras are active. For example, in the image below, 
Camera 1 and Camera 2 are both active.)
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10 If proper video is observed at the monitor, it is reasonable to assume the 
camera, computer, and monitor are working correctly.

If there is a problem with the video, continue with the following steps.
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11 If the Studio main window opens in Files mode, select Cameras mode from 
the dropdown list, as shown below. Video should now be displayed on the 
Video 1 window.

Note: If the system does not display an option for Cameras mode in the 
dropdown list, it means that it has not detected a camera. See the 
appropriate information in Appendix A‚ Cabling Guide and 
Appendix D‚ Troubleshooting—“The System Starts in Files Mode 
Instead of Cameras Mode” on page D-13.

12 If the Camera 1 icon background is not orange, it is not selected. Click on this 
icon now to select it. Ensure that the background changes to orange, as 
shown below.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.
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13 If the dialog with message C900 is displayed, it means that the CinePlex 
System is not detecting a clock signal coming from the OmniPlex System. 
There can be a number of possible causes for this condition, and multiple 
ways to resolve it. See the steps in Appendix D‚ Troubleshooting.

Note: The dialog box text, above, refers to the OmniPlex System as the 
Plexon Neural Data Acquisition (NDAQ) system.
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2.3 Video Test Mode

Video test mode is provided to enable the experimenter to verify operation of the 
video portion of their experimental setup without having to activate and connect 
the OmniPlex System, prepare animals for recording, connect preamplifiers, etc. 
The license keys normally required must be present on the computer.

Starting Studio in Test mode and using Test mode features

When CinePlex Studio starts, it checks for the presence of the ACCES I/O board. 
If the ACCES I/O board is present, Studio checks for the clock signal from the 
OmniPlex System. If the ACCES I/O board is not present or if there is no clock 
signal from the OmniPlex System, the following message displays if one or more 
cameras are detected. If no camera is detected, Studio opens in Files mode 
without showing the message. 

Note: The dialog box text refers to the OmniPlex System as the Plexon Neural Data 
Acquisition (NDAQ) system.

After the OK button is pressed, the following window is displayed (if one or 
more cameras are detected):
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Click Yes to enter Test mode or No to enter Files mode.

Test mode has several restrictions compared to the normal mode:

• CinePlex Studio switches cameras to free-running mode (using their internal 
trigger), since there is no external trigger available.

• The Arm button (the red circular button with the letter “A” in the main 
toolbar) is disabled, since it is impossible to sync with the OmniPlex System.

• Recording can be done only by pressing the Record button on the toolbar.

• The duration of each recording is restricted to 1 min.
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3.1 Setting Up Cameras and the User Interface

3.1.1 Positioning the Cameras and Verifying Video Quality

1 Ensure that Cameras is selected in the video source dropdown list on the 
main toolbar. Camera setting options do not display in the main window 
unless Cameras is set in the main toolbar. If only two cameras are installed, 
the toolbar would display two camera icons, as shown in the image below.

If it is not possible to select Cameras, Studio has not detected any attached 
cameras. See Appendix D‚ Troubleshooting for troubleshooting this problem.

Note: If there are two or more cameras, the system will automatically assign 
the camera with the lowest serial number to be Camera 1. If there is 
only one camera, it is Camera 1.

2 Select the icon(s) for the camera(s) to be used in the experiment (up to four 
cameras). A camera is active only if the corresponding icon is selected. The 
orange color in the icon indicates a camera is selected. 

In the image in Step 1 above, the orange color on the Camera 1 icon shows 
that Camera 1 is active, and it can also be seen that Camera 2 is inactive. 
Clicking on the Camera 2 icon will make it active also, as shown in the image 
below.

3 Read Appendix B‚ Optimizing Camera Mounting and Lens Usage, to 
understand the detailed requirements for camera mounting, cabling and 

TIP
Consider calibration requirements
Plan the mounting of cameras with calibration in mind. Calibration of 
linear dimensions (in inches or centimeters) only works accurately when 
the camera is orthogonal to the arena.

Each of the arenas (that is, the arenas for Cameras 1, 2, 3 and/or 4) can be 
calibrated independently.

The calibration procedure is explained in Section 3.3, “Calibrating the 
Arena Dimensions” on page 30.
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removal. This information is essential for positioning the camera(s) and 

obtaining the best results from the CinePlex® System.

4 Set up one of the cameras as described in Appendix B. It is typical to set up 
Camera 1 first and mount it orthogonally to the arena.

5 Obtain an initial video image from the camera using the default CinePlex 
Studio settings and changing only the physical adjustments (iris, focus and 
zoom) on the camera lens.

Note: The settings that are available on a particular lens depend on the lens 
make and model. Not all settings are available on all models.

6 If any attached camera experiences either of the following problems, take the 
action recommended here:

a If there is no Source window pane corresponding to the camera, go to the 
Window/Layout pulldown menu and select Reset to Default Layout.

b If there is a Source window pane corresponding to the camera, but no 
video is displayed there, select the camera icon in the toolbar to make the 
camera active. (For example, see the camera icons in the image below. In 
that image, the icon for Camera 2 has not been selected, and therefore 
Camera 2 is not yet active.)

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.

TIP
Ensure that cameras are set up for optimum imaging
In general, it is best to position the camera as far from the experiment 
as possible, then zoom as much as possible in order to fill the field of 
view with the area of interest without distortion. Appendix B, 
explains how to compute the distance from the camera to the arena so 
that the whole arena is visible.



3  Recording Video with CinePlex Studio  

28 CinePlex Studio

7 If the previous steps do not result in a good image on the camera, manually 
change camera settings in CinePlex Studio. The available settings depend on 
the camera model Typically, the settings should be adjusted in this order: 
Contrast, Brightness, Sharpness, and Saturation.

8 If the above steps do not cause the video to appear, refer to Appendix D-
Troubleshooting.

9 Repeat Step 4 through Step 8 for each additional camera that will be used in 
the experiment.)

10 Calibrate the dimensions in the video field. (Calibration is accurate only when 
the camera is positioned orthogonally to the arena.)

Note: In many experiments, it is useful to calibrate the video image 
dimensions so that the ratio of centimeters to pixels (or inches to 
pixels) is known. The calibration ratio can be useful even if the 
Tracking Option is not currently installed, because the tracking data 
can be processed with the calibration data at a later time (if the 
Tracking Option is purchased). For the procedure, see Section 3.3, 
“Calibrating the Arena Dimensions” on page 30.

3.1.2 Arranging CinePlex Studio Windows

The default window layout will be sufficient for many experiments. However, to 
change the window layout, see Appendix E‚ Navigating the Plexon User 
Interface. 

To load or save a layout configuration, see "Window Menu"  in Appendix E.

TIP
Make the Video Image Larger
If the default video image is not large enough to make your desired 
adjustments, drag the video window out of its frame to another area 
on the monitor. Then adjust the window size in the normal way.

TIP
Video Test Mode
Video Test Mode enables the experimenter to verify operation of the 
video portion of the experimental setup without having to activate 

and connect the OmniPlex® System. The license keys normally 
required must be present on the computer. For the detailed procedure, 
see Section 2.3, “Video Test Mode” on page 22.
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3.2 Navigating the Studio Main Window

This section describes the CinePlex Studio main window, where you can view 
and modify Studio settings before starting the recording session.

This drawing shows the location of the panes in the CinePlex Studio main 
window. In this example, there are two cameras connected; up to four cameras 
can be licensed (optional).

TIP
Verify “Cameras” Is Selected
Camera settings do not display in the main window unless 
Cameras is set in the main toolbar.
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3.2.1 Main Toolbar Icons

The image below shows a close-up view of the CinePlex Studio main toolbar. In 
this example, there are four cameras connected and three of them are active.

3.2.2 Global Configuration Pane Settings

This pane (see the image above) is the first an experimenter will normally use 
when setting up CinePlex Studio, but perhaps not very often after that. It contains 
settings that pertain to the frame rate to use when recording, image resolution 
(quality of recordings to make), compression bit rate, and local file recording 
folder. For information about video formats and the video Quality setting, see 
Section 3.10.2, “MPEG-4 Quality and File Size” on page 71.

3.2.3 Source Pane Settings

This pane is the second an experimenter will normally use when setting up 
CinePlex Studio. There can be multiple Source panes if there are multiple 
cameras on the system. This pane contains parameters that relate to optical 
settings for each camera (contrast, brightness, sharpness, saturation, etc.), file 
output format (AVI or DVT), labeling/timestamping of frames and calibration. 
(For the calibration procedure, see Calibrating the Arena Dimensions, below.)

3.3 Calibrating the Arena Dimensions

In many experiments, it is useful to calibrate the video images from one or more 
cameras so that the ratio of centimeters to pixels (or inches to pixels) is known. 
The calibration ratio can be useful even if the Tracking Option is not currently 
installed, because the tracking data (such as the animal’s speed) can be processed 
with the calibration data at a later time (if the Tracking Option is purchased). This 
section describes how to perform the calibration procedure on an active camera. 
The calibration procedure can be repeated for any or all active cameras.
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Note:  Calibration only works accurately when the camera is orthogonal to the arena.

CinePlex Studio provides two methods of calibration - single axis (also called 
One-Bar) and dual axis (also called Two-Bar).

Calibration is the final section of the Source (Video) pane. 

Setting Up the Camera

The camera should be set up according to the instructions in Section 3.1, “Setting 
Up Cameras and the User Interface” on page 26.

Selecting Calibration Units and Type

1 Open up the Calibration section (if it is not already open) by clicking on the 
“+” sign.

2 Check the box labeled Use Calibration. Note that the title of the section 
changes from Calibration to Calibrated. This is because the current 
calibration Global Factor is now being applied.

Note: The calibration parameters are applied only if the Use Calibration 
checkbox is checked. If the box is unchecked, the system ignores the 
calibration parameters.

3 Select the unit of measure (Units) - either cm for centimeters or in. for inches.
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4 Select the method of calibration (Type) - either One-Bar or Two-Bar.

Setting Calibration Parameters with One-Bar Method

5 When One-Bar has been selected:

a Click the “+” sign next to Global Factor and then the “+” next to 
Reference Size to expand their subsections, if needed. If they are 
already shown as “-” signs, this is not needed.

b If the current color in the box next to the Color item will not provide good 
contrast with the video image, click in the box and select a suitable color. 
The color selected is the color of the measurement bar used for 
calibration.
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c Choose a feature in the experimental area whose video image extends 
over much of the field of view. As an illustration, the inside diameter of the 
clock frame in the image below will be used as the desired dimension.

d Measure its longest dimension in the units desired, and record it for 
reference. The inside diameter of the clock frame measured 30.5 cm.

e Click the Adjust button. The cursor will go to the video image and a line 
will appear in the color selected. Select one end of the colored line and 
move it to one end of the feature just measured. Select the other end of 
the line and move it to the other end of the feature.
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In the image above note the green line through the middle of the clock with 
the box on each end. This is the sizing bar.

In the above image note that the left end of the sizing bar has been moved to 
the inside edge of the clock’s frame. Select the other end of the sizing bar and 
move it to the opposite inside edge of the clock frame and ensure the sizing 
bar crosses the intersection of the clock hands.
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In the above image note that the sizing bar now measures the inside diameter 
of the clock’s frame.

f Right-click to record the length of the bar in pixels.

g Go to the slider next to the Actual item and move it so that it reads the 
dimension recorded above. Studio is now calibrated to the measured 
distance. The arrow keys may be used for fine adjustments to the slider 
positions.

In the image above note that the Actual setting has been changed to the 
measured inner diameter of the clock’s frame (30.5 cm).

h Click all three “-” signs once the adjustment is satisfactory to hide the 
adjustments.

i If you have not already done so, be sure to click the Use Calibration 
checkbox. Be aware that the positional coordinates will be extracted from 
the AVI file in pixels if the Use Calibration checkbox was not checked 
during recording. See the examples below. 
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j After the parameters are set as desired, on the File menu, click Save 

Settings, or click the Save Settings button ( ) on the toolbar.

Setting Calibration Parameters with Two-Bar Method

6 When Two-Bar has been selected:

a Click the “+” sign next to Horizontal Factor and then the “+” next to 
Reference Size to expand their subsections, if needed. If they are 
already shown as “-” signs, this is not needed.
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b If the current color in the box next to the Color item will not provide good 
contrast with the video image, click in the box and select a suitable color.

c Choose a horizontal feature (horizontal relative to the video image) in the 
experimental area whose video image extends over much of the field of 
view. Once again the inner diameter of the clock’s frame will be used.

d Measure the feature’s horizontal dimension in the units desired, and 
record it for reference. In this example, the width is 41.0 cm.

e Click the Adjust button in the Horizontal section. The cursor will go to the 
video image and a horizontal line will appear in the color selected.
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In the image above note the green line with the box on each end. This is the 
sizing bar.

f Select the horizontal sizing bar and move it vertically so that it rests on the 
desired feature in the frame (in this example, it will be moved to the center 
of the disk). Select one end of the sizing bar and move it over the desired 
feature in the image. Repeat this process for the other end of the sizing 
bar. In this example, the ends of the sizing bar will be placed at the edges 
of the plastic case.

In the above image note that the sizing bar now measures the horizontal width 
of the plastic case.

g Right-click to record the length of the bar in pixels.
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h In the row labeled Actual, double click on the number and enter the 
actual dimension of the object under the sizing bar (41.0 cm in this 
example). 

i Click the “+” sign next to the Vertical Factor and then the “+” next to 
Reference Size to expand their subsections, if needed. If they are 
already shown as “-” signs, this is not needed.

j If the current color in the box next to the Color item will not provide good 
contrast with the video image, click in the box and select a suitable color.
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k Choose a vertical feature (vertical relative to the video image) in the 
experimental area whose video image extends over much of the field of 
view. In this example, the height of the plastic case will be measured.

l Measure the feature’s vertical dimension in the units desired, and record it 
for reference. In this example, the height of the plastic case is 31.9 cm.

m Click the Adjust button in the Vertical section. The cursor will go to the 
video image and a line will appear in the color selected.

In the image above note the vertical green line with a box at each end. This 
line is the sizing bar.

n Select the vertical sizing bar and move it horizontally so that it rests on the 
desired feature in the frame (in this example, it will be moved to the center 
of the disk). Select one end of the sizing bar and move it over the desired 
feature in the image. Repeat this process for the other end of the sizing 
bar. In this example, the ends of the sizing bar will be placed at the edges 
of the plastic case.
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o Right-click to record the length of the bar in pixels.

p In the row labeled Actual, double click on the number and enter the 
actual dimension of the object under the sizing bar (31.9 cm in this 
example). 

Now the system has been calibrated in both horizontal and vertical directions. 
Note that the horizontal and vertical factors are slightly different in this 
example. This situation typically occurs if the camera is not orthogonal to the 
plane of the object that was measured during the calibration. The system 
uses the horizontal and vertical factors to provide a more accurate calibration 
(versus a one-bar calibration).

q Click all five “-” signs once the adjustments are satisfactory if you want to 
hide the adjustments.

r If you have not already done so, be sure to click the Use Calibration 
checkbox. Be aware that the positional coordinates will be extracted from 
the AVI file in pixels if the Use Calibration checkbox was not checked 
during recording. See the examples below. 
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s After the parameters are set as desired, on the File menu, click Save 

Settings, or click the Save Settings button ( ) on the toolbar.
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3.4 Recording Synchronized Video Tracking and Neural Data

This section explains how to record video and tracking data that is time-locked 
(synchronized) with neural data from the OmniPlex System. This procedure 
requires starting and stopping the CinePlex Studio video recording process 
remotely from the OmniPlex System. This method of triggering the recording 
ensures that:

• The timestamps in the CinePlex and OmniPlex files are derived from the 
same clock

• The CinePlex and OmniPlex file start times and stop times are synchronized

• The CinePlex frame numbers and timestamps are synchronized

Simultaneous starting, stopping, pausing, and resuming of the neural data and 
video files is essential in helping the researcher correlate the behaviors captured 
in the video with the observed neural activity.

Although you can manually start, stop, pause, and resume recording an AVI file 
at any time in CinePlex Studio by simply clicking the appropriate toolbar buttons, 
this method will not record synchronized files, because it produces video files 
that do not have the same start time as the corresponding neural data files.

Note: If the animal is being trained prior to the collection of neural data, the CinePlex 
System can record AVI and/or DVT files without the existence of neural data 
files. In that case, the OmniPlex System is used only as a clock source for the 
CinePlex System. The procedure for that case is provided in Section 3.8, 
“Recording Video without Neural Data (Used for Animal Training)” on page 56.

Procedure

Perform these steps to record synchronized video and neural data. 

The steps must be followed in the sequence listed here. If they are not performed 
in order, it will not be possible to create a synchronized recording of video and 
neural data.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.

CAUTION
Lighting Conditions
If lighting conditions change enough during recording that ‘objects 
too large’ or some other condition occurs, the position data may be 
meaningless.
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1 Ensure that the system is connected as described in Chapter 2, Installing, 
Starting and Testing CinePlex Studio.

2 At the OmniPlex System chassis, turn the power on and start the OmniPlex 
Server and PlexControl.

3 If not already done, configure the OmniPlex System.

4 Click the Start Data button in the PlexControl toolbar so that neural data 
acquisition begins, and the neural data appears in PlexControl display. (This 
action also starts the OmniPlex System 1 MHz clock.)

5 Double-click the CinePlex Studio icon ( ). Wait for the CinePlex Studio 
application main window to appear on the monitor.

Note: If Studio does not detect the OmniPlex clock, an error message will 
appear. If it does, see Appendix D-Troubleshooting.

6 Verify that Cameras is selected in the Studio dropdown list and that a camera 
image is displayed for each of the camera(s) that will be used in the 
experiment. The image is displayed for each camera icon that is selected. 
The image below shows that both Camera 1 and Camera 2 are selected 
(indicated by the orange color of the icons).

7 If there is an appropriate file containing all the desired CinePlex settings, load 

the file onto the CinePlex System using the Load Settings icon ( ) on the 
main toolbar or the File/Load Settings menu selection.

8 Click on the Global Config tab in the static configuration pane to display the 
Global Config pane. 

Note: This pane is the first an experimenter will normally use when setting 
up CinePlex Studio, but perhaps not very often after that. It contains 
settings that pertain to the frame rate to use when recording, image 
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resolution (quality of recordings to make), compression bit rate and 
local file recording folder. For information about video formats and the 
video Quality setting, see Section 3.10.2, “MPEG-4 Quality and File 
Size” on page 71.

9 View the settings in the Global Config pane and modify any that need to be 
changed prior to starting the next recording session.

10 To browse for the desired file location (where the recorded files will be saved), 
click on the browse icon, which is the rectangle with three dots on the Rec 
Folder row of the Global Config pane.

11 When the Browse For Folder dialog box appears, use standard Windows® 
methods to select or create the appropriate folder. The factory default location 
for the Recording folder is C:\PlexonData or D:\PlexonData (if disk D is 
available).

12 When finished choosing or creating a storage folder, click OK.

Note: The location of the Recording folder is included in the Settings file (if 
you save a Settings file), and is restored when the Settings file is 
loaded. To save settings, click Save Settings on the File menu, or 

click the Save Settings button ( ) on the toolbar.

Note: If the Recording drive is not NTFS compatible, a warning message 
displays.

13 To view the CinePlex Studio time display, see the Source pane under the 
Video window. The image below shows the Source 1 pane, which appears 
under the Video 1 window for Camera 1. Similar panes appear for each of the 
cameras you have activated in the previous steps.
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14 In the Camera area of the Source pane (labeled with the camera model 
name), adjust the controls to obtain an acceptable image on the screen. The 
specific controls vary depending on the camera model. Typical adjustments 
include Gain, Auto White Balance, Brightness, Sharpness and 
Saturation.

Note: You can also use other image quality settings. To evaluate image 
quality settings, manually collect a set of AVI files at different settings 
and use the file mode to determine a minimum acceptable image 
quality setting for the experiment. (For information about video 
formats and the video Quality setting, see Section 3.10.2, “MPEG-4 
Quality and File Size” on page 71.)
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15 In the Sources pane, view the digital video recording (DVR) section. 

16 In the digital video recording (DVR) area of the Source pane, select the 
type(s) of output to create - video file (AVI File), text file with frame numbers 
and timestamps (DVT File) or both.

 

17 In the Timecode options, select the In Video checkbox to include the time. 
Choose a Location and a Format setting to configure the display. (CinePlex 

TIP
Reducing blurs and color streaks in the video
If the experimental subject moves quickly, blurs and color streaks can appear 
in the video. Reduce or eliminate these problems by increasing the shutter 
speed. See Shutter (ms) in the Source settings, as shown in the image 
above.

For additional tips, see “Sharpening the Image” on page B-7.

CAUTION
Save the AVI File
It is strongly recommended that you save an AVI File for every 
experimental run, even if you are sending data directly from 
CinePlex to the OmniPlex System. (AVI File is the default output 
type.) 
The AVI file is the originally recorded video of the experiment, and 
it can be retrieved and analyzed again. If you deselect the AVI File 
checkbox, the original video will not be saved. 

TIP
Generating timestamps and frame numbers—DVT FIle
The system will generate a digital video tracking (DVT) file if you select the 
DVT File checkbox. However, if you have the basic Studio/Editor license 
only (without the Tracking license), the DVT file will display only frame 
numbers and timestamps (no coordinate data). Therefore, it is not typically 
needed in this case.
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Studio maintains a time code that tracks the time elapsed since the last time 
recording began.)

For example, the following images show the time code in the Upper Left 
location in SSSSS.SSS and HH:MM:SS.SSS format, respectively.

18 Repeat Step 13 through Step 17 for any other cameras connected to the 
system.

19 (Optional) If the arena dimensions have not yet been calibrated, the 
calibration can be done now. See Section 3.3, “Calibrating the Arena 
Dimensions” on page 30 for details.

20 From the CinePlex Studio toolbar, click the “A” arming button. 

A yellow flashing cassette icon appears on the status bar at the bottom left of 
the CinePlex screen.



 

Version 3.7 49

Note: At this point, CinePlex is in the armed condition and is waiting for a 
start signal to be sent from OmniPlex. The SPK - Activity pane in 
PlexControl shows no data on the CPX1 line.

21 From the PlexControl toolbar, click the Start Recording icon. If PlexControl 
prompts for a file name, enter it.

PlexControl starts recording and displays status information about the neural 
data file on the PlexControl status bar; for information on the PlexControl 
status, see the OmniPlex System instructions.

CinePlex Studio automatically starts recording and displays information about 
the video file in the CinePlex Studio status bar.

The Studio status bar will display the amount of free space remaining on the 
drive selected.

Note: The system automatically checks that there is at least 10 GB of free 
disk space on the PC before it starts recording a file. The file size can 
grow to fill the space available, except that the system automatically 
stops recording the current file when the available disk space has 
been reduced to 10 GB. 

Studio starts sending the data to the OmniPlex System, and the SPK - Activity 
pane in PlexControl shows the synchronized data stream (see the blue data 
lines in this image):

Note: Plexon® recommends a short test recording to verify the data stream 
is being sent. The SPK - Activity pane in PlexControl should show the 
presence of the data stream, similar to that shown in the PlexControl 
image above.

22 To pause recording, click the PlexControl Pause Recording icon. 

PlexControl pauses recording and displays status information about the 
neural data file on the PlexControl status bar.
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CinePlex Studio pauses recording and displays information about the video 
file in the CinePlex Studio status bar. The status bar flashes green and gray to 
indicate that the recording is paused.

To resume recording, click PlexControl Pause Recording again.

23 To stop recording, press the Stop Recording button in PlexControl (Studio 
recording stops also.)

PlexControl stops recording to the neural data file, clears the recording 
information from the status bar, and saves the file as specified in Step 21. 

CinePlex Studio stops recording and saves the video file(s) to the location that 
was specified as Rec Folder in the CinePlex Studio Global Configuration 
Pane. CinePlex Studio clears the recording information from the status bar 
and re-arms itself for the next recording session.

When Studio is armed, for efficiency it creates temporary files. When 
recording is started remotely (from the OmniPlex System), Studio writes to 
these temporary files. When recording is stopped, the temporary files are 
renamed, and new temporary files are opened in anticipation of a new 
recording session. The Studio Messages Pane displays information similar to 
the example below.

Note: At this point, there is no tracking data being sent from CinePlex to the 
OmniPlex System, because CinePlex is once again in the armed 
condition. The SPK - Activity pane in PlexControl shows no data on 
the CPX1 line.
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24 You can start and stop recording as many times as desired. When recording 
starts, data will flow from CinePlex to the OmniPlex System. When recording 
stops, data does not flow.

25 To disarm CinePlex Studio, from the DVR toolbar, click Arm to clear. The 
status bar returns to the disarmed state.

26 To view the captured video file, browse to the file location and double click to 
open the file.

27 To transfer files to an analysis computer (if different than the recording 

computer), follow standard Windows procedures. 

3.5 File Naming Procedure During and After Recording

During the recording process, CinePlex Studio creates temporary names for the 
AVI files. When the recording is stopped, Studio renames the files.

If there is only one camera connected to the CinePlex System:

• The format of the temporary files is yyyymmddnnn.avi

• The format of the renamed files is PLX_file_name.avi

If there are multiple cameras connected to the CinePlex System:

• The format of the temporary files is yyyymmddnnn_N.avi

• The format of the renamed files is PLX_file_name_N.avi

where:

yyyymmdd is the year, month and day

nnn is a 3-digit number, 001, 002, ... 999 assigned automatically by the 
system

N is the camera number for which the file is created - 1, 2, ...

PLX_file_name is the file name specified by the user on the OmniPlex System 
in Step 21 of Section 3.4, “Recording Synchronized Video Tracking and 
Neural Data” on page 43.

Note: If Studio is armed on one day, but the start signal is not received until the next 
day, the temporary filename remains the one for the previous day.
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3.6 Monitoring the Video During a Recording Session

CinePlex status bar

The status bar in the CinePlex Studio main window displays information that 
allows the researcher to monitor the video recording process. This drawing shows 
the status bar during a typical recording session. (The image is split into three 
sections to fit the page.)

The contents of the status bar include

• A cassette icon that flashes yellow if recording is armed and is steady green 
when recording is in process.

• A display of the size of the recorded file in time and file size, and the 
remaining recording time and storage space available on the disk

• The maximum number of video frames queued for compression and waiting 
to be written to the AVI file at any time during the current recording session—
maximum queued units (MQU)

• A count of the number of dropped frames during the current recording session

• A recording indicator; a letter R appears when recording is in process

• Numbers identifying the resolution of the current recording in pixels 
(horizontal x vertical)

• The instantaneous frame rate in frames per second (fps). 

Note: During the recording process, the displayed value of the instantaneous frame 
rate (as displayed in the status bar shown in the above diagram) should match 
the value you specified in the Global Config pane. If the rate does not match, it 
is possible that the computer is experiencing partial congestion. Partial 
congestion is normally caused by non-Plexon applications. Partial congestion 
does not always result in dropped frames, but some processing might be 
slightly delayed. In the event that processing ever experiences problems, 
please contact Plexon Support for help in identifying and resolving the issue.



 

Version 3.7 53

Monitoring dropped frames when viewing a recorded file

One or more video frames can be dropped (fail to be recorded to an AVI file) 
during a recording session for a variety of reasons—for example, if you launch 
another application during a CinePlex recording session (which is not 
recommended).

During original recording in Cameras mode or recording with the Retrack 
AVI function in Files mode—In the example below, notice that the frame 
number displayed in the Video pane is 45536 and the status bar at the bottom of 
the CinePlex interface shows that five frames have been dropped. 
This means that only 45531 frames have been successfully recorded.

During playback in Files mode—In this mode, the status bar at the bottom of 
the CinePlex interface is disabled—it will always display Drops: 0.
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3.7 Shutting Down the System after Recording

This section provides the steps for shutting down the system when you have 
finished your experiments. The system shutdown sequence is important for the 
integrity of the recorded data. 

1 To stop recording, press the Stop Recording button in PlexControl (Studio 
recording stops also.)

2 PlexControl stops recording to the neural data file, clears the recording 
information from the status bar, and saves the current file. 

CinePlex Studio stops recording and saves the video file(s) to the location that 
was specified as Rec Folder in the CinePlex Studio Global Configuration 
Pane. CinePlex Studio clears the recording information from the status bar 
and re-arms itself for the next recording session.

When Studio is armed, for efficiency it creates temporary files. When 
recording is started remotely (from OmniPlex), Studio writes to these 
temporary files. When recording is stopped, the temporary files are renamed, 
and new temporary files are opened in anticipation of a new recording 
session. The Studio Messages Pane displays information similar to the 
example below.

Note: At this point, there is no tracking data being sent from CinePlex to 
OmniPlex, because CinePlex is once again in the armed condition. 
The SPK - Activity pane in PlexControl shows no data on the CPX1 
line.

Note: You can start and stop recording as many times as desired. When 
recording starts, data will flow from CinePlex to OmniPlex. When 
recording stops, data does not flow.
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3 To disarm CinePlex Studio, from the DVR toolbar, click Arm  to clear. The 
status bar returns to the disarmed state.

4 To view the captured video files, browse to the file location and double click to 
open the file. Verify that the files for each camera are present and complete.

5 At this time, it is safe to exit the CinePlex application if you are finished.

Continue with these steps if you are shutting down OmniPlex also:

6 Click the Stop Data button in the PlexControl toolbar so that neural data 
acquisition stops.

7 Close the OmniPlex PlexControl and Server applications.

8 Turn the OmniPlex chassis power off.
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3.8 Recording Video without Neural Data (Used for Animal Training)

This section explains how to record video and tracking data without neural data. 
In this case, the OmniPlex System is activated only for the purpose of providing 
the required clock for the CinePlex System. This procedure requires activation of 
the OmniPlex data stream (which starts the clock), and then starting and stopping 
the CinePlex Studio video recording process locally on the CinePlex System. 
This method of triggering the recording is typically used during animal training, 
when no neural data are being collected.

3.8.1 Recording Procedure

Perform these steps to record video data without neural data.

1 Ensure that the system is connected as described in Chapter 2, Installing, 
Starting and Testing CinePlex Studio.

2 At the OmniPlex System chassis, turn the power on and start the OmniPlex 
Server and PlexControl.

3 If not already done, configure the OmniPlex System.

4 Click the Start Data button in the PlexControl toolbar so that neural data 
acquisition begins, and the neural data appears in PlexControl display.

5 Double-click the CinePlex Studio icon. Wait for the CinePlex Studio 
application main window to appear on the monitor.

Note: If Studio does not detect the OmniPlex clock, an error message will 
appear. If it does, see Appendix D-Troubleshooting.

6 Verify that Cameras is selected in the Studio dropdown list and that a camera 
image is displayed for each of the camera(s) that will be used in the 
experiment. The image is displayed for each camera icon that is selected. 
The image below shows that both Camera 1 and Camera 2 are selected 
(indicated by the orange color of the icons).

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.

CAUTION
Lighting Conditions
If lighting conditions change enough during recording that ‘objects 
too large’ or some other condition occurs, the position data may be 
meaningless.
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7 If there is an appropriate file containing all the desired CinePlex settings, load 

the file onto the CinePlex System using the Load settings icon ( ) on the 
main toolbar or the File/Load Settings menu selection.

8 Click on the Global Config tab in the static configuration pane to display the 
Global Config pane. 

Note: This pane is the first an experimenter will normally use when setting 
up CinePlex Studio, but perhaps not very often after that. It contains 
settings that pertain to the frame rate to use when recording, image 
resolution (quality of recordings to make), compression bit rate and 
local file recording folder. For information about video formats and the 
video Quality setting, see Section 3.10.2, “MPEG-4 Quality and File 
Size” on page 71.

9 View the settings in the Global Config pane and modify any that need to be 
changed prior to starting the next recording session.

10 To browse for the desired file location (where the recorded files will be saved), 
click on the browse icon, which is the rectangle with three dots on the Rec 
Folder row of the Global Config pane.
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11 When the Browse for Folder dialog box appears, use standard Windows 
methods to select or create the appropriate folder. The factory default location 
for the Recording folder is C:\PlexonData or D:\PlexonData (if disk D is 
available).

12 When finished choosing or creating a storage folder, click OK.

Note: The location of the Recording folder is included in the Settings file (if 
you save a Settings file), and is restored when the Settings file is 
loaded. To save settings, click Save Settings on the File menu, or 

click the Save Settings button ( ) on the toolbar.

Note: If the Recording drive is not NTFS compatible, a warning message 
displays.

13 To view the CinePlex Studio time display, see the Source pane under the 
Video window. The image below shows the Source 1 pane, which appears 
under the Video 1 window for Camera 1. Similar panes appear for each of the 
cameras you have activated in the previous steps. (Calibration is explained in 
a later step in this procedure.)
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14 In the Camera area of the Source pane (labeled with the camera model 
name), adjust the controls to obtain an acceptable image on the screen. The 
specific controls vary depending on the camera model. Typical adjustments 
include Gain, Auto White Balance, Brightness, Sharpness and 
Saturation.

Note: You can also use other image quality settings. To evaluate image 
quality settings, manually collect a set of AVI files at different settings 
and use the file mode to determine a minimum acceptable image 
quality setting for the experiment. (For information about video 
formats and the video Quality setting, see Section 3.10.2, “MPEG-4 
Quality and File Size” on page 71.)
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15 In the Sources pane, view the digital video recording (DVR) section. 

16 In the digital video recording (DVR) area of the Source pane, select the 
type(s) of output to create - video file (AVI File), text file with frame numbers 
and timestamps (DVT File) or both.

17 In the Timecode options, select the In Video checkbox to include the time. 
Choose a Location and a Format setting to configure the display. (CinePlex 
Studio maintains a time code that tracks the time elapsed since the last time 
recording began.)

For example, the following images show the time code in the Upper Left 
location in SSSSS.SSS and HH:MM:SS.SSS format, respectively.

TIP
Reducing blurs and color streaks in the video
If the experimental subject moves quickly, blurs and color streaks can 
appear in the video. Reduce or eliminate these problems by increasing the 
shutter speed. See Shutter (ms) in the Source settings, as shown in the 
image above.

For additional tips, see “Sharpening the Image” on page B-7.
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18 Repeat Step 13 through Step 17 for any other cameras connected to the 
system.

19 (Optional) If the arena dimensions have not yet been calibrated, the 
calibration can be done now. See Section 3.3, “Calibrating the Arena 
Dimensions” on page 30 for details.

20 To start recording video, click the Start recording button (the red circular 
icon) on the CinePlex Studio toolbar. A green cassette icon appears on the 
status bar to indicate that the recording is in process.

The Pause or resume recording and Stop recording buttons appear on the 
CinePlex toolbar.

Note: The system automatically checks that there is at least 10 GB of free 
disk space on the PC before it starts recording a file. The file size can 
grow to fill the space available, except that the system automatically 
stops recording the current file when the available disk space has 
been reduced to 10 GB. 

21 To pause recording, click the Pause or resume recording icon. 

CinePlex Studio pauses recording and displays information about the video 
file in the CinePlex Studio status bar. The status bar flashes green and gray to 
indicate that the recording is paused.

To resume recording, click the Pause or resume recording icon again.

22 To stop recording, press the Stop recording icon.

CinePlex Studio stops recording and saves the video file(s) to the location that 
was specified as Rec Folder in the CinePlex Studio Global Configuration 
Pane. CinePlex Studio clears the recording information from the status bar 
and re-arms itself for the next recording session.

The Studio Messages Pane displays information similar to the example below.
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23 You can start and stop recording as many times as desired.

24 To view the captured video file, browse to the file location and double click to 
open the file.

25 To transfer files to an analysis computer (if different than the recording 
computer), follow standard Windows procedures. 

26 If desired, to save the current settings, click Save Settings on the File menu, 

or click the Save Settings button ( ) on the toolbar.
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3.9 Video Playback and Rerecording in Studio Files (Offline) Mode

This section explains how to use CinePlex Studio in offline mode to play back 
and rerecord video from existing files. The existing AVI and/or DVT files are the 
ones recorded previously by means of the procedure in Section 3.4, “Recording 
Synchronized Video Tracking and Neural Data” on page 43.

Offline mode allows you to view existing CinePlex video file(s). The files can 
also be rerecorded with parameter settings that are different than those used for 
the original recording.

The offline functions of CinePlex Studio can be used on the OmniPlex/CinePlex 
host PC where the camera(s) are installed, or on a standalone computer. The 
CinePlex Studio license must be present on the computer.

3.9.1 Entering Offline Mode

CinePlex Studio has two modes of operation: Cameras (online) mode and Files 
(offline) mode. You can switch from Cameras mode to Files mode using the 
video source dropdown list on the CinePlex Studio main toolbar, as shown in this 
drawing.

Note: CinePlex Studio comes up in Files (offline) mode automatically if no cameras 
are detected.

3.9.2 Selecting Files to Be Viewed and/or Rerecorded

Files are represented by icons in the toolbar. You can select from one to four files 
to process in offline mode, up to the number of cameras licensed for the system. 
The number in the file icon corresponds to the cameral number on which a file 
was originally recorded. In the following image, for example, File 1 is selected, 
therefore the source file must be one that was recorded on Camera 1.

Files
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3.9.3 Managing the Offline Main Window Layout

The image below shows a typical layout with files from Camera 1 and Camera 2 
enabled.

The Video Edit pane allows the opened file(s) to be viewed frame by frame. 

The Global Config and Source panes allow you to change settings and rerecord 
the files. (The procedure is presented below.)
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3.9.4 Procedure for Loading and Reviewing Video Files

The following procedure organizes the main window and loads the desired files. 
It also displays the Video Edit pane, which can be used to replay the video file 
frame by frame.

To view files from a single camera

1 To view files from a single camera, select the appropriate file icon. For 
example, in the image below, the file from Camera 1 (File 1) is selected.

2 Verify that you can see the video window and Source panel for the selected 
file (File 1 and Source 1 in this example).

Note: If the video window is not displayed, from the Window dropdown 
menu, select Layout and then Reset to Default Layout.
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3 In the Source pane, in the File Name row, click on the folder icon to navigate 
to the directory containing the desired AVI file and select the file.

Note: If you select a file that was created with any camera other than the 
camera associated with Source, the system will prompt you to select 
a different file (a file that was created with appropriate camera). The 
system can automatically detect which camera created the file, 
regardless of the file name. For example, in the image below, only 
files created with Camera 1 can be loaded in the Source 1 pane.

The buttons in the Video Edit pane can be used to replay the video file frame 
by frame.

4 To view files that were created with a different camera, repeat Step 1 through 
Step 3. (In Step 1, for example, disable all Files except the one file to be 
worked on next. For example, disable File 1 and enable File 2.)

To view files from multiple cameras

1 To view files from multiple cameras, select the appropriate file icons. For 
example, in the image below, the files from Camera 1 (File 1) and Camera 2 
(File 2) are selected.
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2 Verify that you can see the video window and Source panel for the selected 
files. In the image below, Source 1 and Source 2 are displayed.

Note: If the correct video windows are not displayed, from the Window 
dropdown menu, select Layout and then Reset to Default Layout.
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3 In each of the Source panes, in the File Name row, click on the folder icon to 
navigate to the directory containing the desired AVI file and select the file.

4 The options for file selection and video playback for multiple files are similar to 
those for a single file. (See To view files from a single camera on page 65.)

3.9.5 Rerecording AVI files in MPEG-4 Format

If you have AVI recordings that you wish to rerecord in the more efficient 
MPEG-4 format, follow the steps listed below.

The recording parameters are set in the Source pane. For example, the image 
below shows the Source frame for File 2, and the File Name is a file that was 
originally recorded with Camera 2.

Note: The Compression row in the Source pane displays the compression format of 
the existing file. When you create a new recording with the procedure below, 
the system will save the new recording in MPEG-4 format, which is highly 
efficient, thus minimizing storage space usage.

1 In the Source pane, you can set parameters that will cause the system to:

t Change brightness, contrast or other settings so that existing files are 
more usable

u Place the File Name and/or Timecode into the video frame that was not 
already done on the original run
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2 In the Global Config pane, you can lower the Quality setting to further reduce 
file size and save storage space.

3 Start retracking of the existing video (with the new settings) by pressing the 

Start recording from file ( ) button in the main toolbar.

3.9.6 Summary of Offline Procedures

This section summarizes the use of the offline procedures.

1 Use CinePlex Studio to record one or more video files on an internal hard 
drive. If the Recording Folder has not been set, a notification message will 
display. See Section 3.4, “Recording Synchronized Video Tracking and 
Neural Data” on page 43.

2 The AVI and/or DVT files can be rerecorded on the host PC that is part of the 
CinePlex/OmniPlex System, or the files can be transferred to another 
computer for analysis computer. When finished copying the files to the 
analysis computer, rename the files, if desired.

The recommended system requirements for an offline analysis computer 
include a dual core Intel processor operating at better than 3 GHz with 3 GB 

of memory, and an NVIDIA® GeForce® 9600 GT or better video card. In 
addition, the appropriate Plexon license (see Section 1.6, “CinePlex Licensing 
Options” on page 5) must be plugged in to one of the USB ports. For a more 
detailed discussion of requirements, contact Plexon Support at 
+1-214-369-4957 or support@plexon.com. 

3 Extraction (see Chapter 7, Extractor Procedures).

3.9.7 Offline Functionality Compared to Online Functionality

Most offline functionality is only marginally different from its online equivalent. 
The major exception is that the optional tracking and behavior functionality in a 
recorded file will be slightly different than the functionality for live video. This is 
because the compression techniques used to create AVI files of manageable size 
inherently discard some of the data that was present in the original, that is, there 
are losses that occur during compression. In particular, some color and brightness 
data might be slightly changed. Normally the differences are not visible to the 
naked eye, but they will cause slight differences in the sensitive algorithms used 
for tracking analysis (if the Tracking Option is installed).

Differences in the user interface are described below:

• Global Config pane - The frame rate and resolution shown are that of the 
source files selected. Other sections are unchanged.

mailto:support@plexon.com
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• Source pane(s) - Most Camera adjustments are replaced with a file selection 
browsing tool. In their places are simple adjustments for brightness and 
contrast. Other sections are unchanged.

3.9.8 File Naming Procedure in Offline Mode

CinePlex Studio renames files during the retracking process. After you press the 
Start recording from file ( ) button, CinePlex Studio prompts for new file 
name(s), and you can accept the name as shown or enter a new name.

If there is only one file being retracked, the format of the prompted file name is 
filename-nn.avi, 
where:

— filename is the original file name of the opened source file

— nn is a 2-digit number, 01, 02, ... 99 assigned automatically by the 
system for each new rerecorded file instance

for example:

filename-01.avi, filename-02.avi, filename-03.avi, ...

If there are multiple files being rerecorded, the format of the prompted file name 
is filenameN-nn.avi,
where:

— filenameN is the original file name for one of the opened source files

— nn is a 2-digit number, 01, 02, ... 99 assigned automatically by the 
system for each new rerecorded file instance

for example:

filename1-01.avi, filename1-02.avi, filename1-03.avi, ...
filename2-01.avi, filename2-02.avi, filename2-03.avi, ...
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3.10 General Information on Video Formats, Synchronization and 
Timestamps

This section discusses technical aspects of video recording, including video file 
formats, synchronization and timestamps.

3.10.1 Reference Information - Digital Video Recorder AVI Files

The Digital Video Recording (DVR) feature of CinePlex Studio stores the video 
recording from one or more cameras on an internal hard drive. In most 
experiments, the user simultaneously collects a neural data file in an AVI file. 
With CinePlex Studio, you may start, stop, and timestamp these AVI files in a 
way that enables you to subsequently correlate them offline with the 
simultaneously-captured neural data.

Note: If Studio is armed on one day, but the start signal is not received until the next 
day, the filename remains the one for the previous day.

CinePlex Studio records video into AVI files at a resolution of 640x480 pixels at 
up to 200 frames per second, which implies a raw data rate of over 700 GB/hour. 
To reduce disk usage, CinePlex Studio compresses the video using standard 
MPEG algorithms before it writes it to the AVI file. You can vary the file com-
pression to find a suitable balance between AVI file size and image quality.

3.10.2 MPEG-4 Quality and File Size

MPEG-4 recording format is used because it produces files that are routinely 75 
to 90% smaller than the equivalent MJPEG formatted files that were produced by 
earlier versions of CinePlex Studio.

The CinePlex System Quality settings for MPEG-4 range from 1 to 10. The 
values represent the nominal bit rate divided by 500,000. The default value of 4 is 
adequate for most experiments and Plexon recommends using that value unless 
there is a specific reason to modify it.

Note: If you increase the MPEG-4 Quality setting, for example, increasing it from 4 to 
10, the size of the AVI file increases significantly (assuming the same recording 
duration), but it does not dramatically increase the quality of the image. 
Conversely, if you reduce the Quality setting, for example, from 4 to 2, the size 
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of the AVI file is reduced (for the same recording duration), however, the quality 
of the image degrades significantly.

3.10.3 MPEG Recording Processes

While it records, CinePlex Studio continually calculates and displays the amount 
of recording time left until the target hard drive would fill up. As the hard drive 
capacity is neared, CinePlex Studio stops recording.

The AVI files created by CinePlex Studio are industry-standard AVI-format files 
that you can play with many standard tools, including Microsoft Windows Media 
Player, which is pre-installed on most Windows computers. You can also use a 
variety of commercial software applications to edit and perform other operations 
on AVI files. 

Note: Windows Media Player and other video players render files slower than real 
time if the files were recorded at 40 frames per second or greater. This can be 
confusing because the slider moves faster than the video plays such that the 
slider reaches the end of its travel before the video finishes playing.

The MPEG/AVI format allows the embedding of additional data segments within 
AVI files. Each embedded data segment has an identification tag. Typically, an 
AVI file reader that does not recognize a tag for an embedded data segment skips 
that data segment. CinePlex Studio always produces AVI files with a Plexon-
specific additional tagged data segment that contains dynamic data, including the 
frame timestamp, for each video frame. CinePlex Editor can read this additional 
data segment in the AVI files generated by CinePlex Studio and thus recover the 
frame timestamp. Other AVI file readers like Windows Media Player ignore this 
data. This Plexon-specific nondestructive embedded data are not visible on the 
video frame. However, CinePlex Studio contains an optional feature that can 
overlay this timestamp in visible numerals on the video image itself; see Section 
3.4, “Recording Synchronized Video Tracking and Neural Data” on page 43. 
CinePlex Editor software is installed separately from CinePlex Studio.

3.10.4 Synchronizing Files from Two Video Cameras

In some cases of synchronizing files from two video cameras, one file can be 
several frames longer than another due to minor software delays handling the 
Stop signal. The critical functionality is that the cameras start together and that 
triggers for corresponding frames occur at exactly the same time.

3.10.5 Synchronizing Video Files with Neural Data Files

To synchronize the video files with the neural data files, both systems must:

• derive all timestamps from the same clock

• start recording both files at the same time - use the same timestamp for 
relative time zero

• stop recordings at approximately the same time
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The above conditions are met when CinePlex Studio is integrated with an 
OmniPlex System, because CinePlex Studio timing is locked onto and controlled 
from the main OmniPlex System clock. This ensures that the PLX and AVI files 
will have the same timing. Use of the same clock to generate the timestamps in 
each file avoids longer-term “drifting” of the time-base of one file relative to the 
other. For example, say the clock controlling the timestamp generation for video 
frames has a frequency difference of 1% from the clock controlling the timestamp 
generation of neural firing events in the neural data files; after 100 seconds, the 
occurrences that should appear as simultaneous in the neural data and AVI files 
appear instead as one second apart. Since CinePlex Studio is integrated with an 
OmniPlex System, synchronization occurs because CinePlex Studio is controlled 
with a clock signal derived from the main OmniPlex System clock. Thus, the 
PLX and AVI files are guaranteed to have the same time-base.

Note: The CinePlex Studio clock is 1 MHz. This means that the resolution of 
timestamps generated by CinePlex Studio is 1 sec.

When using CinePlex Studio with the OmniPlex System, the OmniPlex System 
generates control signals and routes the signals through the control cable to the 
appropriate inputs for CinePlex Studio. To use this mode of operation, arm 
CinePlex Studio to respond to the electrical control signals. When armed, 
CinePlex Studio starts recording the video file exactly one frametime after the 
start of the neural data file.

Note: CinePlex Studio resets the relative timestamp to zero when armed and 
recording is started by PlexControl or when clicking the Record button to 
manually start recording a video file. Otherwise the timestamps continue to 
increment until CinePlex Studio is shut down.
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4.1 Introduction to the CinePlex Tracking Option

This chapter describes the CinePlex® Studio Tracking Option, the experimental 
applications for which it can be used, and how to use it. The Tracking Option 
extends the capabilities of CinePlex Studio by enabling the computation and 
recording of positional data. The Tracking Option requires the CPT V3 license in 
addition to the CPX V3 (Studio/Editor) license.

The general procedure for using the Tracking Option is:

1 Position the camera(s) so that the desired physical experiment area is within 
the field of view of the camera

2 Define the shape of the arena for each camera

3 Select the tracking mode to be used - Object Contour, LEDs, Color 
Markers, or Extended Tracking of Color Markers

4 Set the parameters for the selected tracking mode

5 Perform a calibration of the dimensions in the arena

6 Set the location where the recorded files will be saved

7 Save the settings and layout

8 Synchronize the CinePlex and OmniPlex® Systems for recording

9 Start recording from the OmniPlex System

10 Stop recording at the OmniPlex System

11 If desired, retrack coordinate data in CinePlex Studio offline mode

12 If desired, rerecord synchronized files with CinePlex Editor (installed 
separately)

You can configure CinePlex Studio to capture video only (Audio Video 
Interleaved [AVI] files), track positions only (digital video tracking [DVT] files), 
capture video and track positions simultaneously, or create no files.

The tracking function can also be used in offline mode with existing pre-recorded 
files. In offline mode the tracking parameters can be set to values that are 
different than those used during the original recording, if any, and the system will 
retrack the video based on the new settings (see Section 4.16, “Video Playback In 
Files (Offline) Mode” on page 139).

The CinePlex Studio default window layout will be sufficient for most instances. 
However, to load, change or save a window layout, see Appendix E-Navigating 
the Plexon User Interface.

Use the flowchart below to choose the concepts and procedures in this chapter 
that apply to your experiment.
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4.2 Setting Up Cameras and the User Interface

The procedures for setting up cameras and the user interface are the same as those 
used for the basic recording option. See Chapter 3, Recording Video with 
CinePlex Studio.

4.3 Navigating the Studio Main Window

See the section Section 3.2, “Navigating the Studio Main Window” on page 29 
for a basic description of the Studio main window, where you can view and 
modify CinePlex Studio settings before starting the recording session. 

When the Tracking Option is present, there are additional toolbar options and 
panes, as shown in the image below.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.
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4.4 Understanding Tracking Windows and Arenas

This section explains how the CinePlex Studio software manages the video 
processing load by using system-generated tracking windows and user-defined 
arenas.

4.4.1 System-generated Tracking Windows

The system generates tracking windows to limit the processing and analysis of 
video data to a small portion of the video image, typically to the body contour of 
the animal or the color markers or LEDs mounted on the animal. This reduces the 
overall CPU load and allows tracking more colors. Tracking windows also reduce 
problems with unwanted parasite objects (for example, reflections). 

Tracking windows are displayed as yellow rectangles in the video display, as 
shown in the image below

Tracking windows can be made to appear by selecting the Tracking Window 
checkbox in the Visualization area of the Tracking pane, as shown in the image 
below.

Note: In Object Contour mode, the area will be labeled Whole Body Visualization. In 
LED mode, it is labeled LED Visualization, and in Color Markers mode it is 
Marker Visualization.
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The system automatically sets the size of the tracking window to cover the whole 
object. Each object (whole animal, LED, or marker) has its own tracking window. 
The tracking window is repositioned automatically. A history of an object’s 
movement is used to predict its next position. If the object disappears because of 
occlusion by a cable or other means, its tracking window is moved according to 
the speed and movement direction in its most recently detected frames. If the 
system is tracking multiple LEDs or markers in single animal mode, the system 
will also use the positions of the found LEDs or markers to predict the position of 
the one that disappeared. If the object is not found after a certain number of 
frames, the size of the tracking window will be increased. If the object is not 
found within two seconds, the system switches to search in the whole frame (or 
within the arena, if an arena shape has been defined).

4.4.2 User-defined Arenas

You can define an arena for each camera image. Arenas reduce problems with 
unwanted reflections and parasite objects outside of the working area.

For accurate tracking, you should ensure that the ratio of the object size to the 
arena size is such that the system will be able to track the object. If the ratio is too 
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small (image size of the object less than a few pixels) the system will not be able 
to distinguish the object from noise. If the ratio is too large (more than 1/4 of the 
video image) the system will not track the object.

Using the tools provided by CinePlex Studio and the Tracking Option, you can 
draw an outline of the experimental arena over the video image. Once this outline 
is drawn, Studio ignores objects outside of the arena when processing the images. 
This results in lower CPU usage and reduces false object detections due to 
reflections and shadows. It also allows the experimenter to exclude areas of the 
image that have no relevance to the experiment. Arena tools allow drawing 
circles, ellipses, rectangles, and freehand objects. Arena logical operations 
(AND, OR, NOT, XOR) allow combining multiple arena shapes to produce a 
single complex arena shape.

Example - Using Arenas to Exclude Reflections 

The following drawings show two examples of arenas (red rectangles) - one for 
LED tracking mode and one for Object Contour tracking mode. In each case, the 
reflections outside the arena are ignored by the CinePlex System.
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Example - Using Arenas to Exclude Background Objects or Colors 

If a background object (or background color) might interfere with the tracking 
function, the object (or color) can be removed from the arena. This will allow the 
system to track the animal correctly. 

This image shows an animal to be tracked along with a background object of 
approximately the same color. The background object is larger than the animal 
and the system is tracking the background object (the red cross hair is centered on 
the object and the tracking window [yellow rectangle] is surrounding the object). 

To avoid this situation, the experimenter can use one or both of the following 
tools:

• Define a specific arena shape in which to track

• Use background subtraction (discussed elsewhere in this chapter)
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This image shows a defined arena (in green) that the system will use to track the 
animal. The arena excludes the background object, therefore the system will 
never lock onto the object by mistake.

Modifying Arenas In Offline Mode

If you transfer an AVI file to an offline analysis computer on which CinePlex 
Studio is installed, that file can be retracked with new or changed arenas.

Note: The standalone analysis computer must have minimum memory, 
processor and instruction set to run CinePlex Studio efficiently. The 
requirements for the computer are summarized in Section 1.13.2, 
“Processing and Analyzing Data” on page 14.
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4.5 Defining the Arenas

This section explains how to define an arena for each camera, beginning with 
Camera 1. One arena is allowed per camera.

Adding the Arena for Camera 1

1 In the Scenes tab for Camera 1, click the Add arena (+) button.

A Scenes settings pane is displayed, and the toolbar now displays active 
icons for shapes and logical operators. 

Note: If additional CinePlex System options (for example, Basic Behavior 
Option and/or 3D Option) are installed, the window might contain 
additional tabs and toolbar icons. This chapter focuses only on the 
Tracking Option.

Logical operators:
Union shapes (OR), Intersect shapes (AND), 
Subtract shapes (NOT), XOR shapes (Exclusive OR)

Shapes:
Circle, Ellipse, Rectangle, Polygon
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2 One or more shapes can be added to the arena. To draw a shape, click the 
desired shape on the toolbar (Circle, Ellipse, Rectangle, or Polygon). For a 
circle, ellipse or rectangle, left-click and hold the mouse on a desired point on 
the image and move the mouse to size the arena. 

Note: For a freehand polygon, click the left mouse button over desired 
points that will be the nodes of the polygon, and use a right-click to 
close the polygon. The shape can be moved or resized by left-clicking 
and dragging.

3 Multiple shapes can be drawn and logically combined to create an arena with 
a complex shape. After the first shape is drawn, draw a second shape as 
follows:

• Click on the logical operator that will combine the first and second 
shape.

• Then click on the icon for the second shape and draw the second shape.

• To view the combined shape more clearly, click on the Fill checkbox to 
select it.
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The images below show examples of combined arena shapes. Tracking will 
only occur in the shaded regions. 

Union shapes Intersect shapes

Subtract shapes XOR shapes
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Arenas drawn from several shapes do not need to be contiguous (as was the 
case in the examples above). The image below shows an arena that contains 
noncontiguous shapes. Tracking will only occur in the shaded regions.

4 If desired, use the logical operator and shape icons multiple times to add and 
join several shapes to accurately define the arena.

5 To delete a shape, select the desired shape in the Arena pane (or in the Video 
pane) and press the Delete key on the computer keyboard. In the images 
below note that the rectangle is selected for deletion.

Adding Arenas for Additional Camera(s)

6 Repeat Step 1 through Step 5 for any additional camera(s) to be used in the 
experiment.
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4.6 Selecting the Tracking Mode and Tracking Settings

This section assists you in selecting the tracking mode to use for the experiment. 
It also explains the purpose of two of the settings common to all tracking modes: 
Threshold and PLX buttons.

4.6.1 Tracker Toolbar

The Tracker toolbar (shown below) allows you to select the desired tracking 
mode.When one of the tracking modes is selected, the system tracks the position 
of subject(s) in the video images, in real time, and delivers the tracked position 
coordinates to the OmniPlex® System. 

4.6.2 Understanding the Tracking Mode Options

The tracking modes are listed below. 

Note: Only one tracking mode can be active at a time. Tracking modes cannot be 
combined.

• Object Contour Tracking: In this mode, CinePlex Studio analyzes the 
image to find a whole-body shape that corresponds to the desired object, and 
then computes (and tracks) the center of gravity of the shape. 

• Tracking LEDs: In this mode, CinePlex Studio tracks up to three light 
emitting diodes (LEDs) on the subject or subjects being tracked.

• Tracking Color Markers: This mode of tracking is retained primarily for 
legacy purposes, for experimenters who have been using this mode and wish 
to continue doing so. It can be used in experiments requiring a small number 
of distinct reflective colors (typically up to five colors in a typical arena) with 
good lighting. It is possible to track more than 5 colors, but only if the arena 
lighting is sufficient. 

TIP
Extended Tracking of Color Markers
For new experiments, Plexon strongly recommends using the 
Extended Tracking of Color Markers mode rather than the 
Color Markers tracking mode.

Object Contour  
Tracking 

Tracking LEDs 

Tracking  
Color Markers 

Extended Tracking 
of Color Markers 
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• Extended Tracking of Color Markers: This is the recommended mode of 
color markers tracking for most applications. In this mode, CinePlex Studio 
tracks up to 12 reflective colors (tape or paint, for example) on the subject or 
subjects being tracked. The actual number of trackable colors depends on the 
colors themselves, their relative sizes, and the lighting within the arena.

4.6.3 Guidelines for Selecting the Tracking Mode

This section assists you in selecting the tracking mode to use for the experiment, 
and optimizing tracking parameters to suit the needs of the experiment.

The table below provides an overview of the recommended tracking mode to use 
under various conditions.

In general, for a given experimental setup, only one tracking mode is optimal. 
The following guidelines help to determine which tracking mode to use.

• In general, the best tracking results occur when light-emitting diodes (LEDs) 
are attached to the animal. This is due to:

— The relatively small size of the objects being tracked

— The high intensity of colors against a dark or partially lit background

• The easiest way to use LEDs is to mount them directly on the animal 
headstage. Plexon offers headstages with LEDs mounted on them, such as the 
headstage shown in this drawing.

• To track not only position but head direction, use two or three LEDs. 

• For LED tracking, the system finds the brightest spots on the image, and 
determines their positions in the color space. LED tracking mode is 

Tracking Device to be 
Used on the Animal

Are LEDs the 
Brightest Spots in 

Arena?
Recommended Tracking Mode to Use

No LEDs. 
No colored markers

Not Applicable Object Contour

LEDs Yes LED or 
 Extended Tracking of Color Markers

LEDs No  Extended Tracking of Color Markers

Colored markers Not Applicable  Extended Tracking of Color Markers
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recommended when LEDs are to be tracked, and they are the brightest spots 
on the image and the rest of the image is dark. Check the Pure Colors option 
to cause the system to recognize Plexon standard red, green, and blue LED 
colors automatically. Otherwise, select the colors to track.

• Object Contour Mode can only track the “center of gravity” of one animal’s 
contour, therefore, Object Contour mode cannot be used with LEDs or 
multiple animals.

• If the experiment requires Motion Measure, which can be used for studies of 
freezing behavior, use Object Contour mode.

• If the animals are multicolored, especially with high-contrast colors (for 
example, Long Evans rats), Object Contour mode works best with a 
contrasting background color, such as red.

• Object Contour mode is more sensitive to changes in background and lighting 
conditions compared to the other tracking modes.

• In general, more effort is required to configure Object Contour mode to 
obtain optimal tracking results than is required for either LED or Extended 
Reflective Colors modes. This is because slight variations in background and 
lighting can cause the animal’s contour to vary slightly, even if the animal is 
not moving.

4.6.4 Understanding the Threshold Setting

All tracking modes have a user-configurable Threshold parameter that is used in 
the calculation the system performs to locate and track an object. The result of the 
calculation depends on [1] the contrast between the tracked object and the 
background, and [2] the Threshold value set by the user. For a general 
understanding of how the Threshold value affects tracking, see Section 4.7.2, 
“Setting the Threshold” on page 96. That section presents the Threshold concept 
from the point of view of Object Contour tracking mode, but the discussion 
applies to all tracking modes.

4.6.5 Sending Tracking Data to the OmniPlex System

The system stores tracking data on the host computer in AVI and/or DVT files, as 
specified by the user. In addition, you can specify that the tracking data (X, Y 
coordinates as a function of time) from Camera 1 be sent to the OmniPlex 
System. The OmniPlex System incorporates this tracking data into the PLX files, 
which also contain the neural data. The procedure for sending tracking data from 
CinePlex Studio to the OmniPlex System is included in the recording procedure, 
Section 4.13, “Recording Synchronized Video Tracking and Neural Data” on 
page 130.

To configure CinePlex Studio to send tracking data to the OmniPlex System, 
click the appropriate PLX button(s) for Camera 1 in the CinePlex Studio 
configuration pane. The diagram below shows an example of PLX buttons. 
When a PLX button is selected, it turns orange; when it is not selected, it is clear.
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The following conditions apply to the process of sending tracking data from 
CinePlex Studio to the OmniPlex System:

• Data can be sent for Camera 1 only.

• Data can be sent in online (“Cameras”) mode only, not in offline (“Files”) 
mode.

• Data can be sent for up to three LEDs or colored markers. (Only three of the 
PLX buttons can be active simultaneously.)

The procedure for sending data is as follows:

1 Start the OmniPlex Server and PlexControl.

2 Start data acquisition in the OmniPlex System by pressing the Start 
Recording button on the PlexControl toolbar. (This step also causes the 
OmniPlex System to begin sending timing signals to CinePlex Studio. Without 
this step, CinePlex Studio cannot send data to the OmniPlex System.)

3 Start CinePlex Studio.

4 Verify that “Cameras” is selected in the CinePlex Studio pulldown menu and 
that a camera image is displayed for Camera 1. (It is acceptable if other 
camera video images are also displayed, but Camera 1 is required.)

5 In CinePlex Studio, load a settings file that contains tracking, or configure 
tracking. Ensure that at least one PLX button is pressed.

6 Arm CinePlex Studio (press the “A” arming button in the Studio toolbar).

Note: At this point, there is no tracking data being sent from CinePlex 
Studio to the OmniPlex System. In the armed condition, CinePlex 
Studio is waiting for a start signal to be sent from the OmniPlex 
System. The SPK - Activity pane in PlexControl shows no data on 
the CPX1 line.
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7 Start recording by pressing the Start Recording button in PlexControl (Studio 
recording starts also). Studio starts sending the coordinate data to the 
OmniPlex System, and the SPK - Activity pane in PlexControl shows the 
synchronized data stream (see the blue data lines in the image below). Scroll 
to the bottom of the Activity window to show the CPX1 data row.

8 Stop recording by pressing the Stop Recording button in PlexControl (Studio 
recording stops also.)

Note: At this point, there is no tracking data being sent from CinePlex 
Studio to the OmniPlex System, because Studio is once again in the 
armed condition. The SPK - Activity pane in PlexControl shows no 
data on the CPX1 line.

9 You can start and stop recording as many times as desired. When recording 
starts, tracking data will flow from CinePlex Studio to the OmniPlex System. 
When recording stops, tracking data will not flow.

10 If you disarm CinePlex Studio (by clicking the “A” arming button), tracking 
data will flow again from CinePlex Studio to the OmniPlex System.

Note: Plexon recommends a short test recording to verify the data stream is 
being sent. The SPK - Activity pane in PlexControl should show the 

Arm Start recording

No data
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presence of the data stream, similar to that shown in the PlexControl 
image above. 

4.6.6 Tracking Parameters - List of Configuration Procedures

The following sections contain procedures that configure the tracking parameters 
for specific experimental applications. Select the appropriate procedure for your 
experiment: 

• Section 4.7, “Object Contour Tracking” on page 93

• Section 4.8, “LEDs In Darkness with LED Tracking” on page 108

• Section 4.9, “LEDs In Darkness or Light with Extended Tracking of Color 
Markers Mode” on page 112

• Section 4.10, “Extended Tracking of Color Markers In Light” on page 114

• Section 4.11, “Tracking Color Markers (Legacy Capability)” on page 123

4.7 Object Contour Tracking

Object Contour tracking records coordinate data for the movement of an animal 
within an experimental arena without requiring LEDs or reflective color markers 
to be attached to the animal. 

In Object Contour tracking mode, the system compares the color of the animal 
with the background color and any background objects. The image below shows 
a dark colored animal to be tracked on a light colored background and without 
any background object in the window. The background’s light color is uniform 
and provides a good contrast to the animal’s color.

TIP
Tracking Data - Add it in real-time or add it later
If the PLX button for the desired tracking data is pressed before the 
start of recording, as explained in the procedure above, CinePlex 
Studio sends the tracking data to the OmniPlex System in real-time.

If you forget to press a particular PLX button before starting 
recording, or want to press different PLX button(s) later, CinePlex 
Editor can be used to replay the PLX and AVI files, and overlay the 
coordinate data. (CinePlex Editor is installed separately.)
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The image below shows an example of a well defined animal contour generated 
by CinePlex Studio.
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4.7.1 Configuring Parameters for Object Contour Tracking

Perform these steps to select and configure Object Contour tracking.

1 Place the animal in the camera field of view.

2 At the camera lens, adjust the zoom, focus, and iris settings for the best 
picture quality. For additional guidance on camera setup and video quality, 
see Section 3.1, “Setting Up Cameras and the User Interface” on page 26.

3 To select the Object Contour tracking mode, click the appropriate icon on the 
Tracker toolbar.

4 Click the Tracking tab to display the tracking parameters. In the Whole Body 
Visualization group check Contour and Fill Contour so that the objects 
found by the system are visible.

5 In the video image, view the contour(s) of the object(s) that the system is 
tracking. If the contour of the tracked object is not well defined, follow the 
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instructions in one or both of the following sections to obtain good tracking 
results:

• Section 4.7.2, “Setting the Threshold” on page 96

• Section 4.7.3, “Object Contour Mode Advanced Functions - Overview” on 
page 98

6 (Optional) After the Tracking parameters are set as desired, click the Save 

Settings button ( ) on the toolbar, or, on the File dropdown menu, click 
Save Settings:

4.7.2 Setting the Threshold

CinePlex Studio can locate an object of a specified color by the color contrast 
between the desired color and the threshold setting. If the animal has good 
contrast relative to the arena image, and the background is uniform (that is, there 
are no other objects with similar contrast), adjust the Threshold setting in the 
Object Contour Tracker area to fill the whole image of the animal.

Note: If the background is not uniform or does not have good contrast with the 
animal, setting the Threshold parameter might not be sufficient for tracking. If 
this condition exists, perform the procedure in Section 4.7.5, “Background 
Subtraction” on page 101 to remove the background from the video.

The Threshold is set in the Object Contour Tracker group.
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The image below shows an example of a well defined animal contour.

Use the guidelines below to adjust the Threshold setting.

If the threshold setting is too low, the image could be similar to the one shown 
below. It will probably be necessary to experiment with the setting to obtain the 
optimal value.

If the size of the found target object is larger than 1/4 of the frame area, there will 
be a red blinking message on the bottom of the screen notifying that the threshold 
is probably too low and both the Arm and Record buttons will be disabled.

(Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.
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4.7.3 Object Contour Mode Advanced Functions - Overview

For some experimental arrangements, adjusting the Threshold setting is not, by 
itself, sufficient to obtain the desired tracking results. Additional adjustments 
may be needed. Object Contour mode includes optional advanced functions to 
handle special circumstances in the experimental environment. These functions 
are accessed in the Tracking pane.

Use one or more of the following procedures to improve tracking:

• Section 4.7.4, “Detail Filtering Adjustment” on page 99

• Section 4.7.5, “Background Subtraction” on page 101

• Section 4.7.6, “Close Contour Option” on page 105

• Section 4.7.7, “Motion Measure Option” on page 107



 

Version 3.7 99

4.7.4 Detail Filtering Adjustment

Use Detail Filtering to remove small features of the image that distort the 
tracking results. For example, a long tail on a target animal can skew the centroid 
calculation; cables attached to the target can also skew the results. The Detail 
Filtering adjustment parameter, which has a range of 1 - 10, can remove 
progressively larger features. Use the lowest setting that provides adequate 
results for the experiment.

To set the Detail Filtering Adjustment value

1 In the Properties window Object Contour Tracker area, click Show Contour, 
Fill Contour and/or Find All Objects checkboxes, and view the video image.

2 Select Detail Filter in the Contour Treatment pulldown menu.
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3 Click Detail Filter and set the slider to 2.

4 Observe the effect on the image. Set the Detail Filter slider to lowest setting 
that removes the undesirable features from the target image.

5 (Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.
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4.7.5 Background Subtraction

If a background object (or background color) might interfere with the tracking 
function, the system can be configured to ignore the object (or colored area). This 
will allow the system to track the animal correctly. 

This image shows an animal to be tracked along with a background object of 
approximately the same color. The background object is larger than the animal 
and the system is tracking the background object (the red cross hair is centered on 
the object and the tracking window [yellow rectangle] is surrounding the object). 

To avoid this situation, the experimenter can use one or both of the following 
tools:

• Use background subtraction (discussed in this section)

• Define a specific arena shape in which to track (discussed elsewhere in this 
chapter)
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Example - Using Background Subtraction to Exclude Background 
Objects 

This image shows the background object with nothing else in the window. You 
can capture the image of this window to use for background subtraction.

This image shows the background object and the animal together after the user 
has configured the background subtraction function. Note that the system is 
tracking the animal, as indicated by the positions of the red cross hair and yellow 
rectangle and the contour around the animal.
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Example - Using Background Subtraction to Exclude a Low-Contrast 
Background Color

Background subtraction will allow you to do body tracking even when there is a 
low color contrast between the animal and background, a condition which is seen 
in the following image.

Example - Using Background Subtraction with a Multicolored Animal

You will be able to track multicolored animals using Plexon’s special algorithm 
of background subtraction. In this case be sure that all colors contrast with the 
background color. You can use different background colors to try to improve the 
quality. For example, a brick red background works well for Long-Evans rats. 
Note that the contour encloses the complete animal
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To apply the Background Subtraction option

1 In the Object Contour Tracker area, ensure that the Contour and Fill 
Contour checkboxes are selected (so the object contour can be viewed in the 
Video pane later in this procedure).

2 Remove the animal from the tracking area.

3 Capture background image by clicking the Camera icon. The Use 
Background control will activate so that it may be clicked.

4 Check the Use Background checkbox (see diagram above). Checking this 
box configures the system to subtract the background image from the video.

Note: Pressing the eye icon brings up a window containing the latest 
background image. Pressing the scissors icon deletes the latest 
background image.

5 Replace the animal in the tracking area.

6 Adjust the Threshold (see diagram above) so the animal is detected and the 
animal’s outline is filled in the Video pane (see Section 4.7.2, “Setting the 
Threshold” on page 96).

7 (Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.
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4.7.6 Close Contour Option

The Close Contour capability causes the tracker to merge multiple objects in near 
proximity to each other into a single object. This can occur, for example, when a 
cable passes between the animal and the camera. Adjust the setting so that a 
single object is displayed. The image below is taken before the Close Contour 
setting is applied.

To apply the Close Contour option

1 Select Close Contour in the Contour Treatment pulldown menu.
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2 Adjust the Close Contour setting until the image contour is closed.

The image below is taken after the Close Contour setting is applied.

3 (Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.
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4.7.7 Motion Measure Option

CinePlex Studio Motion Measure is an Object Contour mode option that can be 
used for studies of an animal’s freezing behavior. Motion Measure is the 
normalized contour difference of the animal’s body computed on a frame-by-
frame basis.

Note: The Motion Measure option must be included during a CinePlex Studio 
recording or re-recording session if you plan to analyze the data with the 
CinePlex Editor Freezing Detector function. See the CinePlex Editor User 
Guide for information about the Freezing Detector.

If the Motion Measure checkbox is selected, CinePlex Studio writes the motion-
measurement data for each video frame to the AVI and DVT files. If the PLX 
button beside the Motion Measure checkbox is selected, Studio also writes the 
data to the OmniPlex System.

To apply the Motion Measure option

1 On the Object Contour Tracker menu, double-click the Motion Measure 
checkbox to enable Motion Measure.

2 Click on the PLX button, if desired, to write Motion Measure data to the 
OmniPlex System. (The PLX button turns orange when selected.)

3 (Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.
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4.8 LEDs In Darkness with LED Tracking

This section configures CinePlex Studio to track colored LEDs in darkness with 
the LED tracking mode selected. Up to three different colored LEDs can be 
tracked.

In darkness, the LEDs are the brightest spots in the window, therefore, the LED 
tracking mode is excellent for this condition. The image below shows three LEDs 
being tracked in darkness.

4.8.1 Configuring Parameters for LED Tracking

Perform these steps to select and configure LED tracking.

1 Place powered LEDs in the camera field of view.

2 At the camera lens, adjust the zoom, focus, and iris settings for the best 
picture quality. For additional guidance on camera setup and video quality, 
see Section 3.1, “Setting Up Cameras and the User Interface” on page 26.

3 To select the LED tracking mode, click the appropriate icon on the Tracker 
toolbar.

4 Click on the Tracking tab in the Dynamic Configuration pane to view the 
Tracking parameters.

5 In the LED Visualization group check Contour and Fill Contour so that the 
objects found by the system are visible. These selections are common to all 
LEDs used in the experiment.
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6 Check the Pure Colors checkbox in the LED Tracker area. Checking this box 
causes the standard red, green and blue LED colors to appear in the LED 
Colors area in the Tracking configuration pane.

Note: In Pure Colors mode, software is optimized for the red, green and/or 
blue LEDs supplied by Plexon. 

7 Check each color to track in the LED properties area (LED 1, LED 2 and/or 
LED 3).

8 For each color checked in Step 7, check the PLX button, if desired, to send a 
copy of the tracking coordinate data to the OmniPlex System. (The PLX 
button turns orange when selected and clear when deselected.)

9 Change the Threshold (common to all LEDs) so that the correct objects are 
filled and outlined on the Video window. Their color crosses (representing the 
centers of gravity) should be centered on the correct objects.

10 If pure colors do not give good results, use the pick-up tool to select the color 
from the video (see "Using the Color Pick-up Tool with LED Tracking" below). 
Adjust the Threshold as needed.

11 (Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.
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4.8.2 Using the Color Pick-up Tool with LED Tracking

This procedure explains how to use the color pick-up tool to adjust Color 1, Color 
2, or Color 3 to match an existing color of an LED on the animal.

LED color shade selection is possible, but requires precision in the pixel selection 
process. This is because an LED image is a hot white center surrounded by pixels 
of varying shades of color. You must click on one of the pixels of the desired 
color, but not white.

1 To use the color pick-up tool on a specific LED, click on the Color Selection 
box for the color that is to be adjusted.

2 The image below shows a sample video window before clicking the Color 
Selection box.

3 In the Video window a square area surrounding the cursor displays as a 
magnified window. Move the magnified window over the area to be shown in 
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the Color Selection box. The image below shows the magnified cursor 
window in the lower left of the diagram - note the digitization of the area.

4 Position the crosshair over a representatively colored pixel. The Color 
Selection box displays the color of the pixel directly under the crosshair. The 
image below shows a red pixel under the magnified area.

Note: Be sure that the pixel is the dominant color of the LED, and not the 
white center of the LED.

5 Click the pixel.

6 The color of the corresponding color box in the properties window will be 
changed to that of the clicked pixel.

7 Change the Threshold (common to all LEDs) so that the correct objects are 
filled and outlined on the Video window. Their color crosses (representing the 
centers of gravity) should be centered on the correct objects.

Note: For a general discussion of Threshold values, see Section 4.7.2, 
“Setting the Threshold” on page 96.
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8 If the cursor does not track accurately with the threshold set to optimum, 
change the color or adjust the sharpness and saturation. 

9 Repeat the steps in this section for any additional camera(s) to be used in the 
experiment.

10 (Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.

4.9 LEDs In Darkness or Light with Extended Tracking of Color 
Markers Mode

CinePlex Studio can track colored LEDs in darkness or light with the Extended 
Tracking of Color Markers mode selected.

In darkness, the LEDs are the brightest spots in the window, therefore, the 
Extended Tracking of Color Markers mode works well for this condition. The 
system treats the LEDs as if they were reflective colors. The image below shows 
three LEDs being tracked in darkness.

In light, the LEDs might (or might not) be the brightest spots in the window. If 
the LED colors have sufficient brightness and contrast with respect to the 
background, Extended Tracking of Color Markers works well for this condition. 
The image below shows three LEDs being tracked in light.
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Note regarding use of the color pick-up tool with LEDs

With the color pick-up tool, LED color shade selection is possible, but requires 
precision in the pixel selection process. This is because an LED image is a hot 
white center surrounded by pixels of varying shades of color. You must click on 
one of the pixels of the desired color, but not white.

To configure tracking of LEDs with Extended Tracking of Colors mode

Follow the same procedure as with Section 4.10, “Extended Tracking of Color 
Markers In Light” on page 114.
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4.10 Extended Tracking of Color Markers In Light

This section configures CinePlex Studio to track reflective colored markers in 
light with the Extended Tracking of Color Markers mode selected. Up to 12 
different colored markers can be tracked.

The image below shows three reflective markers being tracked.

4.10.1 Enabling Extended Tracking of Color Markers In Light

Perform these steps to select and configure Extended Tracking.

1 Place the colored targets in the camera field of view.

2 At the camera lens, adjust the zoom, focus, and iris settings for the best 
picture quality. For additional guidance on camera setup and video quality, 
see Section 3.1, “Setting Up Cameras and the User Interface” on page 26.

3 To select the Extended Tracking of Colors mode, click the appropriate icon on 
the Tracker toolbar.

4 Click on the Tracking tab for Camera 1 in the Dynamic Configuration pane to 
view the Tracking parameters.

5 In the Marker Visualizations group check Contour and Fill Contour so that 
the objects found by the system are visible. These selections are common to 
all color markers used in the experiment.
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6 In the Marker Colors and Additional Marker Colors areas, click the 
checkboxes to select the colors to be tracked. 

Note: You can track markers of the same color with different sizes. 
See "Examples of Tracking Markers of the Same Color but Different 
Sizes" (below).

7 For each color checked in Step 6, check the PLX button, if desired, to send a 
copy of the tracking coordinate data to the OmniPlex System. (The PLX 
button turns orange when selected and clear when deselected.)

8 Follow the procedure in "Examples of Tracking Markers of the Same Color but 
Different Sizes" (below) to select the specific colors to track.

9 (Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.

4.10.2 Examples of Tracking Markers of the Same Color but Different Sizes

You can use several markers of the same color, but differing in size, from up to 
four video streams; the system will track each of those markers.

Example 1

In the example below, Markers 1 and 2 are configured for the same color, but the 
Object Size parameters have been set with mutually exclusive size ranges—see 
Min Size and Max Size for Markers 1 and 2.
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Note: One typical use for this approach is the tracking of animals in the dark using 
infrared cameras. In this mode, you might be tracking two animals, one with all 
dark fur and one with half of its fur dark. By specifying different sizes for the two 
markers, you can track each animal independently.

The image below shows how the two objects are tracked independently. (The 
colors of the crosshairs are selected in the Mrk 1 Visualizations and Mrk 2 
Visualizations. You can select any convenient colors for the crosshairs.)
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Example 2

In the example below, there are two dark areas of different sizes on the animal. 
These two dark areas are being tracked independently.

Note: The tracking of two same-colored markers of different size can also be applied 
to experiments involving infrared imaging. Colors are not visible in infrared, so 
two animals (or two parts of a single animal) can be marked by markers of the 
same color, but having different size. You need to make sure of course the 
markers exhibit significant infrared contrast to the animal, for example, white 
markers on a black animal.
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Example 3

In the example below, there are two dark animals of different sizes. These two 
dark areas are being tracked independently.

Here are the settings that specify the tracking seen in the above image:
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4.10.3 Using Color Pick-up Tool on Extended Tracking of Reflective Colors

This procedure explains how to use the color pick-up tool to adjust any of the 
tracked colors (Color 1 through Color 12) to match an existing color of a 
reflective color marker on the animal.

1 To use the color pick-up tool on a specific color, click on the Color Selection 
box for the color that is to be adjusted.

2 The image below shows a sample video window before clicking the Color 
Selection box.

3 In the Video window a square area surrounding the cursor displays as a 
magnified window. Move the magnified window over the area to be shown in 
the Color Selection box. The image below shows the magnified cursor 
window in the lower left of the diagram - note the digitization of the area.
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4 Position the crosshair over a representatively colored pixel. The Color 
Selection box displays the color of the pixel directly under the crosshair. The 
image below shows a red pixel under the magnified area.

5 Click the pixel.

6 The color of the corresponding color box in the properties window will be 
changed to that of the clicked pixel.
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7 Click the checkbox for Fill Contour in the Marker Visualizations area (if not 
already selected) so that the image of the selected object is seen in the video 
image.

8 Repeat Step 1 through Step 7 for the other colors that will be tracked in the 
experiment.

9 Work with the Tolerance parameters (in the following section) to improve 
tracking efficiency.

10 (Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.

4.10.4 Improve Tracking Efficiency with Tolerance Parameters

1 If necessary to improve tracking, adjust the H, S and V tolerances so there 
are no Intersects among the various colors.

2 Change the H, S and V Tolerance setting so that the correct object is filled 
and outlined on the Video window. The crosshair should be centered on the 
correct object.

Note: Do not change the Adjust HSV settings manually. These settings 
were adjusted automatically by the system when you clicked the 
colored pixel in the earlier step.

3 If the above steps do not provide accurate visualization of the objects that 
need to be tracked, or do not eliminate all the Intersects, consider making 
some or all of the following additional adjustments and changes: 

• Use different marker colors, especially if two of the colors being used in 
the experiment are similar to each other.

• Increase the lighting level in the experimental area, if possible.

• Reduce the number of color markers being used in the experiment.

• Increase the gain on the camera (although this will also increase noise).

Note: The above list is intended as a general guide. If you need additional 
information on these adjustments, contact Plexon Support.
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4 After completing the previous steps, verify that the video display looks similar 
to the following image, in which the system is set up to track three colors.

5 Repeat the steps in this section for any additional camera(s) to be used in the 
experiment.

6 (Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.

4.11 Tracking Color Markers (Legacy Capability)

This section configures CinePlex Studio to track an animal with Color Markers 
tracking mode selected, and with any of the following experimental 
configurations:

• LEDs in darkness

• LEDs in light

• Reflective colored markers in light

Note: This mode of tracking is retained for legacy purposes only, for experimenters 
who have been using this mode and wish to continue doing so. In this mode, up 
to 5 colors can be tracked in the typical arena. It is possible to track more than 
5 colors, but only if the arena lighting is sufficient. For new experiments, Plexon 
strongly recommends using the Extended Tracking of Color Markers, as 
described elsewhere in this chapter.

The images below show LEDs in darkness, LEDs in light, and reflective markers 
(respectively) being tracked.
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4.11.1 Enabling Color Markers Tracking Mode

Perform these steps to select and configure Color Markers tracking mode.

1 Place the colored targets in the camera field of view.

2 To select the Color Markers tracking mode, click the appropriate icon on the 
Tracker toolbar.

The Tracking pane for the selected tracking mode displays in the Static 
Configuration pane.

3 In the Visualization group check Contour and Fill Contour so that the 
objects found by the system are visible. These selections are common to all 
color markers used in the experiment.

4 Check the Default Colors checkbox in the Marker Properties area.



4  Recording Positional Data with CinePlex Tracking Option  

126 CinePlex Studio

5 Check the color to track by clicking the corresponding checkbox.

6 If any settings need to be changed for a particular color, click on the ‘+’ for that 
color.

7 Adjust the Threshold of the selected color (see diagram below) so that the 
correct object is filled and outlined on the Video window and its color cross is 
properly centered.

Note: If working with default colors, the Threshold should be moved to 
lower values to provide stable tracking.
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Note: For a general discussion of Threshold values, see "Setting the 
Threshold" (below).

8 If the default colors do not give good results, select the color from the video. 
To do this, use the method described in Section 4.10.2, “Examples of Tracking 
Markers of the Same Color but Different Sizes” on page 115. Adjust the 
Threshold higher to find and track the object.

9 Repeat Step 6 through Step 8 for each color selected.

10 (Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.

4.11.2 Setting the Threshold

CinePlex Studio can locate an object of a specified color by the color contrast 
between the desired color and the threshold setting. If the marker has good 
contrast relative to the animal, adjust the Threshold setting in the Marker 
Colors area to fill the whole image of the animal.

The Threshold is set in the Marker Colors group.

Use the guidelines below to adjust the Threshold setting.
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If the threshold setting is very low, the image could be similar to the one shown 
below. It will be necessary to experiment with the setting to obtain the optimal 
value.

If the size of the found target object is larger than 1/4 of the frame area, there will 
be a red blinking message on the bottom of the screen notifying that the threshold 
is probably too low and both the Arm and Record buttons will be disabled.

If the threshold is low, the center of gravity crosshair will exhibit jitter. Click the 
Fill Contour checkbox to view the contour that the system is tracking. The image 
below shows an example. There are several parasite objects that are being tracked 
in addition to the desired marker.

Try to set the threshold so that the number of parasite objects is as few as 
possible. 

There is an additional tool to use to check whether the threshold is set too low. To 
see all objects, click the Fill All Objects checkbox. As shown in the image 
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below, the system is tracking the correct object, but it is also wasting bandwidth 
analyzing a large number of parasite objects.

Note: The Fill All Objects function (which displays the blue objects inside the green 
rectangle in the above image) is automatically disabled when the recording 
starts, and these objects are not displayed during recording.

Increase the threshold to reduce the number of parasite objects. The image above 
shows the tracked object (in green), but the image also contains a large number of 
parasite objects (in blue). After you increase the Threshold value, there should be 
fewer parasite objects. The image below shows very few parasite objects and 
effective tracking of the desired object.

Increasing the threshold does not work in all cases. If the threshold is too large, 
the target object will be smaller.
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(Optional) After the Tracking parameters are set as desired, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.

4.12 Calibrating the Arena Dimensions

In many experiments, it is useful to calibrate the video image so that sizes, 
positions and velocities are reported in the desired units of measure instead of 
pixels. See Section 3.3, “Calibrating the Arena Dimensions” on page 30 for the 
procedure.

4.13 Recording Synchronized Video Tracking and Neural Data

This section explains how to record video and tracking data that is synchronized 
with neural data from the OmniPlex System. This procedure requires starting and 
stopping the CinePlex Studio video recording process remotely from the 
OmniPlex System. This method of triggering the recording ensures that:

• The timestamps in the CinePlex and OmniPlex files are derived from the 
same clock

• The CinePlex and OmniPlex file start times and stop times are synchronized

• The CinePlex frame numbers, coordinate data and timestamps are 
synchronized

Simultaneous starting, stopping, pausing, and resuming of the neural data and 
video files is essential in helping the researcher correlate the behaviors captured 
in the video with the observed neural activity.

Although you may manually start, stop, pause, and resume recording an AVI file 
at any time in CinePlex Studio by simply clicking the appropriate toolbar buttons, 
this method will not record synchronized files, because it produces video files 
that do not have the same start time as the corresponding neural data files.

4.13.1 Recording Procedure

Perform these steps to record synchronized video and neural data.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.
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1 Ensure that the system is connected as described in Appendix A-Cabling 
Guide so that the clock and control signals can be sent from the OmniPlex 
System to the CinePlex Studio components.

Note: For more information on setting up and running the OmniPlex Server 
and PlexControl, refer to the OmniPlex instructions. 

2 At the OmniPlex chassis, turn the power on and start the OmniPlex Server 
and PlexControl.

3 If not already done, configure the OmniPlex System.

4 Click the Start Data button in the PlexControl toolbar so that neural data 
acquisition begins, and the neural data appears in PlexControl display.

5 Double-click the CinePlex Studio icon. Wait for the CinePlex Studio 
application main window to appear on the monitor.

Note: If Studio does not detect the OmniPlex clock, an error message will 
appear. If it does, see Appendix D-Troubleshooting.

6 Verify that “Cameras” is selected in the Studio pulldown menu and that a 
camera image is displayed for Camera 1. (It is acceptable if other camera 
video images are also displayed, but Camera 1 is required.)

7 If there is an appropriate file containing all the desired CinePlex settings (with 
the tracking function configured), load the file onto CinePlex Studio using the 

Load settings icon ( ) on the main toolbar or the File/Load Settings menu 
selection.

8 Click on the Global Config tab in the static configuration pane to display the 
Global Config pane. 

Note: This pane is the first an experimenter will normally use when setting 
up CinePlex Studio, but perhaps not very often after that. It contains 
settings that pertain to the frame rate to use when recording, image 
resolution (quality of recordings to make), compression bit rate, local 
file name, and whether the experiment involves one animal or many. 

CAUTION
Lighting Conditions
If lighting conditions change enough during recording that ‘objects 
too large’ or some other condition occurs, the position data may be 
meaningless.
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9 View the settings in the Global Config pane and modify any that need to be 
changed prior to starting the next recording session:

10 To browse for the desired file location (where the recorded files will be saved), 
click on the browse icon, which is the rectangle with three dots on the Rec 
Folder row of the Global Config tab.

11 When the Browse for Folder appears, use standard Windows® methods to 
select or create the appropriate folder. The factory default location for the 
Recording folder is C:\PlexonData or D:\PlexonData (if disk D is available).

12 When finished choosing or creating a storage folder, click OK.

Note: The location of the Recording folder is included in the Settings file (if 
you save a Settings file), and is restored when the Settings file is 
loaded. To save settings, click Save Settings on the File menu, or 

click the Save Settings button ( ) on the toolbar.

13 To view the CinePlex Studio time display, select the Source 1 tab in the Video 
1 window, and view the digital video recording (DVR) section. (CinePlex 
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Studio maintains a time code that tracks the time elapsed since the last time 
recording began.)

14 In the Timecode options, select the In Video checkbox to include the time. 
Choose a Location and a Format setting to configure the display.

For example, the following images show the time code in the Upper Left loca-
tion in SSSSS.SSS and HH:MM:SS.SSS format, respectively.
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15 In the Camera area, adjust the controls to obtain an acceptable image on the 
screen. The specific controls vary depending on the camera model. Typical 
adjustments include Gain, Auto White Balance, Brightness, Sharpness 
and Saturation.

Note: You can also use other image quality settings. To evaluate image 
quality settings, manually collect a set of AVI files at different settings 
and use the file mode to determine a minimum acceptable image 
quality setting for the experiment. 

16 In the digital video recording (DVR) area of the Sources pane, select the 
type(s) of output to create - video file (AVI File), text file with digital video 
tracking (DVT File) data, neither or both.

TIP
Reducing blurs and color streaks in the video
If the experimental subject moves quickly, blurs and color streaks 
can appear in the video. Reduce or eliminate these problems by 
increasing the shutter speed. See Shutter (ms) in the Source 
settings, as shown in the image above.

For additional tips, see “Sharpening the Image” on page B-7 in 
Appendix B, Optimizing Camera Mounting and Lens Usage.

CAUTION
Save the AVI File
It is strongly recommended that you save an AVI File for every 
experimental run, even if you are sending data directly from 
CinePlex to OmniPlex. (The AVI File is the default output type.) The 
AVI file is the originally recorded video of the experiment, and it can 
be retrieved and analyzed again. If you deselect the AVI File 
checkbox, the original video will not be saved. 
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17 You have the option to send tracking data from CinePlex Studio to the 
OmniPlex System. To send tracking data, click the PLX button(s) in the 
Camera 1 pane for the type(s) of data to be sent. (If no PLX button is 
checked, no data will be sent to the OmniPlex System during the recording 
session.)

Note: When a PLX button is selected, it turns orange; when it is not 
selected, it is clear.

The following conditions apply to the process of sending tracking data from 
CinePlex Studio to the OmniPlex System:

• Data can be sent for Camera 1 only.

• Data can be sent in online (“Cameras”) mode only, not in offline (“Files”) 
mode.

• Data can be sent for up to three LEDs or colored markers. (Only three of 
the PLX buttons can be active simultaneously.)

TIP
Timestamps, frame numbers and tracking data—DVT File
The system will generate a digital video tracking (DVT) file if you select the 
DVT File checkbox. The DVT file will have frame numbers and timestamps 
as data extracted from the AVI files with the Extractor Function. However 
there is an algebraic relationship between the tracking coordinates extracted 
from the AVI file versus the coordinates listed in the DVT file. See Chapter 
7, Extractor Procedures.
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18 (Optional) If the arena dimensions have not yet been calibrated, the 
calibration can be done now. See Section 3.3, “Calibrating the Arena 
Dimensions” on page 30 for details.

19 Repeat Step 13 through Step 16 for any other cameras connected to the 
system.

20 From the CinePlex Studio toolbar, click the “A” arming button. A yellow 
flashing cassette icon appears on the status bar.

Note: At this point, there is no tracking data being sent from CinePlex 
Studio to the OmniPlex System. In the armed condition, Studio is 
waiting for a start signal to be sent from the OmniPlex System. The 
SPK - Activity pane in PlexControl shows no data on the CPX1 line.

21 From the PlexControl toolbar, click the Start Recording icon. If PlexControl 
prompts for a file name, enter it.

PlexControl starts recording and displays status information about the neural 
data file on the PlexControl status bar; for information on the PlexControl sta-
tus, see the OmniPlex System instructions.

Studio automatically starts recording and displays information about the video 
file in the Studio main window status bar.

The Studio status bar will display the amount of free space remaining on the 
drive selected.

Note: The system automatically checks that there is at least 10 GB of free 
disk space on the PC before it starts recording a file. The file size can 
grow to fill the space available, except that the system automatically 
stops recording the current file when the available disk space has 
been reduced to 10 GB. 

Studio starts sending the coordinate data to the OmniPlex System, and the 
SPK - Activity pane in PlexControl shows the synchronized data stream (see 
the blue data lines in this image):

Note: Plexon recommends a short test recording to verify the data stream is 
being sent. The SPK - Activity pane in PlexControl should show the 
presence of the data stream, similar to that shown in the PlexControl 
image above.

22 To pause recording, click the PlexControl Pause Recording icon. 

PlexControl pauses recording and displays status information about the neu-
ral data file on the PlexControl status bar.
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CinePlex Studio pauses recording and displays information about the video 
file in the CinePlex Studio status bar. The status bar flashes green and gray to 
indicate that the recording is paused.

To resume recording, click PlexControl Pause Recording again.

23 To stop recording, press the Stop Recording button in PlexControl (Studio 
recording stops also.)

PlexControl stops recording to the neural data file, clears the recording infor-
mation from the status bar, and saves the file as specified in Step 21. 

Studio stops recording and saves the video file(s) to the location that was 
specified as Rec Folder in the CinePlex Studio Global Configuration Pane. 
Studio clears the recording information from the status bar and re-arms itself 
for the next recording session.

When Studio is armed, for efficiency it creates temporary files. When record-
ing is started remotely (from the OmniPlex System), Studio writes to these 
temporary files. When recording is stopped, the temporary files are renamed, 
and new temporary files are opened in anticipation of a new recording ses-
sion. The Studio Messages Pane displays information similar to the example 
below.

Note: At this point, there is no tracking data being sent from CinePlex 
Studio to the OmniPlex System, because Studio is once again in the 
armed condition. The SPK - Activity pane in PlexControl shows no 
data on the CPX1 line.
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24 You can start and stop recording as many times as desired. When recording 
starts, tracking data will flow from CinePlex Studio to the OmniPlex System. 
When recording stops, tracking data does not flow.

25 To disarm CinePlex Studio, from the DVR toolbar, click Arm to clear. The 
status bar returns to the disarmed state.

26 To view the captured video file, browse to the file location and double click to 
open the file.

27 To transfer files to an analysis computer (if different than the recording 
computer), follow standard Windows procedures. 

28 To view the neural and video files together, use CinePlex Editor. You can also 

view just the video files using CinePlex Editor, Windows Media Player® or 
CinePlex Studio on the analysis computer. (CinePlex Editor is installed 
separately.)

29 (Optional) If you want to save the settings from this session, on the File menu, 

click Save Settings, or click the Save Settings button ( ) on the toolbar.

4.13.2 File Naming Procedure During and After Recording

During the recording process, CinePlex Studio creates temporary names for the 
AVI files. When the recording is stopped, Studio renames the files.

If there is only one camera connected to the CinePlex System:

• The format of the temporary files is yyyymmddnnn.avi

• The format of the renamed files is PLX_file_name.avi

If there are multiple cameras connected to the CinePlex System:

• The format of the temporary files is yyyymmddnnn_N.avi

• The format of the renamed files is PLX_file_name_N.avi

where:

yyyymmdd is the year, month and day

TIP
Tracking Data - Add it in real-time or add it later
If the PLX button for the desired tracking data is pressed before the 
start of recording, as explained in the procedure above, CinePlex 
Studio sends the tracking data to OmniPlex in real-time. 

If you forget to press a particular PLX button before starting 
recording, or want to press different PLX button(s) later, CinePlex 
Editor can be used to replay the PLX file and overlay the coordinate 
data. (CinePlex Editor is installed separately.)
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nnn is a 3-digit number, 001, 002, ... 999 assigned automatically by the 
system

N is the camera number for which the file is created - 1, 2, ...

PLX_file_name is the file name specified by the user on the OmniPlex 
System in Step 21 of Section 4.13.1, “Recording Procedure” on page 130.

Note: If Studio is armed on one day, but the start signal is not received until the next 
day, the temporary filename remains the one for the previous day.

4.14 Monitoring the Video During a Recording Session

The status bar in the CinePlex Studio main window displays information that 
allows the researcher to monitor the video recording process. See the section 
Section 3.6, “Monitoring the Video During a Recording Session” on page 52 for a 
description of this feature. 

4.15 Recording Video without Neural Data (Used for Animal Training)

You can record video and tracking data without neural data. In this case, the 
OmniPlex System is activated only for the purpose of providing the required 
clock for the CinePlex System. This procedure requires activation of the 
OmniPlex data stream (which starts the clock), and then starting and stopping the 
CinePlex Studio video recording process locally (using the CinePlex controls). 
This method of triggering the recording is typically used during animal training, 
when no neural data are being collected.

See the section Section 3.8, “Recording Video without Neural Data (Used for 
Animal Training)” on page 56 for this procedure. 

Note: In addition to the parameters configured in that procedure, you can also 
configure the Tracking Option parameters. If the Tracking Option is enabled 
and the DVT file format is selected, the DVT file will contain the tracking 
coordinates.

4.16 Video Playback In Files (Offline) Mode

CinePlex Studio can be used in offline mode to play back and rerecord video 
from existing files. The existing AVI and/or DVT files are the ones recorded 
previously by means of the procedure in Section 4.13, “Recording Synchronized 
Video Tracking and Neural Data” on page 130.

TIP
Verify that the tracking window is displayed as expected
During the recording, you should see that the tracking window is 
successfully following the subject in the arena. 
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The procedure is the same as presented in Section 3.9, “Video Playback and 
Rerecording in Studio Files (Offline) Mode” on page 63.

4.17 Additional File-processing Tools

The following tools can also be used for processing of files:

• Use the Retrack AVI feature if you want to re-record an existing video file 
with modified arenas, or with different parameter settings than those used in 
the original recording. See Chapter 6, Retrack AVI Procedure.

• Use the CinePlex Studio Extractor to extract static and dynamic data from a 

Plexon AVI file for analysis with a database program such as Microsoft® SQL 

Server® or data processing tools such as Microsoft Excel®. See Chapter 7, 
Extractor Procedures.

• You can use CinePlex Editor (installed separately) to view the AVI file time-
locked (synchronized) with its partner neural data file to see what the subject 
was doing at a time of interest in the neural data. See CinePlex Editor User 
Guide on the Plexon website. The video and neural data are time-locked 
because both systems (the OmniPlex and CinePlex Systems) are running off 
the same clock signal. This ensures that the PLX and AVI files will have the 
same timing.

• You can import and analyze the X, Y position data in PLX files with 

NeuroExplorer®, Version 3.088 or later. For details about NeuroExplorer, see 
www.plexon.com. 

http://www.plexon.com 
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5.1 Introduction to the CinePlex Basic Behavior Option

This chapter describes the CinePlex® Studio Basic Behavior Option, the 
experimental applications for which it can be used, and how to use it. The Basic 
Behavior Option extends the capabilities of CinePlex Studio and CinePlex 
Tracking Option. The Basic Behavior Option requires the CPB V3 license in 
addition to the CPT V3 (Tracking) and CPX V3 (Studio/Editor) licenses.

5.1.1 General Procedure

The general procedure for using the Basic Behavior Option is the same as that for 
the Tracking Option (see Chapter 4, Recording Positional Data with CinePlex 
Tracking Option), with the additional procedures described in this chapter. The 
additional Basic Behavior procedures include:

• Defining static and dynamic zones of interest within an experimental arena

• Defining zone sequences

• Monitoring objects traversing zones and sequences and generating logical 
and digital events

• Defining behavioral events from one or multiple cameras to generate logical 
events and electrical signals

• Recording and viewing real-time and offline information about behavioral 
events and tracked objects, including such attributes as speed, direction 
(vector), limb angles, presence in particular zones in the arena, proximity to 
other objects, sequence of zones visited.

• Monitoring vectors between objects and creating behavioral events when the 
objects are within/outside of a customer-defined angle and tolerance

• Monitoring animal head direction based on markers or LEDs on a headstage.

• Monitoring animal speeds to create digital events when the speed is over/
under a user-specified threshold

• Accumulating and displaying behavioral event statistics

5.1.2 Terminology

The following terminology is useful in discussing behavior recording and 
tracking:

• Zones: A zone is a defined portion of the arena that has significance in an 
experiment. Many zones can be defined simultaneously. CinePlex Studio 
provides tools that allow you to draw zone outlines on top of the video image. 
These tools operate in the same way as the arena tools, allowing complex 
shapes to be created by means of logical operations. 

Note: Complex zones can be created for either static or dynamic zones; see the 
definitions of static zones and dynamic zones, below.
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• Static Zones: Zones that do not move with respect to the image or the arena 
are referred to as static zones. In general, they are used in object recognition 
experiments. For example, a static zone could be an area the animal should 
avoid to receive a reward or it could be an area the animal must traverse to 
receive the reward. It could even be one of the zones in a sequence of zones 
the animal should traverse. 

• Dynamic Zones: A dynamic zone is a circular area around a marker or LED. 
In general, it is used to detect social interactions among animals. Dynamic 
zones are available for LED tracking mode, Color Markers mode and 
Extended Tracking of Color Markers mode. They are not available in Object 
Contour tracking mode.

• Sequences: A sequence is an ordered list of zones. Many different sequences 
can be defined.

• Events: Logical events can be defined so that, when an animal enters or 
leaves a zone, or completes a sequence, the event becomes true. Many events 
can be specified. Their current states are dynamically displayed in the Event 
Statistics pane. The system can generate electrical pulses or levels (high or 
low) based on logical event states or state changes.

• Combination Events: A combination event is an event that becomes true 
when two or more other events are true. The events used in a combination 
event can be generated from one or multiple cameras. This allows events to 
be generated by simultaneous occurrences in several different images, if 
desired.

5.2 Setting Up Cameras and the User Interface

The procedures for setting up cameras and the user interface are the same as those 
used for the basic recording option. See Chapter 3, Recording Video with 
CinePlex Studio.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.
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5.3 Navigating the Studio Main Window

See the section Section 3.2, “Navigating the Studio Main Window” on page 29 
for a basic description of the Studio main window, where you can view and 
modify CinePlex Studio settings before starting the recording session. 

When the Tracking Option and Basic Behavior Option are present, there are 
additional toolbar options and panes, as shown in the image below.

5.4 Defining Arenas and Configuring Tracking Parameters

The procedures for defining the arenas and tracking parameters are the same as 
those used for the Tracking Option. See Chapter 4, Recording Positional Data 
with CinePlex Tracking Option.
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5.5 Configuring Zones, Sequences and Events for Basic Behavior

This section explains how to create and configure zones, sequences of zones, 
events and combination events.

You can specify values for behavioral events for tracked objects, including such 
attributes as speed, direction (vector), limb angles, presence in particular zones in 
the arena, proximity to other objects or sequence of zones visited. For example, 
the system can create a digital event when the animal’s speed is over/under a 
user-specified threshold, or the animal is within a user-specified distance of a 
certain point in the arena.

5.5.1 Before You Start

The procedures in Chapter 4, Recording Positional Data with CinePlex Tracking 
Option are required for configuring an arena for each camera. The arena must be 
configured and the Tracking Option must be configured before a zone can be 
created. The Basic Behavior Option is built on the Tracking Option.

5.5.2 Overview of Procedure

The procedure consists of the following tasks:

• Section 5.6, “Adding Zones (Static and Dynamic)” on page 145

• Section 5.7, “Defining Sequences of Zones” on page 151

• Section 5.8, “Defining Logical Events” on page 154

• Section 5.9, “Defining Combination Events” on page 168

5.6 Adding Zones (Static and Dynamic)

There are two types of zones—static and dynamic. Static zones are created by 
clicking the Static Zone icon and defining the shape, size and location of the 
zone in the video image. Dynamic zones are created by clicking the Dynamic 
Zone icon and selecting the LED or color marker around which to draw it.

Note: See See “Terminology” on page 142 for definitions of static zone and dynamic 
zone. In general, static zones are associated with static objects in the arena 
and dynamic zones are associated with objects attached to the animal.
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5.6.1 Adding a Static Zone

1 On the Scenes tab click the Add static zone to current arena  icon. 

The parameters are displayed for the new Static Zone.
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2 Select the drawing tool that makes the most sense for the zone that needs to 
be created. 

3 Draw the zone outline over the image corresponding to the first physical zone 
of interest. For the image below a red circle was added.

4 Adjust size and shape so that the complete zone, and nothing else, is 
enclosed by the outline. For the image below, the circle was adjusted to fit 
around the clock by moving and adjusting the circle by the handles on the 
yellow square.

5 If a complex zone is desired, select a different drawing tool if needed, and the 
logical operator to be applied. 

Note: Complex zones can be created by applying logical operations to 
additional shapes as they are added to the zone. These logical 
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operations are selected from the Scenes toolbar: 

For a detailed description of the logical operators, see Section 4.5, 
“Defining the Arenas” on page 84.

The image below shows an example of a complex static zone.

 

6 If necessary, adjust the value for the Time Threshold (frames) parameter. 
This parameter specifies the number of frames that an object must be 
detected in the zone before it is considered “present.” Whether an object is 
“present” or not can be used to trigger a zone-related event. For a description 
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of the Present in Zone parameter, see Section 5.8.1, “Events Based on a 
Zone” on page 155.

Note: An object is considered “absent” from a zone in the first frame its 
coordinates are not in the zone.

7 Repeat Step 1 through Step 6 for each additional zone to be defined.

8 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.

5.6.2 Adding a Dynamic Zone

Note: Dynamic Zones are not available for the Object Contour Tracking option.

1 On the Scenes tab click the Add dynamic zone to current arena  icon. 
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The parameters are displayed for the new Dynamic Zone.

 

2 In the Available Objects row, select the specific marker or LED on which the 
dynamic zone will be centered.
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3 If necessary, adjust the values for the Time Threshold (frames) and Radius 
parameters. 

The Time Threshold (frames) parameter specifies the number of frames that 
an object must be detected in the zone before it is considered “present” (and 
a zone-related event is triggered). For a description of the Present in Zone 
parameter, see Section 5.8.1, “Events Based on a Zone” on page 155.

Note: An object is considered “absent” from a zone in the first frame its 
coordinates are not in the zone.

The Radius parameter specifies the radius of the dynamic zone from the 
center of the LED or color marker.

4 Repeat Step 1 through Step 3 for each additional zone to be defined.

5 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.

5.7 Defining Sequences of Zones

Note: Before defining sequences of zones, two or more zones must be defined. 

1 After two or more zones have been added, use the Sequences tab.

2 Click the Add new sequence icon to add a sequence. 

A new sequence is added to the pane.

TIP
To view all panes in the main window, reset to default layout 
If some of the panes are not visible in the main window, it may be help-
ful to restore the default screen layout. From the Window dropdown list, 
select Layout, then Reset to Default Layout.
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3 Click the Add zone to selected sequence icon to add a zone to the 
sequence.

A zone is added to the sequence.

4 Select available zones from the drop down list for the new sequence. 

The selected zone is displayed in the Zone 1 setting.

5 To add a second zone, repeat Step 3 and Step 4.
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The selected zone is displayed in the Zone 1 setting.

6 Repeat these steps for each additional sequence to be defined.

7 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.

TIP
Understanding how sequences of zones are used
The purpose of defining a sequence of zones is to use this sequence 
to define a behavioral event. For example, you might configure an 
event in which the animal enters Zone 1 and receives a stimulus, then 
moves to Zone 2 to obtain a reward, then moves to Zone 3.
When you are configuring a sequence on zones, keep in mind how 
the system detects events based on these sequences, as described in 
Section 5.8.2, “Events Based on a Sequence of Zones” on page 157.
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5.8 Defining Logical Events

Logical events can be defined as TRUE when an animal enters or leaves a zone or 
completes a sequence, or when a specified parameter (the angle between two 
vectors, the animal’s speed or the animal’s head direction) is within a specified 
range.

1 In the Events tab, select the Add new tracking event icon to create an 
Event.

2 In the Target row, select the type of Target behavior to be associated with the 
event.

The available parameters vary according to the type of Target selected. The 
available Targets depend on the type of tracking:

• For Object Contour Tracking, the Targets listed in the dropdown are 
Zone, Sequence and Speed.

• For LEDs, Markers, and Extended Markers, the Targets listed in the 
dropdown are Zone, Sequence, Speed, Angle and Head Direction.

See the specific procedure for each type of Target:

• Section 5.8.1, “Events Based on a Zone” on page 155

• Section 5.8.2, “Events Based on a Sequence of Zones” on page 157

• Section 5.8.3, “Events Based on an Angle” on page 159

• Section 5.8.4, “Events Based on Speed” on page 162

• Section 5.8.5, “Events Based on Head Direction” on page 166
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5.8.1 Events Based on a Zone

1 Select a Zone.

2 Define the Condition.

The Present in Zone event is dependent on the Time Threshold (frames) 
parameter that was set in the Scenes panel (see Section 5.6.1, “Adding a 
Static Zone” on page 146 or Section 5.6.2, “Adding a Dynamic Zone” on 
page 149 as applicable). Specifically:

• The Present in Zone event is triggered only when the coordinates of the 
object are inside the specified zone for the number of consecutive frames 
specified by the value of the Time Threshold (frames) parameter in the 
Scenes panel. 
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• An object is considered absent from a zone in the first frame its 
coordinates are not in the zone.

Note: (The meaning of “object” is explained in the Available Objects 
discussion in the next step.)

3 In the Available Objects row, select a tracked object to traverse the specified 
zone.

The event will become TRUE when the conditions are satisfied. At that point, 
the event count will be incremented and times and track lengths in the Event 
Statistics will be extended.

4 Event statistics can be viewed in the Event Statistics pane of the main 
window.

5 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.
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5.8.2 Events Based on a Sequence of Zones

This section explains how to configure events based on a sequence of zones and 
how the system detects and reports these events. It is recommended that you have 
a thorough understanding of the information in this section when you are defining 
sequences (as described in Section 5.7, “Defining Sequences of Zones” on 
page 151) and when you are creating events based on those sequences (as 
discussed below).

1 Select a Sequence.

2 In the Available Objects row, select a tracked object to traverse the specified 
sequence of zones.

The event will become TRUE when the conditions are satisfied. At that point, 
the event count will be incremented and times and track lengths in the Event 
Statistics will be extended.
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3 Event statistics can be viewed in the Event Statistics pane of the main 
window.

4 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.

Understanding how the system interprets events based on sequences

The system treats sequence-based events “strictly.” Any interruption in the 
traversing of a sequence results in the system restarting the entire sequence from 
the beginning. The following conditions can cause a sequence to restart:

• Loss of tracking of the object fulfilling the sequence for even one frame.

• Exit from the arena by the object fulfilling the sequence for even one frame.

• Entry into any zone not in the sequence.

• Entry into a zone that is not the next zone specified in the sequence (for 
example, a sequence is configured as Zone1 > Zone2 > Zone3, and the object 
enters and exits Zone1 then enters Zone3).

• Exit from any zone in the sequence followed by re-entry into that zone before 
the sequence is completed. However, if it is the first zone, the sequence will 
be restarted.

If a sequence restarts, it means that the event has not occurred. In that case, the 
system does not increment any counters and it resets the timer.

The system computes the track length and time for a sequence event as follows. 
Consider a sequence that consists of an object entering Zone1, then exiting 
Zone1, and some time later entering Zone2 and then exiting Zone2. The system 
starts measuring track length and time when the object enters Zone1 and it stops 
measuring track length and time when the object exits Zone2. The track length 
and time that the object spends between Zone1 and Zone2 are included in the 
total measurements.
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5.8.3 Events Based on an Angle

This section explains how to define and specify values for behavioral events 
based on the angle between two vectors. For example, an event could be 
generated when the animal’s front leg is bent more than a certain angle. 

The procedure for creating an angle-based event involves defining connections 
between pairs of markers (or LEDs) and then defining an angle between a pair of 
connections. In the example shown below, one connection is defined from the red 
marker to the green marker, and a second connection is defined from the red 
marker to the blue marker. Then the angle of interest (Angle Value) is specified as 
the angle those two connections, in degrees.

1 Add connections by clicking on the + icon in the Add/Remove Connections 
row.
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2 Define two or more connections. In the example below, the user is defining 
four connections.

3 Define the event parameters.

The Angle event is considered TRUE only when the angle between the two 
vectors (1st Connection and 2nd Connection) meets the specified 
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Condition for the number of consecutive frames specified by the value of the 
Time Threshold (frames) parameter. The Angle event is considered FALSE 
in the first frame the specified condition is not met.

For example, in the image above, Event 1.1 (the Angle event) will be triggered 
when the observed angle between Connection 1.1 and Connection 1.2 is less 
than 60 degrees for five consecutive frames.

The Available Objects selection (optional) instructs the Event Statistics to 
display the track length of the selected object during the time that the event is 
TRUE.

When the event becomes TRUE, the event count will be incremented and 
times and track lengths in the Event Statistics will be recomputed and 
updated.

4 Event statistics can be viewed in the Event Statistics pane of the main 
window.

5 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.
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5.8.4 Events Based on Speed

This section explains the settings for the calculation of the animal’s speed. It is 
not necessary to adjust any of these settings if you do not need data on the 
animal’s speed (or if you are satisfied with the default values). There are two 
topics in this section:

• Procedure for configuring the Speed event

• How to decrease jitter in the speed calculation

Procedure for configuring the Speed event

1 In the Events pane, specify the Target as Speed.

2 Specify the speed (Value), Time Threshold and Condition, Object 
(Averaged Cent.Grav. or Position of Object) and Available Object, plus 
any additional parameters as needed in the Event group. Speed is recorded 
in pixels/second unless the camera is calibrated, in which case it is recorded 
in cm/second or inches/second.

The Available Object selection specifies the object to be tracked. 

The Speed event will become TRUE only when the tracked Available Object 
has been moving at a speed (Value) that meets the specified Condition for 
the specified Time Threshold. 

3 (Optional) Set the Color parameter. The Color selection defines the color the 
system will use to highlight the event in the Event Statistics frame, provided 
that the event becomes TRUE.

In the example below, if Marker 1 moves faster than 10.0 cm/s for five 
consecutive frames the event becomes TRUE.

When the event becomes TRUE, the event count will be incremented and 
times and track lengths in the Event Statistics pane will be recomputed and 
updated.
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4 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.

How to decrease jitter in the speed calculation

The Speed Averaging Interval (s) specifies the time period or window (in 
seconds) over which the average speed is calculated. This setting is used to 
decrease jitter in the calculation of the speed of a tracked object. When this 
parameter is set to 0 (the default value), the speed is computed for two sequential 
frames, and no averaging is performed.

If you see that the jitter or rapid variation in the speed is causing false triggering 
of speed events, consider setting the Speed Averaging Interval (s) to a non-zero 
value. You can set it to any value from 0 to 1.0 in increments of 0.1s (0.0, 0.1, 0.2, 
... 0.9, 1.0). The larger the averaging window, the less the jitter. However, larger 
averaging intervals decrease the average speed. Therefore, be cautious about 
setting a non-zero value.

Calculation Example

• Assuming the frame rate of the camera is 30 frames per second (fps), a Speed 
Averaging Interval (s) setting of 0 means that the animal’s speed would be 
calculated between sequential frames (30 times per second). Therefore, the 
speed will jitter.

• Assuming a camera frame rate of 30 fps and a Speed Averaging Interval (s) 
setting of 0.5 (0.5 second), the average speed would be calculated as follows: 

Average speed for the 16th frame = 
{ (animal’s location in the 16th frame) – 

(animal’s location in the 1st frame) } / (0.5 second)

Average speed for the 17th frame = 
{ (animal’s location in the 17th frame) – 

(animal’s location in the 2nd frame) } / (0.5 second)
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Usage Example

In the example below, the goal is to determine when the animal is immobile (not 
moving). In this example, there is a great deal of jitter in the unaveraged speed 
data, so that it appears as if the animal is never immobile even though the AVI 
video file clearly shows periods of immobility.

Let’s define immobility as periods with speed less than 1cm/s for a duration of at 
least 60 frames. This means the speed should stay below 1cm/s for at least 2s at 
30 fps. In this graph of the data, it appears that the speed never meets our 
definition of immobility.

In this situation you can use the Speed Averaging Interval (s) parameter to 
remove some of the jitter from the speed calculation. We will set this parameter to 
0.5s and see how it affects the calculated speed.

1
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The results are shown in the graph below. Much of the jitter has been removed, 
and the calculated speed is noticeably lower than before. There are clearly some 
periods of what appears to be immobility as defined above.

1

Periods of immobility
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5.8.5 Events Based on Head Direction

This section explains how to define and specify values for behavioral events 
based on the animal’s head direction as determined with markers or LEDs on the 
headstage. For example, an event could be generated when the animal’s head 
faces toward the feeding station (within a certain number of degrees).

1 In the Events tab, specify the Tolerance (in degrees) and specify the markers 
or LEDs that identify the beginning and end of the head.

2 Specify the Time Threshold in seconds, Object (Averaged Cent.Grav. or 
Position of Object) and the target object (Available Objects). In the image 
below, the feeder location (for example) is identified as Marker 3. The event 
will be triggered when the head direction is within + or - 10 degrees of 
Marker 3 for the specified Time Threshold (five consecutive frames).
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The meaning of these parameters is illustrated in the following diagram:

3 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.
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5.9 Defining Combination Events

1 Use the Combination Events tab.

Note: When two or more video sources are available, combination events 
can be created using events from multiple cameras. This is helpful, 
for example, for triggering an event when an animal is occupying a 
volume that has a different projection in each source. In the example 
below, the Combination Events tag is located in the Global 
Configuration pane; however, if desired, it can be repositioned in 
other panes, for example, the Video1 pane.
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2 Click the Add new combination of tracking events icon. 

3 Select the logical operation to use.

Operation (see the image above)—Used to specify events that are 
combinations of one or more existing events on which logical operations are 
performed. The existing events can be any single or combination event. The 
four logical operators are NOT, AND, OR and XOR:

NOT—For single events, an event can be defined which is the opposite of it 
by using the NOT operator. The new event is true when the original event is 
not true and vice versa (the new event is not true when the original event is 
true). For example, NOT[animal is inside feeding zone] means the animal is 
not inside the feeding zone.

For the combination of two events, the AND, OR and XOR operators are 
available. The resulting combination event is considered true under the 
following conditions:

AND—Both of the individual events are true

OR—Either one of the individual events is true, or both of the individual 
events are true

XOR—Either one of the individual events is true, but not both of them
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4 Select each event in the sequence from the drop down list of available events.

The system generates an entry in the Formula line based on the Operation 
and Event(s) that the user selected in the above steps.

5 If desired, an Event Combination can contain other Event Combinations, as 
shown in the following example. Events of arbitrary complexity can be created 
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by combining already combined events with combined or non-combined 
(single) events.

6 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.
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5.10 Using Dynamic Zones to Detect Social Interactions

If you are tracking an animal by means of LEDs or color markers, you can use the 
dynamic zones capability to detect when a tracked LED or marker moves within 
a certain distance of another animal.

Example—Social interaction—Proximity of animal to another animal

This example defines a behavioral event for an animal’s proximity to another 
animal. For one of the animals, you can define a dynamic zone of a certain radius 
around a marker on the animal’s head. Then you can cause an event to be 
triggered when a marker on the head of a second animal touches or crosses the 
boundary of the dynamic zone around the first animal. In this example, we will 
set the radius of the zone to 3cm, so if the animals approach within 3cm, the event 
will be triggered.

In the Tracking toolbar:

1 Select LED or Extended tracking of color markers tracking mode. In this 
example, we will select markers.

In the Tracking pane:

2 Select the checkboxes for Marker 1 (the marker on the head of the first 
animal) and Marker 2 (the marker on the head of the second animal).

In the Sources pane:

3 Calibrate the arena in cm.

4 Select the Use Calibration checkbox.

In the Scenes pane:

5 Draw the arena.

6 Define a dynamic zone around Marker 1.

7 Set Available Objects to Marker 1 and Radius (cm) to 3.0cm.
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In the Events pane:

8 Set the Target to the dynamic zone that was established previously for the 
3cm radius around Marker 1 on the head of the first animal.

9 Set the Condition as Present in Zone and Available Objects as Marker 2 
(the marker on the second animal’s head).

In the above example, when Marker 2 comes to within 3cm of Marker 1, 
regardless of which animal is moving, the event (EV1.1 in this example) is 
triggered.
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Save settings if desired:

10 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.

5.11 Specifying Digital Outputs

The CinePlex System can be configured to generate zone events when a specified 
tracked object enters or exits from a specified zone. These events can be mapped 
to digital outputs in order to pass the information to external devices.

The exact nature of the resulting digital output depends on several settings in the 
CinePlex user interface:

• The Time Threshold (frames) parameter associated with the zone

• The Condition associated with the zone event—Present in Zone or Absent 
from Zone

• The Signal Type associated with the zone event—Pulse, Low or High

Note: If the Signal Type is Pulse, the Pulse Duration (s) parameter needs 
to be set to a value between 0.1 to 5.0 (default value is 1.0)

The meaning of these parameters is illustrated in the diagram below. The figure 
assumes that the tracked object starts outside the zone and enters and exits the 
zone at the times indicated. Note that the system applies Time Threshold 
parameter for the TRUE condition but not for the FALSE condition.
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Note: By default, the system does not evaluate event conditions while it is in Armed 

mode ( ). This ensures that the CinePlex System does not send signals to 
the OmniPlex System or user systems attached to the DO Unit before 
recording actually starts. Evaluation of event conditions only begins when 
recording starts. 

If you want the CinePlex System to send event data to the OmniPlex System 
while the CinePlex System is in the Armed state, you can select the Compute 
when Armed checkbox. However, this can cause events to be present in the 
OmniPlex System PL2 file that are not present in the CinePlex AVI file.

The default setting, which is recommended for typical applications, is 
unchecked, as shown in the image below.
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Digital Output Unit

In order to transmit digital outputs to external devices, the digital output (DO) 
unit must be installed. (It is included with the Basic Behavior Option and the 
Basic Behavior license must be installed to use this feature.) The DO unit 
connects to a USB port on the host PC. (Be sure to restart the CinePlex Studio 
application after connecting the USB cable.) The DO unit is shown below.

You can specify creation of digital outputs for single events and for combination 
events. Up to 24 different digital outputs can be specified, any of which can be 
pulsed, high, or low when the event occurs (i.e., when the event becomes TRUE).
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Procedure

1 Ensure that the CinePlex DO unit is connected to a USB port on the host PC.

2 Restart the CinePlex Studio application after connecting the USB cable.

3 Open the Events tab.

4 To specify that a digital output is sent when an event occurs (becomes 
TRUE), select the desired output line from the drop down list associated with 
the event. The output line numbers correspond to the line numbers shown in 
the side view of the DO unit (see the photograph of the DO unit, above).



5  Generating Events with CinePlex Basic Behavior Option  

178 CinePlex Studio

5 For event combinations, open the Combinations Event tab.

6 To specify that a digital output is sent when a combination event occurs 
(becomes TRUE), select the desired output line from the drop down list 
associated with the combination event.

7 (This step refers to the DO signals illustrated in the diagram at the beginning 
of this section, Section 5.11, “Specifying Digital Outputs” on page 174.) 

Select the Signal Type, which can be a Low or High level signal or a Pulse. 
If you select Pulse, the Pulse Duration (s) row will appear and you can enter 
the length of the pulse (0.1 to 5.0 seconds). These options are shown in the 
images below.

• An output signal specified as a Pulse indicates that a transition has 
occurred, for example, an animal has entered a specific zone. The pulse 
signal transitions from 0V to 5V.
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• An output signal specified as a level indicates that a condition is true for 
some period of time, for example, an animal is inside a particular zone:

• High true output voltage transitions from 0V (not asserted) to 5V 
(asserted).

• Low true output voltage transitions from 5V (not asserted) to 0V 
(asserted).

8 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.



5  Generating Events with CinePlex Basic Behavior Option  

180 CinePlex Studio

Timing of Event Digital Output Signals Relative to Frame Timestamp

It is important to understand the timing of event digital output signals relative to 
the frame in which an event actually occurs. 

The timestamp associated with a video frame is the time when its shutter opens 
relative to time zero in the recording. The time when a digital output signal is 
generated to reflect the change in the state of an event will always lag the video 
frame time. These are the components of the lag:

a Shutter open time

b Image processing time in the camera

c Image transmission time from the camera to the CinePlex Studio computer

d CinePlex Studio image processing time

e CinePlex Studio logical processing to determine need for new True or False 
event

f CinePlex Studio I/O processing sending the digital output signal

The sum of all of these times varies with image size, computer speed, image 
complexity, tracking type, event count, and a few more minor factors. But the 
biggest factor by far (of those listed above) is [a] the shutter open time, since by 
default it is set to the maximum possible, which is slightly less than the 
interframe interval.

For example, at 30 frames per second, the shutter open time defaults to 0.0322 
milliseconds for many cameras. The typical total for lag factors [b] through [f] (in 
the above list) is normally 0.020 seconds or less. However, it could be more than 
0.020 seconds in some circumstances. So in the case where CinePlex Studio is 
running in a mode controlled by the OmniPlex System, and CinePlex digital 
outputs are connected to OmniPlex digital inputs, the events arriving at the 
OmniPlex System will be timestamped 0.0522 seconds, usually less, after the 
timestamp for the frame in which they are detected.
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5.12 Calibrating the Arena Dimensions

In many experiments, it is useful to calibrate the video image for each camera so 
that sizes, positions and velocities are reported in the desired units of measure 
instead of pixels. See Section 3.3, “Calibrating the Arena Dimensions” on 
page 30 for the procedure.

5.13 Recording Synchronized Video Tracking and Neural Data

The procedure for recording video and neural data is the same as that used for the 
Tracking Option. See Chapter 4, Recording Positional Data with CinePlex 
Tracking Option.

5.14 Monitoring the Video During a Recording Session

The status bar in the CinePlex Studio main window displays information that 
allows the researcher to monitor the video recording process. See the section 
Section 3.6, “Monitoring the Video During a Recording Session” on page 52 for a 
description of this feature. 

5.15 Recording Video without Neural Data (Used for Animal Training)

You can record video, tracking and basic behavior data without neural data. In 
this case, the OmniPlex® System is activated only for the purpose of providing 
the required clock for CinePlex. This procedure requires activation of the 
OmniPlex data stream (which starts the clock), and then starting and stopping the 
CinePlex Studio video recording process locally (with the CinePlex controls). 
This method of triggering the recording is typically used during animal training, 
when no neural data are being collected.

See the section Section 3.8, “Recording Video without Neural Data (Used for 
Animal Training)” on page 56 for this procedure. 

Note: In addition to the parameters configured in that procedure, you can also 
configure the Tracking Option and Basic Behavior Option parameters. 

TIP
Verify that tracking and events are displaying as expected
During the recording, you should see that the tracking window is 
successfully following the subject in the arena. If you have configured 
events, verify that the Events Statistics are updating as expected.
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5.16 Displaying Behavioral Event Statistics

To open the event statistics pane, select Event Statistics from the View pulldown 
menu.

The images below are examples of event statistics displays for sequence-based 
and angle-based events.

5.17 Video Playback and Rerecording In Studio Files (Offline) Mode

CinePlex Studio can be used in offline mode to play back and rerecord video 
from existing files. The existing AVI and/or DVT files are the ones recorded 
previously by means of the procedure in Section 5.13, “Recording Synchronized 
Video Tracking and Neural Data” on page 181.

The procedure is the same as presented in Section 3.9, “Video Playback and 
Rerecording in Studio Files (Offline) Mode” on page 63.

5.18 Additional File-processing Tools

Additional tools can be used for processing of files. See Section 4.17, “Additional 
File-processing Tools” on page 140. 
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6.1 Retracking AVI In Studio Files Mode

This chapter explains how to retrack video streams using settings that are 
different from those used in the original AVI recording. This procedure is useful 
if you did not specify tracking during the original recording, or if you are not 
satisfied with your tracking results and want to apply new calibration, tracking 
parameters, arena shapes, behavioral events and/or recording settings.

6.2 Getting Started—Entering Offline Mode

If your system is in Cameras mode, switch to Files mode using the video source 
dropdown list on the CinePlex Studio main toolbar, as shown in this image.

Note: CinePlex Studio comes up in Files mode (offline) automatically if no cameras 
are detected.

Files
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6.3 Selecting the Correct Procedure

Find out how many cameras your system is licensed for. In the example below, 
the system is licensed for four cameras, Your system might have from one to four 
camera licenses.

Go to the appropriate section for your system:

• Section 6.4, “Retracking Video in Systems Licensed for a Single Camera” on 
page 186

• Section 6.5, “Retracking Video in Systems Licensed for Multiple Cameras” 
on page 189

• Section 6.6, “Retracking Single Video when Licensed for Multiple Cameras” 
on page 191

Number of camera licenses
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6.4 Retracking Video in Systems Licensed for a Single Camera

Selecting a File to Be Retracked

1 The main toolbar displays the icon for File 1. If it is not already selected, click 
on the icon to select it. It has an orange background when selected.

2 In the Source pane, in the File Name row, click on the folder icon to navigate 
to the directory containing the desired AVI file and select the file.

Note: If you select a file that was created with any camera other than the 
camera associated with Source, the system will prompt you to select 
a different file (a file that was created with appropriate camera). The 
system can automatically detect which camera created the file, 
regardless of the file name. For example, in the image below, only 
files created with Camera 1 can be loaded in the Source 1 pane.
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3 Verify that you see the video stream in the Video window.

Note: If the Video 1 window does not appear, restore the default layout. 
(In most cases, the Video 1 window appears, therefore this step is not 
necessary.)

4 You can use the buttons in the Video Edit pane to replay the video file frame 
by frame if desired.
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Select the Retracking Option

5 Select Retrack AVI.

Modify Parameters for Retracking

6 You can adjust a wide range of parameters prior to retracking the video. For 
examples of these parameter settings, see Section 6.8, “Modifying 
Parameters for Retracking” on page 197.

Retrack the File

7 Start retracking of the existing video (with the new settings) by pressing the 

Start recording from file ( ) button in the main toolbar.

Save Settings

8 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.



 

Version 3.7 189

6.5 Retracking Video in Systems Licensed for Multiple Cameras

The procedures in this section assume a system with two camera licenses. These 
procedures are easily extended to systems with three or four licenses.

Selecting Files to Be Retracked

1 The main toolbar displays the icons for Files 1 and 2. If both files are not 
already selected, click on the icons to select them. They have an orange 
background when selected.

2 In the Source 1 and 2 panes, in the File Name row, click on the folder icon to 
navigate to the directory containing the desired AVI file and select the file.

Note: If you select a file that was created with any camera other than the 
camera associated with that Source, the system will prompt you to 
select a different file (a file that was created with appropriate camera). 
The system can automatically detect which camera created the file, 
regardless of the file name. For example, only files created with 
Camera 2 can be loaded in the Source 2 pane.
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3 Verify that you see the video streams in the Video 1 and 2 windows.

Note: If the Video 1 and 2 windows do not both appear, restore the default 
layout. (In most cases, the Video windows appear, therefore this step 
is not necessary.)

4 You can use the buttons in the Video Edit pane to replay the video file frame 
by frame if desired.

Select the Retracking Option

5 Select Retrack AVI.
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Modify Parameters for Retracking

6 You can adjust a wide range of parameters prior to retracking the video. For 
examples of these parameter settings, see Section 6.8, “Modifying 
Parameters for Retracking” on page 197.

Retrack the File

7 Start retracking of the existing video (with the new settings) by pressing the 

Start recording from file ( ) button in the main toolbar.

Save Settings

8 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.

6.6 Retracking Single Video when Licensed for Multiple Cameras

This section explains how to retrack a single video stream if your system is 
licensed for multiple cameras.

The procedures in this section assume a system with two camera licenses. These 
procedures are easily extended to systems with three or four licenses.

Selecting Files to Be Retracked 
Example—Retracking File 1 Only

1 The main toolbar displays the icons for Files 1 and 2 (because the system in 
this example is licensed for two cameras). Select the icon for the file you want 
to retrack, and deselect the icon for the other file. An icon has an orange 
background when selected.

In this example, we are selecting File 1 to be retracked, and deselecting the 
icon for File 2.
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2 In the Source 1 pane, in the File Name row, click on the folder icon to 
navigate to the directory containing the desired AVI file and select the file.

Notice that the Source 2 pane is blank because the File 2 icon was 
deselected in the previous step.

Note: If you select a file that was created with any camera other than the 
camera associated with that Source, the system will prompt you to 
select a different file (a file that was created with appropriate camera). 
The system can automatically detect which camera created the file, 
regardless of the file name. For example, only files created with 
Camera 1 can be loaded in the Source 1 pane.
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Notice that the Start recording from file icon is active when there is a match 
between the File icon(s) selected and the actual file(s) loaded in the Source 
window(s). If there is a mismatch, the Start recording from file icon is 
disabled.

Example: File 1 and 2 icons selected, but Source 2 file not loaded.
Mismatch—Start icon is disabled:

Example: File 1 icon selected and Source 1 file loaded.
Match—Start icon is enabled:
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Note: If the Video 1 and 2 windows do not both appear, restore the default 
layout. (In most cases, the Video windows appear, therefore this step 
is not necessary.)

3 In this example, we are retracking the video for File 1 only.
Verify that you see the video stream in the Video 1 window only.

4 You can use the buttons in the Video Edit pane to replay the video file frame 
by frame if desired.

Select the Retracking Option

5 Select Retrack AVI.
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Modify Parameters for Retracking

6 You can adjust a wide range of parameters prior to retracking the video. For 
examples of these parameter settings, see Section 6.8, “Modifying 
Parameters for Retracking” on page 197.

Retrack the File

7 Start retracking of the existing video (with the new settings) by pressing the 

Start recording from file ( ) button in the main toolbar.

Selecting Different File(s) to Be Retracked 
Example—Retracking File 2 Only

8 In the previous example, we selected File 1 to be retracked, and deselected 
the icon for File 2.

Now deselect the icon for File 1 and select the icon for File 2.

9 Load a file for Source 2.

10 Proceed with the retracking steps in a manner similar to the previous 
example.

Save Settings

11 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.
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6.7 Requirements for Computer and License

The offline functions of CinePlex Studio can be used on the original OmniPlex/
CinePlex host PC where the camera(s) are installed, or on a standalone computer. 
The appropriate CinePlex Studio license must be plugged into a USB port on the 
computer.

The recommended system requirements for an offline analysis computer include 
a dual core Intel processor operating at better than 3 GHz with 3 GB of memory, 
and an NVIDIA® GeForce® 9600 GT or better video card. In addition, the 
appropriate Plexon license (see Section 1.6, “CinePlex Licensing Options” on 
page 5) must be plugged in to one of the USB ports. For a more detailed 
discussion of requirements, contact Plexon Support at 
+1-214-369-4957 or support@plexon.com. 

mailto:support@plexon.com
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6.8 Modifying Parameters for Retracking

The examples in this section show how to adjust parameters prior to retracking 
the video.

Source Files

The AVI files to be retracked are typically the ones recorded by means of the 
procedure in either of the following sections. These sections provide additional 
guidance on setting the values for the parameters you want to modify:

• Section 4.13, “Recording Synchronized Video Tracking and Neural Data” on 
page 130 (with Tracking license)

• Section 5.13, “Recording Synchronized Video Tracking and Neural Data” on 
page 181 (with Tracking and Basic Behavior licenses)

Loading and Saving Parameter Settings

When you load the AVI file, the system automatically loads all the parameter 
settings that you used in making that original recording. You can then modify 
some of those settings as needed before you retrack the video. You can also 
save the new (modified) settings, if desired, for future experiments.

1 If you have a Settings file that you created in a previous recording session, 
either in Cameras mode or Files mode, you can load that Settings file and use 
those settings as a starting point for retracking the video. The images below 
illustrate the Save Settings and Load Settings menu options.
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Modify the Retracking Parameters as Needed

2 In the Source pane, you can set parameters that will cause the system to:

• Change brightness, contrast or other settings so that existing files are 
more usable

• Place the File Name and/or Timecode into the video frame if that was not 
already done on the original run

• Specify and modify calibration settings (be sure the Use Calibration 
checkbox is checked if you want to use the calibration)

TIP
Select the “Use Calibration” checkbox for calibrated data
Remember that the positional coordinates in the extracted file will be in 
pixels if the Use Calibration checkbox is not checked during re-recording. 
See the examples below. The calibration procedures are provided in 
Section 3.3, “Calibrating the Arena Dimensions” on page 30.
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3 In the Tracking pane, you can adjust a number of parameters to more 
effectively track your subject. For details about each of these parameters, see 
Chapter 5, Recording Positional Data with CinePlex Tracking Option.
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4 In the Scenes pane, you can adjust the arena geometry. For details about 
each of these parameters, see Chapter 5, Recording Positional Data with 
CinePlex Tracking Option. If you have the Basic Behavior license, you can 
also adjust the shapes and positions of zones, sequences of zones, events 
and combination events. For details about these parameters, see Chapter 6, 
Generating Events with CinePlex Basic Behavior Option.

5 In the Global Config pane, you can lower the Quality setting to reduce file 
size and save storage space.

6 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.
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6.9 Offline Functionality Compared to Online Functionality

Most offline functionality is only marginally different from its online equivalent. 
For details, see Section 3.9.7, “Offline Functionality Compared to Online 
Functionality” on page 69.

6.10 File Naming Procedure in Offline Mode

CinePlex Studio renames files during the retracking process. For details, see 
Section 3.9.8, “File Naming Procedure in Offline Mode” on page 70.

6.11 Additional File-processing Tools

The following tools can also be used for processing of files:

• Use the CinePlex Studio Extractor to extract static and dynamic data from a 

Plexon AVI file for analysis with a database program such as MATLAB® or 

data processing tools such as Microsoft Excel®. See Chapter 7, Extractor 
Procedures.

• You can use CinePlex Editor (installed separately) to view the AVI file time-
locked (synchronized) with its partner neural data file to see what the subject 
was doing at a time of interest in the neural data. See CinePlex Editor User 
Guide on the Plexon website. The video and neural data are time-locked 
because both systems (the OmniPlex and CinePlex Systems) are running off 
the same clock signal. This ensures that the PLX and AVI files will have the 
same timing.
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7.1 Introduction—Extracting Data with CinePlex Extractor Function

This chapter explains how to extract static and dynamic data from an Audio 
Video Interleaved (AVI) file. The CinePlex Extractor function places the data into 
files that are readable with standard text applications. These files are suitable for 
use by database programs such as MATLAB® or data processing tools such as 
Microsoft® Excel®. 

Note: Static data in an AVI file includes system information and settings data. 
Dynamic data includes frame numbers, timestamps, positional coordinates 
and status of behavioral events.

7.2 Getting Started—Entering Offline Mode

If your system is in Cameras mode, switch to Files mode using the video source 
dropdown list on the CinePlex Studio main toolbar, as shown in this image.

Note: CinePlex Studio comes up in Files mode (offline) automatically if no cameras 
are detected.

Files



 

Version 3.7 205

7.3 Selecting the Correct Procedure

Find out how many cameras your system is licensed for. In the example below, 
the system is licensed for four cameras, Your system might have from one to four 
cameras. 

Go to the appropriate section for your system:

• Section 7.4, “Extracting Data in Systems Licensed for a Single Camera” on 
page 206

• Section 7.5, “Extracting Data in Systems Licensed for Multiple Cameras” on 
page 217

Number of camera licenses
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7.4 Extracting Data in Systems Licensed for a Single Camera

Selecting a File

1 The main toolbar displays the icon for File 1. If it is not already selected, click 
on the icon to select it. It has an orange background when selected.

Notice that the Extractor icon and menu option are inactive, because no file 
has been loaded yet.

2 In the Source pane, in the File Name row, click on the folder icon to navigate 
to the directory containing the desired AVI file and select the file.

Note: If you select a file that was created with any camera other than the 
camera associated with Source, the system will prompt you to select 
a different file (a file that was created with appropriate camera). The 
system can automatically detect which camera created the file, 
regardless of the file name. For example, in the image below, only 
files created with Camera 1 can be loaded in the Source 1 pane.
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3 Verify that you see the video stream in the Video window.

Notice that the Extractor icon and menu option are now active (enabled).

Note: If the Video 1 window does not appear, restore the default layout. 
(In most cases, the Video 1 window appears, therefore this step is not 
necessary.)
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4 You can use the buttons in the Video Edit pane to replay the video file frame 
by frame if desired.

Selecting the Data from AVI Option

5 Ensure that the dropdown menu in the main toolbar is set to Data from AVI.

Configuring the Extractor

6 From the File menu select Extractor, or click the Extractor icon ( ) in the 
toolbar (see the image above to locate these features).

The Extractor dialog box opens. Examples of these dialog boxes are shown 
below.
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7 To select the data to be extracted, drag and drop the desired entries in the 
Available Data panel to the panel on the right. When the panel on the right is 
populated with one or more entries, the Data to Extract banner appears. 

8 If desired, you can rearrange the order of the entries in the Data to Extract 
section by dragging and dropping them into the desired position in the list.
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The default locations for the extracted Settings File and Data File are the 
same folder from which the original AVI file was opened. You can modify the 
locations and names of these files if you wish by typing in the preferred 
locations and names.

Extracting the Data

9 When ready to extract the data, click the Extract Data button.

The system will create the requested file and store it in the specified location.
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10 If you want to stop the data extraction before the end of the file is reached, 
click the Stop button.

The data are extracted to a comma-separated-values (CSV) file and can be 
opened in a spreadsheet application such as Microsoft Excel. The column 
headings are presented in the order that was specified in the Data to Extract 
section of the dialog box.

The image below shows an example of the data file opened in Excel®. In this 
example, the x and y coordinates are in pixels, because the arena was not 
calibrated prior to recording.

The image below shows an example of the same data file opened as text.
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If the arena is calibrated, the heading displays x_cm and y_cm (or x_in and 
y_in) as shown in the images below.

TIP
If you forgot to calibrate the arena prior to recording...
If you did not calibrate the area prior to recording and you want to obtain 
calibrated coordinate data now, you can do so by following the procedure in 
Section 7.6, “Calibrating the Arena and Extracting Calibrated Coordinate 
Data” on page 222.
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Extracting Settings

11 The settings from the AVI file may be extracted by clicking the Extract 
Settings button. This is useful if you have lost a Settings file but you know 
which AVI file was created with the desired settings.

Creating a DVT File

12 A DVT file may be created by clicking the Make DVT 2.0 button. This is useful 
if you did not check the DVT checkbox when you made the original recording.

An example of a text file with the extracted DVT data is shown below. 

Note that the frame numbers and timestamps created with the Extractor Make 
DVT 2.0 button are identical to the frame numbers and timestamps generated 
if you have selected the DVT File checkbox in the Sources pane.

Saving Settings

13 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.

Viewing the AVI and DVT Files

The frame numbers and timestamps in the DVT file are identical to the frame 
numbers and timestamps embedded in the AVI file, although the DVT file 
does not have a header row (see the image below). However, there is an 
algebraic ratio between the coordinate data in the DVT file with respect to the 

=
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coordinate data in pixels obtained from the AVI file with the Extract Data 
function. In the image below, notice that the coordinate data in the DVT file is 
different (by an algebraic ratio) from the data in the AVI file.

Note: If the arena is not calibrated, the AVI data will appear in pixels and the 
columns will be named X_pix,Y_pix.
If the arena is calibrated, the AVI data will appear as X_cm,Y_cm 
(or X_in,Y_in), and the AVI coordinate data will be in cm (or inches).

CAUTION

See Section 7.7.5, “Conversion of DVT Coordinates to Pixels” on 
page 227 for an understanding of the algebraic relationship between 
the positional data extracted from the AVI file (the Extract Data 
button in the Extractor dialog box) vs. data extracted in a DVT file 
(the Make DVT 2.0 button). They are not identical.

AVI DVT
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14 Close the Extractor dialog box (click on the Close button) when you have 
finished using the Extractor function.

15 Repeat Step 3 through Step 14 to extract data or settings from any additional 
files from this same camera.

16 Repeat the entire procedure to extract data or settings from the recordings 
made by other cameras.

Interpreting Events in Extracted Data

In the example below, the extracted data for each frame includes the condition 
(TRUE or FALSE) for events EV1.1 and EV1.2, and the track length for each 
event. Notice that track length is measured only if the event is happening. In this 
example, EV1.1 is FALSE (not happening) for the times shown, so the 
Track_Length is 0. For EV1.2, the event is TRUE (happening) for the times 
shown, so the Track_Length is measured and reported in the extracted data.

TIP
Create DVT files automatically in Sources or with the Extractor
If you know that you will want files with all your timestamps, frame 
numbers and coordinate data. you might find that it is convenient to 
preselect the DVT File checkbox in the Sources pane prior to recording, 
rather than opening the Extractor for each individual experimental run.
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Interpreting Speed and Speed Events in Extracted Data

If you configured a speed event in a recording, you can extract and view the 
speed event information. (To review the method of configuring speed events, see 
Section 5.8.4, “Events Based on Speed” on page 162.)

In the example below, EV1.1 is FALSE (not happening) during the times shown, 
as indicated by the 0 value in that column. When the speed event is FALSE, the 
system does not measure the track length of the object, so all of the values in the 
EV1.1_Track_Length_cm column are 0. Notice, however, that the system always 
measures the object’s speed for each frame, so these values are reported.

In the example below, EV1.1 is TRUE (happening) during the times shown, as 
indicated by the 1 value in that column. When the speed event is TRUE, the 
system measures and reports the track length of the object as well as the object’s 
speed for each frame.
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7.5 Extracting Data in Systems Licensed for Multiple Cameras

The Extractor function can extract either data from one video file at a time.
Use the procedure in this section when you have a CinePlex System licensed for 
multiple cameras.

It is suggested that you read through the previous procedure (Section 7.4, 
“Extracting Data in Systems Licensed for a Single Camera” on page 206) for 
detailed information about the options in the Extractor dialog box.

The procedures in this section assume a system with two camera licenses. These 
procedures are easily extended to systems with three or four licenses.

Selecting Files 
Example—Extracting Data from File 1 

1 The main toolbar displays the icons for Files 1 and 2 (because the system in 
this example is licensed for two cameras). In this example, we are extracting 
data from File 1, so we select the icon for File 1 and deselect the icon for 
File 2. An icon has an orange background when selected.

2 In the Source 1 pane, in the File Name row, click on the folder icon to 
navigate to the directory containing the desired AVI file and select the file.

Notice that the Source 2 pane is blank because the File 2 icon was 
deselected in the previous step.

Note: If you select a file that was created with any camera other than the 
camera associated with that Source, the system will prompt you to 
select a different file (a file that was created with appropriate camera). 
The system can automatically detect which camera created the file, 
regardless of the file name. For example, only files created with 
Camera 1 can be loaded in the Source 1 pane.
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Notice that the Extractor icon is active when there is a match between the File 
icon(s) selected and the actual file(s) loaded in the Source window(s). If there 
is a mismatch, the Extractor icon is disabled.

Example: File 1 and 2 icons selected, but Source 2 file not loaded.
Mismatch—Extractor icon is disabled:

Example: File 1 icon selected and Source 1 file loaded.
Match—Extractor icon is enabled:
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Note: If the Video 1 and 2 windows do not both appear, restore the default 
layout. (In most cases, the Video windows appear, therefore this step 
is not necessary.)

3 In this example, we are extracting data from the File 1 AVI file only. Verify that 
you see the video stream in the Video 1 window only.

4 You can use the buttons in the Video Edit pane to replay the video file frame 
by frame if desired.
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5 Ensure that the Data from AVI option is selected.

6 Extract the desired File 1 settings, data or DVT file.
See the details for these steps in Section 7.4, “Extracting Data in Systems 
Licensed for a Single Camera” on page 206.

7 Close the Extractor dialog box (click on the Close button) when you have 
finished using the Extractor function.

Selecting a Different File 
Example—Extracting Data from File 2

1 In the previous example, we selected File 1, and deselected the icon for 
File 2.

Now deselect the icon for File 1 and select the icon for File 2.

2 Load a file for Source 2.
Notice that the Extractor icon becomes active.
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3 Verify that you see the video stream in the Video 2 window only, as shown in 
Step 2, above.

4 You can use the buttons in the Video Edit pane to replay the video file frame 
by frame if desired.

5 Ensure that the Data from AVI option is selected.

6 Extract the desired File 2 settings, data or DVT file.
See the details for these steps in Section 7.4, “Extracting Data in Systems 
Licensed for a Single Camera” on page 206

7 Close the Extractor dialog box (click on the Close button) when you have 
finished using the Extractor function.

8 (Optional) After the parameters are set as desired, on the File menu, click 

Save Settings, or click the Save Settings button ( ) on the toolbar.



7  Extractor Procedures  

222 CinePlex Studio

7.6 Calibrating the Arena and Extracting Calibrated Coordinate Data

If you did not calibrate the arena prior to recording the AVI file, you can still 
obtain calibrated coordinate data by using the Extractor function.

Follow this procedure to extract calibrated coordinate data.

1 In Files mode, load the file.

2 Select Data from AVI.

3 In the Source pane, select the Use Calibration checkbox.

TIP
Select the “Use Calibration” checkbox for calibrated data
Remember that the positional coordinates in the extracted file will be in 
pixels if the Use Calibration checkbox is not checked during re-recording. 
See the examples below. The calibration procedures are provided in 
Section 3.3, “Calibrating the Arena Dimensions” on page 30.
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4 Perform a calibration according to the procedure in Section 3.3, “Calibrating 
the Arena Dimensions” on page 30.

5 Open the Extractor dialog and follow the procedure in Section 7.4, “Extracting 
Data in Systems Licensed for a Single Camera” on page 206 or Section 7.5, 
“Extracting Data in Systems Licensed for Multiple Cameras” on page 217 as 
applicable.

6 The data extracted from your AVI files will now be calibrated in cm (or inches).
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7 If desired, save the new settings. You can select the Save Settings option 
from the File dropdown menu or click the Save settings to file icon.

7.7 Digital VideoTracker (DVT) Files—Interpreting DVT Data

A Digital VideoTracker (DVT) file contains timestamp and tracking information 
for an audio video interleave (AVI) format recording. 

The DVT file is a text file where each row contains positional data for a video 
frame. 

Example of DVT file for LED mode

In this example, three LEDs were used during the original recording:

• The x,y coordinates for all three LEDs are displayed in each row—x1,y1 for 
LED1, x2,y2 for LED2 and x3,y3 for LED3. 

• The coordinate data are in 0–1023 format.

The data for each row is in this form:
Frame Number, Timestamp, x1, y1, x2, y2, x3, y3

1,0.033000,910,35,110,366,19,247

2,0.066000,915,37,112,366,19,247

3,0.099000,927,38,112,366,19,247

4,0.133332,934,40,112,369,20,251

…

The above example was for LED mode. The format of each line depends on the 
selected tracker mode, as described below. 
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7.7.1 Object Contour Mode

For Object Contour mode, the format of each line is:

row,time,x,y,m

where:

• row is the row number

• time is the time of the frame in seconds

• x and y is the track position of the target centroid

• m indicates the motion measure value; see Section 5.7.7, “Motion Measure 
Option” on page 169. This field is present if the Motion Measure checkbox 
was selected in the original recording and Motion Measure was also selected 
in the Extractor dialog box (see the image below).

7.7.2 LED Mode

For LED mode, the format of each line is:

row,time,x1,y1,x2,y2,x3,y3

where:

• row is the row number

• time is the time of the frame in seconds

• x1 and y1 is the track position of color #1 (if selected)

• x2 and y2 is the track position of color #2 (if selected)

• x3 and y3 is the track position of color #3 (if selected)
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7.7.3 Reflective Colors Mode

For Reflective Colors mode, the format of each line is:

row,time,x1,y1,x2,y2,x3,y3,x4,y4,x5,y5

where:

• row is the row number

• time is the time of the frame in seconds

• x1 and y1 is the track position of color #1 (if selected)

• x2 and y2 is the track position of color #2 (if selected)

• x3 and y3 is the track position of color #3 (if selected)

• x4 and y4 is the track position of color #4 (if selected)

• x5 and y5 is the track position of color #5 (if selected)

7.7.4 Extended Tracking of Color Markers Mode

For Extended Tracking of Color Markers mode, the format is similar to that for 
the Reflective Colors mode (above), but there can be up to 12 different colors 
selected, with rows up through x12 and y12 to track color #12.
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7.7.5 Conversion of DVT Coordinates to Pixels

The data in the DVT and in PLX or PL2 files is always in the 0–1023 format, but 
in the CSV files extracted directly from the AVI file, the data are in unadjusted 
pixels, inches, or centimeters as the user has specified in the experiment 
calibration..

To convert DVT coordinates to pixels, multiply each coordinate by 639/1023.
:

:

Consider the AVI and DVT files shown in the previous procedure.

Note: If the arena is not calibrated, the AVI data will appear as X_pix,Y_pix.
If the arena is calibrated, the AVI data will appear as X_cm,Y_cm 
(or X_in,Y_in), and the AVI coordinate data will be in cm (or inches).

TIP
Select the “Use Calibration” checkbox for calibrated data
Remember that the positional coordinates will be extracted from the AVI 
file in pixels if the Use Calibration checkbox was not checked during 
recording. See the examples below. The calibration procedures are provided 
in Section 3.3, “Calibrating the Arena Dimensions” on page 30.
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In Frame Number 6, for example:

xpixels = 806 x 639 / 1023 = 503.45 (and actual xpixels from AVI file = 503.92)

ypixels = 616 x 639 / 1023 = 384.77 (and actual ypixels from AVI file = 384.95)

The diagram below illustrates the relationship between the DVT coordinates (x,y) 
and camera pixels (x’,y’).

For any recording session, if you compare the calculated pixel coordinates (based 
on the above calculation from the DVT coordinates) with the actual camera pixel 
coordinates you will see that there can be differences of up to half of a pixel due 
to rounding errors.

AVI DVT
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A.1 Overview

This appendix explains how to cable the Plexon® CinePlex®/OmniPlex® System. 
Feel free to contact Plexon Support (support@plexon.com or 
+1-214-369-4957) if you need clarification regarding any of these connections.

The diagram below provides an overview of the required connections.

Note: The CinePlex digital output (DO) unit, included with the Basic Behavior Option, 
connects to a USB port on the host PC and permits the Basic Behavior Option 
(if installed and licensed) to transmit digital outputs to external devices.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.

mailto:support@plexon.com
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A.2 Required Cables

This section lists the cables required for connections between the CinePlex 
System and the OmniPlex System, and connections between the CinePlex System 
and the cameras. (The cables listed here are in addition to those needed for 
normal OmniPlex System operation, such as the cable that carries OmniPlex 
control and neural data.)

The following cables are used.

• Gray Timing Cable between the OmniPlex Timing Control Card and the 
CinePlex ACCES I/O Adaptor.

• Trigger cable(s) from the CinePlex ACCES I/O Adaptor to the video 
camera(s).

• FireWire cable(s) from the FireWire card in the host PC to the video 
camera(s). 

Note: Plexon supplies the Trigger and FireWire cables bundled together with plastic 
tie wraps. This combination is referred to as a Combination Cable on the 
following pages.

• Optional cable from a USB port on the computer to the Digital Output unit 
(for customers purchasing the Basic Behavior option).

Gray Timing Cable

Combination Cable for Camera – Trigger and FireWire
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A.3 Cabling Procedure

This procedure explains how to connect the CinePlex/OmniPlex System cables.

1 Make sure the host PC is turned off before connecting the combination 
Trigger and FireWire camera cable(s). Otherwise, the camera(s) could be 
damaged. 

The following steps refer to diagrams that appear later in this appendix. Please 
refer to the applicable diagram(s) when performing these steps. 

2 Connect the Plexon supplied gray Timing Cable between the OmniPlex 
System and the Host PC.

3 Attach the combination Trigger and FireWire camera cable(s).

4 Connect all of the other cables for the system as shown in the diagrams 
below.

A.4 Cabling Diagrams and Connection Details

The diagram below shows the cabling for a two-camera system. Your system 
might have one, two, three or four cameras. The cabling procedure is basically 
the same as the two-camera example shown here. Regardless of the number of 
cameras, you will need only one gray Timing Cable and one ACCES I/O 
Adaptor.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.
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A.5 Close-up Images of CinePlex/OmniPlex System Cables Installed

Gray Timing Cable connected to OmniPlex Timing Control Card

Connection of Combination Cable to the Camera

FireWire cable

Trigger cable
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Connection of Combination cables to the PC 
(connections for two cameras shown)
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B.1 Overview

This appendix provides details of camera and lens setup and usage. It is intended 
to assist the scientist in preparing the cameras and lenses for his or her 
experiment.

In any experiment where video is required, there is a physical area of interest in 
which it would be meaningful to record video. This area of interest can be a 
simple enclosure, a maze, a geometrical track, or any other area needed for the 
experiment. For video recording of behaving animals, this area of interest is 
known as the arena. The arena shape and size are critical in determining the lens 
used and the distance from the camera to the arena. Colors used and target 
visibility are also extremely important.

The sections that follow this introduction provide information about camera and 
lens selection, arena layout, and camera installation. Only the materials described 
in Section B.5, "The Plexon Camera Mounting Kit" are provided with each 
camera shipped by Plexon®. All other equipment shown in this Appendix should 
be obtained or machined by the customer as needed. Diagrams and procedures in 
this Appendix are intended as general guidance.

Please contact Plexon Support at support@plexon.com or +1-214-369-4957 if 
you have any questions regarding cameras and lenses.

B.2 Available Cameras

For CinePlex® Version 3, Plexon currently offers several AVT cameras and 
several lenses, both varifocal and zoom. The camera types are listed in Section 
1.7, "CinePlex Studio Features” on page 6.

The setup of the camera, lens selection and distance from the experimental arena 
are discussed in the following section.

B.3 Camera Positioning and Lens Selection

This section provides a systematic procedure for determining the position of the 
camera and selecting the lens to use in an experimental arena.

Investigators may find that they need to compromise arena size and/or camera 
distance to accommodate the physical limitations of the camera/lens 
combinations. The limiting factors are that the lens must be able to focus the 
arena image and that the arena image should fill the screen. If the camera’s 
distance to the arena is fixed, the arena size must be kept within certain limits for 

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.

mailto:support@plexon.com
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best results. Alternatively, if the arena size is fixed, the distance between the 
camera and arena must be kept within limits for best results.

1 Determine Optimal Arena Setups

Use the charts below to determine if a particular lens can be used with the 
current experimental setup. The area between the green and blue lines in the 
charts represents arena size and camera distance combinations that are 
acceptable for best results.

2 Determine the distance from the camera to the arena in meters

This distance should be as far as possible from the arena, while still close 
enough to allow the zoom function to fill the sensor with the arena image. Be 
sure to allow space for camera mounting. Find that distance on the X-axis 
(Camera Distance) of the Standard Varifocal chart.

3 Determine the size of the arena in meters

Imagine a circle, square or 4:3 rectangle drawn around the arena, completely 
enclosing it. The Arena Size in the charts above is the diameter of the circle, 
the side of the square, or the longer side of the 4:3 rectangle. Find that size on 
the Y-axis (Arena Size) of the Standard Varifocal chart.

4 Determine if the arena size and camera distance are optimal

If the (X,Y) position specified by the Camera Distance and Arena Size is in the 
area between the Green and Blue lines, the setup should yield optimal results 
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when the camera is zoomed appropriately. It is not necessary to proceed. The 
Standard Varifocal lens will work. 

If the (X,Y) position specified by the Arena Size and Camera Distance is NOT 
in the area between the Green and Blue lines, the setup is sub-optimal. The 
image will be smaller than desirable, larger than desirable, or out of focus.

5 If the position is not optimal, try the steps above on the chart for the Zoom 
lens

If this lens yields an optimal result, contact Plexon to obtain the lens. If not, try 
adjusting Arena Size and Camera Distance to find an optimal combination 
with one of the lenses.

6 If an optimal result cannot be obtained using this procedure, contact Plexon 
for other lens possibilities

Note: The charts are derived from calculated numbers. Small variations in 
lens and camera manufacturing can result in as much as 10% 
variation.

B.4 Experiment Design

B.4.1 Field of View

The field of view (what the sensor of the camera sees) depends on the distance 
between the camera and the surface and the angles of view of the lens that is used 
with the camera. The cameras supplied by Plexon generate screen images with 
the following geometries, depending on the camera model:

• images that are rectangular, 4 units wide by 3 units high, as shown by the 
diagram below. This aspect ratio corresponds to the sensor image size of 640 
by 480 pixels or 320 by 240 pixels.

• images that are square, with sensor image size of 320 by 320, 640 by 640 or 
960 by 960 pixels.

The example that follows in this section is based on a 4 by 3 rectangular 
geometry.

Orient the camera to the experimental area to take maximum advantage of the 
rectangular field of view. As shown in the following illustration, the 4:3 ratio 
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corresponds to a horizontal dimension (H) that is 1.33 times the vertical 
dimension (V).

When the camera is placed so that it is directed towards the experimental area, it 
has a horizontal angle of view and a different vertical angle of view because of 
the aspect ratio described above. The image producing sensor in the camera is 
also rectangular in the same proportion. So the ideal experimental layout will 
have a rectangular 4:3 arena with the camera aligned so that its longer 
(horizontal) sensor dimension is parallel to the arena’s long side. Actual arenas 
may not be 4:3 rectangles, but in all cases, best results will be obtained when the 
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longest dimension of the arena is parallel to the longer sensor dimension of the 
camera.

When the camera and lens are viewed as shown in the image below, the long axis 
of the sensor is in the horizontal plane. This axis should be parallel to the longest 
dimension of the experimental area.

The table below shows the horizontal and vertical angles of view that correspond 
with maximum and minimum zoom of the camera, using the standard lens as an 
example. Other lenses will differ.

The best way to avoid optical distortions is to set the lens at Maximum Zoom and 
move the camera far enough away from the experiment that the maze, cage, track 
or other setup is completely imaged This is the optimum height. The figure below 
illustrates the parameters for a field of view estimate (maze size).

normal lens)

Maximum zoom 
(minimum angle and 

area covered)

Minimum zoom 
(maximum angle and 

area covered)

Horizontal 30 degrees 83 degrees

Vertical 22 degrees 61 degrees
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The formula to calculate the optimum height (H) of a camera over a square maze 
of side L (or a circular maze of diameter L) is:

If the maze is round or square, use the Vertical Maximum zoom angle (or 22 
degrees for the normal lens). If the maze is rectangular, use the Horizontal 
Maximum Zoom angle (30 degrees for the normal lens).

B.4.2 Colors

In contour tracking, to achieve the best tracking accuracy, choose colors with 
maximum contrast. For example, if the target animal is white, choose black or 
another dark color for the arena floor. Likewise, if the target is dark-colored, 
choose a bright white or other light color for the floor. For multi-colored animals 
like Long-Evans rats, red has been shown to have good contrast to the animal’s 
fur colors. It may be necessary to experiment to determine the best background 
color in individual situations.

In all tracking modes, use materials with solid colors as floors, if at all possible. 
Avoid floor materials with patterns or textures.

B.4.3 Visibility

Unless otherwise required, the design of the arena should ensure that the target is 
completely visible to the camera in all areas. If the target is partially obscured by 
overhangs or other obstacles during its travel around the arena, the centroid 
calculations that determine target position and orientation can be affected.

B.4.4 Sharpening the Image

Reducing Blurs and Color Streaks in the Video

If the experimental subject moves quickly, blurs and color streaks can appear in 
the video. Reduce or eliminate these problems by increasing the shutter speed. 
See the shutter speed adjustment—Shutter (ms)—as shown in the images below.

Notes regarding shutter speed

Note: Although it may seem confusing, for historical reasons the terms “increasing 
shutter speed” and “reducing shutter open time” are synonymous.

If an image is too bright, you can make the image darker by reducing the amount 
of time that the shutter is open. In all the images shown in the example below, the 
frame rate is 30 frames per second (one frame per 33.236ms). By default, the 
shutter will stay open the entire 33.236ms per frame. You can reduce this opening 
time, Shutter (ms), using the slider to set a new value. The images below show 
the effects on brightness for shutter speeds of 33.236ms, 20ms and 10ms.

H L

2

2
--- 
 tan

---------------------=



B  Optimizing Camera Mounting and Lens Usage 

B-8 CinePlex Studio

It might be useful, for example, to adjust the Shutter (ms) value in the following 
situations:

• The image is too bright, so the video gets oversaturated:
You might need to reduce the shutter open time (reduce the Shutter (ms) 
value) to make the image darker. You can reach a similar effect by closing the 
lens iris, but that means touching the cameras, and you will not be able to 
have the iris set exactly the same on all cameras.

• You will be recording animals in subdued lighting, but prefer to perform 
dimensional calibration in full lighting:
In this case, It is useful to have the iris opened all the time when you set up 
cameras, and then reduce the shutter open time (reduce the Shutter (ms) 
value) slightly when you do the calibration. Then, increase the shutter open 
time to the maximum prior to performing experiments.

• You are tracking an animal at a certain frame rate, for example 30 fps, but 
your animal moves very quickly; so you might get a blurry image:
You can improve the image by keeping the shutter closed most time within 
each frame. Alternatively, you might simply prefer to use a faster frame rate, 
which has the effect of reducing the maximum time the shutter can be open.

B.5 The Plexon Camera Mounting Kit

For repeatable, reliable video recording, the video camera(s) must be mounted 
stably and securely with respect to the experimental area. Cameras that vibrate or 
move can result in not just partial recordings or blurred images, but also in 
inaccurate position metrics, event triggers at undesired times, and, worst of all, 
non-repeatable experimental trials.

The Plexon Camera Mounting Kit is provided with each camera shipped with the 
CinePlex Studio order. The parts have been selected to apply in many of the 

 33.236ms 20ms 10ms
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situations encountered while doing CinePlex installations. Note that because of 
the general nature of the kit, not all parts will be used in all cases. In addition, 
there will be some cases where a particular installation will require that the 
customer purchase some additional parts locally. The kit includes the parts shown 
below.

Quick Change Mounting Assembly 
(Bogen-Manfrotto):

Note: The Quick Change Mounting Assembly (Bogen-Manfrotto) consists of 
the Rectangular Quick Release Adaptor (Part No. 323) and Rectangular Plate 
(Part No. 200PL).

Universal Adjustable Camera Mounting Bracket 
(VideoSecu Model MCB1B)

3
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B.6 Additional Mounting Accessories to Consider

Some experimental setups may require additional mounting hardware over and 
above those supplied in the Plexon Mounting Kit. This section shows some 
examples of parts you might find useful. See Section B.8.3, "Examples of 
Camera Installations" for some examples using these accessories.

All of the parts shown in this section can be purchased or machined by the 
customer as needed.

1 Mounting Bracket

2 Sandwich Plate 

3 Three Arm Phenolic Knob (small) - 1/4”-20 (3 ea.)(McMaster Carr 
57715K16)

4 Three Arm Phenolic Knob (large) - 3/8”-16 (McMaster Carr 57715K83)

1

3

4

2

5
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1 Camera Mounting Plate 3”x6” with threaded holes.

2 Stud 036-014 (1/4”-20 m x 1/4” 20 f)(Bogen Manfrotto 036-014)*

3 Stud 036-038 (3/8” m x 3/8” f)(Bogen Manfrotto 036-038)*

4 Stud 037 (1/4”-20 m x 3/8” m)(Bogen Manfrotto 037)*

5 Stud 066 (1/4”-20 f x 2/8” f)(Bogen Manfrotto 066)*

1

2
3

4
5
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6 Ball Head - Micro (Bogen Manfrotto 482)*

7 Ball Head - Mini w/ RC2 (Bogen Manfrotto 484RC2)*

8 Ball Head - Compact w/ RC2 (Bogen Manfrotto 486RC2)*

To obtain these accessories, you might consider the following sources:

• Online - search for “Manfrotto” and the item number from many sources such 
as:

— http://www.amazon.com/

— http://www.ritzcamera.com/

— http://www.bhphotovideo.com/

• A local professional camera or video store

CAUTION ABOUT TRIPODS
Note specifically that tripod mounting of the camera is NOT 
RECOMMENDED. This is because tripod adjustments, particularly leg 
locking mechanisms, can loosen and become unstable. Tripods can 
also be jostled or moved easily since they are generally not secured 
to a surface.

6 7 8
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B.7 Bracket Mounting Methods

This section provides some examples of bracket mounting methods.

B.7.1 Camera Mounting Location

First, choose where the camera should be mounted. Common choices are shown 
below:

Above the Experiment

• Ceiling mount

• Top of enclosure

a  Inside of enclosure with room for cables

b  Above the enclosure through an opening

c  Inside of cage with room for cables

From the side of the Experiment

• Wall mount

• Side of enclosure

a  Inside of enclosure with room for cables

b  Outside of enclosure through an opening

c  Inside of cage with room for cables

Below the Experiment

• Up through a glass or cage floor to view the undersides of animals or for birds 
in perches

• Floor mount aimed up an animals in the air or above the floor

• Below enclosure

a  Inside of enclosure with room for cables

b  Below the enclosure through an opening

c  Inside of cage with room for cables
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B.7.2 Bracket Attachment to Surface or Other Structure

Choose the most appropriate method of attaching the camera mounting bracket to 
the desired location.

1 On a surface of a wall or ceiling over 0.4 in (1 cm) thick, use one of the 
following methods or devise a custom method.

a  Customer provided screws through the three threaded holes in the bracket 
into the wall. Wall anchors should be used as necessary.

b  Customer provided bolts through the three threaded holes in the bracket 
into a wooden surface. Pilot holes can be drilled, if needed, using the 
sandwich plate as a template.

c  Customer provided adhesive or epoxy to glue the surface of the mounting 
bracket containing the three threaded holes to the surface.
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2 On a cage:

a  Place the sandwich plate on the outside of the cage, then

b  Insert the three small knobs through the sandwich plate holes and through 
openings in the cage, then

c  Thread the three small knobs into the threaded holes in the mounting plate.

3 On a wall or surface under 0.4 inches (1 cm) thick:

a  Drill three 9/32” (7 mm) holes using the sandwich plate as a template, then

b  Insert the three small knobs through the wall into the threaded holes in the 
mounting plate.
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B.8 Installing the Camera

B.8.1 Procedure for Camera Installation

Note: This procedure assumes that you are using a mounting bracket and other 
hardware shown in the diagrams below. Your actual mounting method might be 
different than the examples shown here.

1 Power down all system components - computer, OmniPlex System, etc.

2 Select the bracket attachment method suitable for the experiment and install 
the mounting bracket. Make sure that the mounting bracket is firmly attached 
and stable.

3 Install the rectangular plate adaptor on the mounting bracket using the large 
phenolic knob. For most applications, the point of large lever should be 
pointing away from the experiment when secured. Tighten finger-tight.

4 Make sure that the large lever on the plate adaptor is in the open position and 
ready to accept the plate. If the large lever cannot be moved easily, move the 
small brass level to the unlock position, and try again.

5 Remove any cables from the camera, if present.

6 Attach lens to camera by screwing it on finger-tight.
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7 The adaptor plate should already be attached to the camera - if not, do so at 
this time.

8 Attach the rectangular plate to the camera adaptor plate. For most 
applications, the lens should be oriented in the position labeled “2 LENS”. use 
the attached wire loop to finger-tighten the camera and then fold the loop 
down.

a Position “1 LENS” shown below

b Position “2 LENS” shown below
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9 Snap the camera/plate combination into the plate adaptor that is already 
attached to the mounting bracket. Note that there is only one possible 
orientation. The large lever will snap closed. Move the small brass lever to the 
lock position. Make sure that the large lever cannot be unlocked.

10 Connect the FireWire cable(s) to the camera(s). Use the FireWire socket 
labeled “1” in the photo.

11 Connect the other end(s) of the camera FireWire cable(s) to any port(s) in the 
FireWire board in the computer. Tighten the screws so that each plug is 
secure in its socket.

12 Connect the camera trigger cable(s) to the trigger cable socket on the 
camera(s).

13 Connect the other end(s) of the camera trigger cable(s) to any of the ports on 
the ACCES I/O Adaptor on the computer (shown in the image below).

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.

1 2

Trigger cable
socket

FireWire
socket 1
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Note: The following steps are a brief summary of the additional cabling 
requirements and system startup procedures. 

14 Make sure all other system cables are attached as required. Cabling 
diagrams and details are provided in Appendix A‚ Cabling Guide. 

15 Turn on the OmniPlex chassis, then the PC. Open the OmniPlex Server and 
PlexControl applications and start data acquisition in PlexControl. Then bring 
up CinePlex Studio. The complete startup sequence is provided in Chapter 2, 
Installing, Starting and Testing CinePlex Studio.

16 Loosen the large phenolic knob holding the camera/plate assembly to the 
mounting bracket and adjust the camera orientation until the experimental 
area is centered. Then tighten the large phenolic knob. It may also be 
necessary to repeat Step 8 with the camera in the “1 Lens” position of more 
adjustment latitude is needed.

17 Adjust the camera zoom until the experimental area fills the viewable image. If 
this is not possible the camera may need to be moved closer to or further 
away from the experiment. This can be done by selecting a different hole in 
the mounting bracket for the adaptor plate attachment. If there is space 
available, the mounting bracket may even be moved to the other side of its 
mounting surface. If a satisfactory view is still not possible, contact Plexon 
Support for additional lens options.

18 Adjust focus, and iris as needed for a good image.

B.8.2 Mounting Options for Multi-camera Systems

Place each camera as needed to record its area of interest. Make the choices 
required for each position. Install each camera using the procedure appropriate 
for your experiment.
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B.8.3 Examples of Camera Installations

This section includes some examples of camera installations. Obtain the customer 
supplied accessories as needed for your experiment.

1 Using a Mini Ball Head between the camera and the mounting plate.

2 Using multiple ball heads to achieve difficult angles.
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3 Using a camera mounting plate together with a ball head and stud 037 to 
achieve an offset camera mount at a difficult angle.

B.9 Camera Removal

Procedure for Camera Removal

1 Power down all systems.

2 Remove all cables from the camera.

3 Move the small brass level to the unlock position if not already there.

4 Place a hand on the camera to catch it as it releases.

5 Move the large lever to the unlock position.

6 Catch the camera and place it in a safe location.
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C.1 Types of Messages

This appendix lists the system messages that the CinePlex® Studio software 
displays in reaction to current conditions and certain user actions. Messages are 
displayed in the Messages pane of the CinePlex Studio main window.

Informational messages are called simple messages, and the more urgent 
messages are called critical messages.

C.2 How to Use Messages

Messages provide a convenient flow of information to the user, and alert you to 
problems detected by CinePlex Studio. Therefore, messages can be useful for 
monitoring and troubleshooting the system. For information on correcting 
specific problems, see Appendix D-Troubleshooting.

C.3 CinePlex Studio Simple Messages

The table below lists the CinePlex Studio simple messages. In most cases, it is 
not necessary for you to take action when a simple message is displayed.

Note: In this table, [...] and <N> refer to text and numeric strings, respectively. These 
strings can differ for each instance of the message.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.

Table 1: CinePlex Studio Simple Messages

Message # Message Text

C100 CinePlex Studio version [...] Starting...

C101 Current date:

C102 Date changed. Current date: [...]

C103 Current display frequency

C104 Display frequency successfully changed to <N> Hz

C107 Factory default settings loaded

C108 File opened for View

C109 File closed for View

C110 Cameras reset

C111 Frame resolution changed
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C112 Loaded settings were created for a different resolution. Arena, zones and calibration 
(if present) are properly resized.

C113 Startup settings loaded from [...]

C114 Settings loaded from [...]

C115 Background image loaded from [...]

C116 Settings stored in the file [...]

C117 Background image stored in the file [...]

C118 Play file started

C119 Event Combinations view presented

C120 Video view presented

C121 Recorder Properties view presented

C122 Area Properties view presented

C123 Messages view presented

C124 Previous video configuration is not applicable due to hardware changes or absence 
of Rasputin or OmniPlex key

C125 Video configuration has been automatically reset to One File

C126 The layout loaded contains panels incompatible with the current license. These 
panels are removed.

C127 Remote start received and discarded

C128 Remote stop received and discarded

C129 Remote pause received and discarded

C130 Video configuration has been automatically set to connect all available cameras 
according to the license

C132 Video configuration has been automatically set to One File

C133 Video configuration has been automatically reset to Camera 1

C135 Armed for remote control - DVR control by Plexon NDAQ is now enabled

C136 Remote control disabled - DVR control by Plexon NDAQ is now disabled

C137 Recording [...] started by Plexon NDAQ

C138 Recording [...] paused by Plexon NDAQ

C139 Recording [...] resumed by Plexon NDAQ

Table 1: CinePlex Studio Simple Messages (Continued)

Message # Message Text
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C140 Recording [...] stopped by Plexon NDAQ (<N> dropped frame(s), <N> MQU)

Note: MQU = maximum queued units. For a description of MQU, see “Monitoring the 
Video During a Recording Session” on page 3-52.

C141 Recording [...] started locally

C142 Recording [...] stopped locally (<N> dropped frame(s), <N> MQU)

C143 Recording [...] paused locally

C144 Recording [...] resumed locally

C145 Tracking switched to Object Contour mode

C146 Object Contour tracking stopped

C147 No LEDs are active. The objects for dynamic zones will be switched to N/A.

C148 Tracking switched to LED mode

C149 LED tracking stopped

C150 Can not switch to LED mode, since tracking license is not detected

C151 Tracking switched to Reflective Colors mode

C152 Reflective Colors tracking stopped

C153 Can not switch to Reflective Colors mode, since tracking license is not detected 

C154 Recording [...] stopped due to missing license key

C155 Tracking stopped due to missing license

C156 No markers are active. The objects used in dynamic zones will be switched to N/A.

C157 Recording folder changed to [...]

C158 Recording [...] stopped since file size on FAT32 drive cannot exceed 4GB (<N> 
dropped frame(s), <N> MQU)

C159 Recording [...] stopped due to low disk space (<N> dropped frame(s), <N> MQU)

C160 End of File. Can not start recording

C161 End of File. Can not start playing

C162 Camera framerate changed to <N>

C163 Wizard opened

C164 Wizard finished

C165 CPX Studio window size reduced by Shrink button

C166 CPX Studio window size restored by Expand button

Table 1: CinePlex Studio Simple Messages (Continued)

Message # Message Text
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C167 Date has changed since the last file was recorded. The file number reset to 001

C168 Can not add sequence due to missing license key

C169 Tracking settings ignored since missing license

C171 Tracker Properties view presented

C172 New shape added to Arena

C173 New shape added to Zone

C174 Shape #<N> deleted from Arena

C175 Shape #<N> deleted from Zone

C176 Tracking Events view presented

C177 Event Statistics view presented

C178 Output lines for the loaded tracking events ignored since no digital output device 
found

C179 All shapes deleted from Arena

C180 All shapes deleted from Zone

C181 Temporary AVI file [...] renamed to [...]

C182 Renaming temporary AVI file [...] failed

C183 Temporary DVT file [...] renamed to [...]

C184 Renaming temporary DVT file [...] failed

C185 Standalone recording [...] started

C186 Standalone recording [...] stopped (<N> dropped frame(s), <N> MQU)

C187 Recording time zero [...] received from OmniPlex Server

C188 File N activated

C189 File N closed

C190 Zone Sequences view presented

C191 Standalone recording [...] paused

C192 Standalone recording [...] resumed

C193 Video Properties view presented

C194 Previous video configuration was [...]

C195 Switched to Camera mode

C196 Camera N started

Table 1: CinePlex Studio Simple Messages (Continued)

Message # Message Text
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C197 Camera N stopped

C198 Switched to File mode

C199 Camera settings for camera <N> have been applied to all available cameras

C200 View with 3D calibration settings presented

C201 3D data view presented

C202 3D calibration started

C203 3D calibration finished successfully

C204 3D calibration failed

C205 3D calibration interrupted and not ready

C207 Video Edit view presented

C209 3D settings ignored since missing 3D license

C211 Initializing CinePlex

C212 Initializing cameras at start

C213 Disconnected from IP address

C214 Connected to IP address

C215 View with 3D settings presented

C216 Extended Color Markers tracking stopped

C217 Tracking switched to Extended Color Markers mode

C218 3D calibration failed: there are cameras without reference frame

C219 Temporary DV3 file [...] renamed to [...]

C220 Renaming temporary DV3 file [...] failed

C221 3D settings ignored due to mismatch between number of cameras used for this 
calibration and number of available sources

C222 No calibration data present

C223 Tracking settings ignored since they are incompatible with the current license

C224 Screen saver and power management disabled

C225 Screen saver and power management enabled

Table 1: CinePlex Studio Simple Messages (Continued)

Message # Message Text
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C.4 CinePlex Studio Critical Messages

The table below lists the CinePlex Studio critical messages. In most cases, it is 
important for you to take action (or revise your previous action) when a critical 
message is displayed.

Note: In this table, [...] and <N> refer to text and numeric strings, respectively. These 
strings can differ for each instance of the message.

Table 2: CinePlex Studio Critical Messages

Message # Message Text

C898 MAP and CinePlex Studio out of synch.

C900 Clock signal not detected

C901 Clock signal detected

C902 Recording [...] stopped due to loss of clock OR RECORDING STOPPED AND/OR 
DISABLED! CLOCK or TRIGGER SIGNAL NOT DETECTED!

C904 Current CinePlex Studio does not support this version of settings file. Try to read 
another file.

C905 Can not be armed for remote recording before arena definition is finished

C906 Apparently Adobe Acrobat Reader is not installed on this system

C907 Cannot find the manual at: [...]

C908 Error code <N> has occurred while trying to open [...].

C999 Polygon can not have less than 3 points.

C910 Can not create self-intersecting polygons.

C911 Recording folder doesn’t exist. Please choose another one.

C912 Saved layout does not exist

C913 Unable to load the requested layout! The default layout applied

C914 Can not be armed for remote recording until Wizard is exited.

C915 Can not start recording until Wizard is exited.

C916 Can not add new zone: number of zones of interest can not exceed 100.

C917 Can not add new zone: the boundary of the last existing zone is not defined.

C918 The number of shapes in arena can not exceed 100.

C919 The number of shapes in zone can not exceed 100.

C920 Overlapped zones are not allowed in sequence

C921 Can't delete selected zone since it is used for generation of tracking event(s). Modify 
the event(s) first.

C922 Can't delete selected zone since it is used in sequence(s). Modify sequence(s) first.
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C923 The number of events can not exceed 100.

C924 Can't delete the last remaining shape from the selected zone since it is used for 
generation of tracking event(s). Modify the event(s) first.

C925 Can not be armed for remote recording due to missing license key

C926 Can not add event since LED or Marker tracking mode is not selected.

C927 Can not add event since no LEDs selected.

C928 Can not add event since no markers selected.

C929 Can't delete selected sequence since it is used for generation of tracking event(s). 
Modify the event(s) first

C930 Unable to save current layout

C931 Can not add event combination since tracking mode is not selected.

C932 Can not add event combination since no single events are defined.

C933 Can not add new event combination since not all events for the last combination are 
defined.

C935 Can't uncheck selected LED since it is used for generation of tracking event(s). 
Modify the event(s) first.

C936 Can't uncheck selected marker since it is used for generation of tracking event(s). 
Modify the event(s) first.

C937 Can not add event since tracking mode is not selected.

C938 Can not add event since no LEDs selected

C939 Can not add event since no markers selected.

C940 No Rasputin or OmniPlex key found. Switching to offline mode

C941 Access I//O board is not found, but cameras are detected. Switch to test mode? 
Clicking YES will switch Studio to the test mode. Otherwise Studio will start in offline 
mode.

C942 Access I//O board is not found. Switching to test mode

C943 Access I//O board is not found. Switching to offline mode

C944 No clock signal from Plexon NDAQ, but cameras are detected. Switch to test mode? 
Clicking YES will switch Studio to the test mode. Otherwise Studio will start in offline 
mode.

C945 No clock signal from Plexon NDAQ. Switching to test mode

C946 No clock signal from Plexon NDAQ. Switching to offline mode

C947 Recording is stopped, since recordings longer than 1 min are not allowed in test 
mode

Table 2: CinePlex Studio Critical Messages (Continued)

Message # Message Text
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C948 Can not add new sequence since the previously added sequence contains no zones.

C949 Can not add new sequence since the last zone in the previously added sequence is 
undefined.

C950 The number of sequences can not exceed 100.

C951 Can't delete selected sequence since it is used for generation of tracking event(s). 
Modify the event(s) first.

C952 Can not add new zone to the current sequence since the last zone in the sequence 
is undefined.

C953 Sequence can not contain more than 100 zones.

C954 Can not add new zone to the current sequence since no zones is defined.

C955 Files opened have different compression. Record, Play, Pause and Stop will be 
disabled.

C956 Files opened have different frame rate. Record, Play, Pause and Stop will be 
disabled.

C957 Can not open the same file twice.

C958 Start and end point of head direction vector should be different.

C959 Start point of head direction vector and end point of reference vector should be 
different.

C960 Can't associate selected LED with event since this LED is associated with dynamic 
zone used for generation of this event. Select another LED.

C961 Loading startup settings from [] failed because this version of settings file is not 
supported by Current version of CinePlex Studio

C962 Current Cineplex Studio does not support this version of settings file. Try to read 
another file.

C963 Loading last saved settings file [...] failed because the file is missing. Factory default 
settings have been applied

C964 Settings loading failed because file [...] is missing.  Factory default settings have 
been applied

C965 No settings file to load. Factory default settings have been applied

C966 Can not start recording due to missing license key

C967 Can not start recording since disk information can not be retrieved

C968 Can not start recording. File number can not exceed 999. Delete or rename video 
(*.AVI and *.DVT) files in the recording folder and try again

C969 Can not start recording due to low disk space.

C970 Can not add arena due combination to missing license key

Table 2: CinePlex Studio Critical Messages (Continued)

Message # Message Text
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C971 Can't associate dynamic zone with selected LED since this LED is used for 
generation of event associated with this zone. Select another LED.

C972 Can't associate dynamic zone with selected Marker since this Marker is used for 
generation of event associated with this zone. Select another Marker.

C973 Only Motion JPEG RGB files are accepted. Record, Play, Pause and Stop will be 
disabled.

C974 Files opened have different frame resolution. Record, Play, Pause and Stop will be 
disabled.

C975 Only resolution 640x480 or 320x240 is supported. Record, Play, Pause and Stop will 
be disabled.

C976 CinePlex only supports MJPEG or Plexon MPEG4 AVI files. Try another file.

C977 Video frame width must be a multiple of 16. Record, Play, Pause and Stop will be 
disabled.

C978 Video frame height must be a multiple of 8. Record, Play, Pause and Stop will be 
disabled.

C979 CinePlex Studio has not been connected as a Client since SortClient is not running. 
No coordinate data will be recorded in .PLX file

C980 CinePlex Studio has not been connected as an OmniPlex Client since PlexControl is 
not running. No coordinate data will be recorded in .PLX file

C981 CinePlex Studio has not been connected as an OmniPlex Client since CinePlex.dll is 
absent or damaged

C982 Display resolution is not enough to run all available cameras even in 320x240 
resolution. Number of cameras to use is reduced to fit the display resolution.

C983 Connections should be different.

C984 Connection points must be different.

C985 Open socket failed

C986 No network connection found

C987 Cannot connect to selected node.

C988 Cannot apply calibration: Number of cameras in the calibration file less than number 
of active cameras. Please try different calibration file or deactivate cameras.

C990 Camera switched to 320x320 resolution because of multi-camera license. One-
camera license required to run 960x960 resolution for this camera.

C991 Cannot have resolution exceeding 320x320 because of multi-camera license. One-
camera license required to run 960x960 or 640x640 resolution for this camera.

C992 Video signal detected

Table 2: CinePlex Studio Critical Messages (Continued)

Message # Message Text
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C993 Video signal not detected

C994 This CinePlex Studio (N camera license) requires minimum w x h screen resolution 
or higher

C995 Cannot write to the file. The file might be opened by other application. Please close 
the file first

C996 This CinePlex Studio (N camera license) cannot accept W x H frame resolution

Table 2: CinePlex Studio Critical Messages (Continued)

Message # Message Text
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This section identifies some operational problems that can arise due to issues 
with hardware, software or procedures, and provides the steps to help solve 
each problem. If the steps here do not solve the problem, or if the problem 
is not listed, please contact Plexon® Support at support@plexon.com 
or +1-214-369-4957.

D.1 CinePlex Studio Software Does Not Install Properly

This section provides troubleshooting steps you can use if the Studio application 
fails to install correctly.

The installation package adds programs and DLLs to the system. Therefore, the 
installation software:

1 Must be run on a Windows® 7 machine. (The software is designed for 
Windows 7 and might not run correctly on other platforms.)

2 Must be run from a computer account with administrator privileges.

3 Must be downloaded to and run from a local hard drive. Removable drives, 
including USB flash drives and USB hard drives, are not acceptable. Neither 
are networked drives.

D.2 Studio Displays a Dialog Box and Does Not Run

Under certain conditions, when you double click the CinePlex® Studio icon 
( ), Studio displays a dialog box and does not begin normal operations. This 
section describes some of those conditions and possible solutions.

D.2.1 Licensing Problems

1 Ensure you have installed the correct license keys (CinePlex and 

OmniPlex®). Then close and restart the Studio application.

2 If CinePlex Studio still will not start and reports a missing license key, install 
the Sentinel drivers. (This is done by the CinePlex installation software or by 

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.

TIP
Correcting loose connections can fix many problems
In some cases, a problem can be due to a cable, ACCES I/O Adaptor or 
ACCES I/O board in the PC becoming loose. In those cases, the problem 
is easily fixed by reconnecting or reseating any loose cable, adaptor or 
board. 

mailto:support@plexon.com
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running the file C:\Program Files (x86)\Plexon Inc\CinePlex Studio V3\ 
Common Files\Sentinel System Driver Installer 7.5.8.exe.)

D.2.2 DLL and Driver Problems

If CinePlex Studio reports missing DLLs, reinstall the CinePlex software. All the 
required DLLs are in the installation package.

D.2.3 Possible Interference from Antivirus Software

Some OmniPlex/CinePlex Systems come from Plexon with antivirus software 
pre-installed. The system has been tested with this antivirus software in place and 
should operate without problem as long as software and update settings are not 
changed. If problems occur that can be traced to the pre-installed antivirus 
software, please contact Plexon Support. It could be that a new set of virus 
signature files has caused some CinePlex components to be flagged as 
untrustworthy.

Please do not install any other antivirus software on the OmniPlex/CinePlex 
System computer without consulting Plexon Support first. Periodic downloads of 
updates or periodic scans for infections can disrupt video streams and processing, 
causing dropped frames and delayed events.

D.3 Studio Starts but Displays a Dialog Box 

When you double-click Studio application icon ( ) and CinePlex Studio opens, 
it takes one of the following actions depending on the conditions it detects:

• Camera and Clock Are Both Detected On Startup—Studio opens normally 
and does not display a dialog.

• Camera Is Not Detected On Startup— Studio opens automatically in Files 
mode.

• Camera Is Detected but Clock Is Not Detected On Startup—There is a 
problem with the clock signal that comes from the OmniPlex System to the 
CinePlex System. CinePlex Studio displays a series of dialogs with user-
selectable options.

Note: During normal operation, if the clock signal is interrupted, Studio stops any 
recording that is in progress and displays a dialog (see Section D.5, "Message 
C902—Interruption of Clock Signal during Operation").

The flow chart below summarizes these startup and clock conditions, and 
additional explanations are provided in the pages following the flow chart.



D  Troubleshooting 

D-4 CinePlex Studio



 

Version 3.7 D-5

D.3.1 Camera and Clock Are Both Detected On Startup

If camera(s) and clock are both detected, the system opens automatically in 
Cameras or Files mode (whichever mode the system was in when it was closed). 
You can switch back and forth between Files and Cameras modes.

D.3.2 Camera Is Not Detected On Startup

If the system does not detect any cameras, Studio opens automatically in Files 
mode. The Messages window displays “C947, No cameras found. Switching to 
File mode.” An example is shown below. 

Only Files mode is available, and you cannot switch to Cameras mode.
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D.3.3 Camera Is Detected but Clock Is Not Detected On Startup

If the system detects a camera but does not detect a clock signal, Studio displays 
a dialog with message C900 “Clock signal ... not detected” and then gives you the 
option of opening in Test mode (1-minute recording limit) or Files mode.

For additional details regarding these dialogs, see Section D.4, "Messages C900/
C944 on Startup—Clock Signal Problems".

For more information about Test mode, see Section 2.3, "Video Test Mode” on 
page 22.

To troubleshoot clock signal problems and restore the clock signal, see Section 
D.6, "Restoring the Clock Signal".

Studio switches to Test mode Studio switches to Files mode



 

Version 3.7 D-7

D.4 Messages C900/C944 on Startup—Clock Signal Problems

This section provides troubleshooting steps you can use if the Studio application 
fails to start correctly due to problems with the clock signal.

D.4.1 Message C900—Clock Signal Not Detected
Message C944—No Clock Signal, but Cameras Are Detected

If the following dialog is displayed when you attempt to start the Studio 
application, it means that Studio has not detected a clock signal from the 
OmniPlex System. The clock signal originates in the OmniPlex System and is 
transmitted from the OmniPlex Timing Control Card, through the gray Timing 
Cable, through the ACCES I/O Adaptor and into the ACCES I/O board on the 
back of the PC.

Note: The dialog box text refers to the OmniPlex System as the Plexon Neural Data 
Acquisition (NDAQ) system.

1 Click OK.

After you click the OK button, the system response depends on the signals it 
is receiving from the clock and cameras:

• If no clock and no cameras are detected, the system opens in Files 
mode. (Studio always opens in Files mode if no cameras are detected.)

• If no clock is detected, but one or more cameras are detected, Studio 
displays a dialog (see below) and gives you the option of clicking Yes or 
No. 
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2 Click Yes to enter Test mode or No to enter Files mode.

3 For information on running the system in Test Mode, see Section 2.3, "Video 
Test Mode” on page 22.

4 To restore the clock signal, perform the steps in Section D.6, "Restoring the 
Clock Signal". Then you will need to restart the system; after that, you will be 
able to run the system in Cameras mode.

D.5 Message C902—Interruption of Clock Signal during Operation

If Studio is running normally and the clock signal from the OmniPlex System is 
interrupted, the system displays this dialog:

Follow the procedure in Section D.6, "Restoring the Clock Signal" to restore the 
clock signal and restart the system.
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D.6 Restoring the Clock Signal

The Studio application will run in Test mode (with cameras) or Files mode 
(without cameras) even if a clock signal is not present. However, to run in 
Cameras mode, the clock and at least one camera must be detected by the Studio 
software. This section explains how to restore the clock signal.

The diagram below shows the components involved in the timing and control 
circuits. If a clock signal is not detected by the CinePlex System, there could be a 
problem anywhere in the chain of hardware timing and control components.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.

CinePlex timing 
and control path
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1 Power down (turn off) the PC and the OmniPlex chassis.

2 Verify that the Timing Control Card is installed and seated properly in the 
OmniPlex chassis.

3 Verify that the CinePlex ACCES I/O board is seated properly in the PCI slot in 
the rear panel of the computer.

4 Verify that the ACCES I/O Adaptor is installed and seated properly onto the 
ACCES I/O board.

5 Verify that the camera(s) are cabled to their correct locations on the rear panel 
of the computer as shown in the following diagram, and that all camera 
cabling connectors are properly seated. (The diagram below applies to 
systems with two cameras. Additional information on cabling is provided in 
Appendix A‚ Cabling Guide.) 
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6 Verify that the gray Timing Cable is installed and seated correctly (see the 
diagram, above).

7 Restart the OmniPlex chassis and then the computer. 

8 Start the OmniPlex Server and PlexControl. Start data acquisition in 
PlexControl.

9 Start the CinePlex Studio application.

10 Check that the Studio application is functioning normally. If it is not, contact 
Plexon Support for assistance.

D.7 Message C947—Test Mode, Recording Stopped at One Minute

If you are capturing video while in Test mode, after one minute of recording, the 
system will display Message C947, “Recording is stopped, since recordings 
longer than 1 min are not allowed in test mode.” The CinePlex System will 
remain in Test mode until a clock signal is established (from the OmniPlex 
System to the CinePlex System), and the computer is restarted.

You can take either one of the following actions:

• Continue working in Test mode by making multiple 1-minute recordings (see 
Section 2.3, "Video Test Mode” on page 22).

• Restore the clock signal (see Section D.6, "Restoring the Clock Signal"), 
restart the computer and applications as described in Section 2.2, "Startup and 
Operational Testing” on page 16, and then work in Cameras mode.
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D.8 Problems with Cameras or Video Stream

This section provides troubleshooting steps you can take if there is no video 
stream displayed (the Video pane is black, no image showing), or there are other 
problems with the video image.

Note: Only the cameras listed in Section 1.7, "CinePlex Studio Features” on page 6 
are supported. If you are using a camera that is not supported, it may be diffi-
cult to obtain a proper video stream.

D.8.1 The System Starts in Files Mode Instead of Cameras Mode

If the system detects a clock signal but does not detect any cameras, Studio opens 
automatically in Files mode and displays the message “C947, No cameras found. 
Switching to File mode.” An example is shown in the following image. 

1 After powering the PC down, check the camera cables, especially the 
FireWire cable connections.

2 Power up the system according to instructions in Chapter 2, Installing, 
Starting and Testing CinePlex Studio.

D.8.2 No Video Stream Is Displayed In Cameras Mode

The CinePlex application can open in Cameras mode only if both of the 
following requirements are met:

• At least one camera must be connected to the host computer so the CinePlex 
application can detect the camera.

• The OmniPlex chassis must be turned on, and the timing signal from the 
OmniPlex System must be detected by the CinePlex System.

Follow this recommended sequence to bring up the system:

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result. Please note that any 
damage due to this cause is not covered by the Plexon warranty.
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1 After powering the PC down, check the camera cables, especially the 
FireWire cable connections.

2 Power up the OmniPlex chassis.

3 Plug the Sentinel license (including both the OmniPlex and CinePlex licenses) 
into a USB port in the computer.

4 Power up the computer, log in as administrator, bring up the OmniPlex Server 
program, and then bring up the PlexControl program. 

5 Start data acquisition in PlexControl.

6 Bring up CinePlex Studio. 

7 If Studio fails to start or displays startup error messages, perform the 
necessary steps in Section D.4 and Section D.6.

8 After Studio starts, verify that the system is in Cameras mode.

9 Verify that at least one of the camera icons is selected. The icon background 
is orange when selected. In the image below, Camera 1 is selected.

10 If there is still a problem with the video stream, ensure that the manual iris 
control on the lens is fully open.

11 The video stream should be visible now in the Studio user interface. If it is not, 
reset the user interface to the default layout, as shown in the image below.
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12 If the video stream is still not visible, contact Plexon Support for further 
assistance.

D.8.3 No Video Stream Is Displayed In Files Mode

Ensure that you have loaded a file in the Source pane.

D.8.4 Video Image Shakes

Camera mounts must be stable or the resulting video data will shake and not be 
repeatable. This can be the case, for example, when a tripod is used to mount a 
camera, instead of the preferred wall or ceiling mount. Please refer to 
Appendix B‚ Optimizing Camera Mounting and Lens Usage.

D.8.5 Video Image Is not Focused

Adjust the zoom and focus rings on the lens until a clear picture is obtained. 
(See the image of the camera in Section D.8.2.) 

D.8.6 Flickering Video

Video is present, but the image is flickering.

1 Some gas discharge lamps can cause the video image to flicker. Use 
incandescent bulbs if possible. 

2 If fluorescent fixtures must be used, check for any problems with the bulbs, 
starters or ballast. Use incandescent bulbs if possible. 

D.8.7 Arena Is Too Small or Too Large within the Video Image

Once video has been obtained, the camera and lens must be adjusted so that the 
maximum dimension of the arena nearly fills the long dimension of the video 
image while ensuring that all other parts of the arena are within the video image 
as well. In general, it is best to move the camera as far from the experimental 
surface as possible, then zoom in as much as possible. For further information 
about camera mounting and adjustments, see Appendix B‚ Optimizing Camera 
Mounting and Lens Usage.

D.9 Studio Does Not Start Recording from PlexControl “Start Data”

1 Check that Studio is in the Armed mode, waiting for PlexControl to start 
recording. Armed mode is explained in Section 3.4, “Recording Synchronized 
Video Tracking and Neural Data” on page 43.

2 Check that all cables are properly connected, especially the control cables 
(see Appendix B‚ Optimizing Camera Mounting and Lens Usage).
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D.10 No Strobed Data Showing in PlexControl after Initial Startup

Usually, this problem occurs because the correct startup sequence has not been 
followed with the OmniPlex chassis and PC, and with Server, PlexControl, data 
acquisition, and CinePlex Studio software. 

In addition, you must select one of the tracking modes and then select at least one 
PLX button in Studio to cause a data stream to be sent from Studio to the 
OmniPlex System. 

The strobed data in the OmniPlex Activity window should look like this:

If there is no activity displayed in the CPX1 line (as shown above), perform the 
following steps:

1 Select a tracking mode in Studio.

2 Press at least one of the PLX buttons (see the procedure in Section 4.6.5, 
"Sending Tracking Data to the OmniPlex System” on page 90).

3 Scroll down to the bottom of the OmniPlex Activity tab window and verify that 
strobed data hash marks are being displayed.

4 If there is no strobed data being displayed, close all applications on the PC, 
then shut down the PC. Then turn off the OmniPlex chassis. 

5 Restart the OmniPlex and CinePlex Systems according to the sequence 
provided in Chapter 2, Installing, Starting and Testing CinePlex Studio.

6 Repeat the above steps and verify that the strobed data is displayed in the 
OmniPlex Activity window.
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D.11 Dropped Frame Count Non-zero While Recording

When the computer is heavily loaded with other applications running 
simultaneously with the CinePlex and OmniPlex applications, it might prevent 
video frames from being processed in time, which can even result in video 
frames being dropped. The count of dropped frames is incremented each time 
this happens.

Note: For details on monitoring dropped frame counts, see Section 3.6, 
"Monitoring the Video During a Recording Session” on page 52.

1 Stop running all unnecessary applications on the computer while recording. 
This includes CinePlex Editor, which can initiate intensive hard drive activity. 
Use the Task Manager to display and end unneeded tasks.

2 Disable scheduled tasks such as backup and Windows® Update. These can 
cause dropped frames when they run. Use the Task Scheduler to view all 
tasks. Contact the system administrator to disable unwanted tasks.

3 Internet activity, especially that involving heavy downloads such as from 
YouTube or similar sites should be prohibited on the CinePlex/OmniPlex 
System computer. To avoid this possibility Plexon recommends placing the 
computer on a subnet isolated from intensive internet traffic.

4 If dropped frames still persist after these steps, please contact Plexon 
Support.
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E.1 Plexon User Interface

The Plexon® User Interface embodies a standard look-and-feel for Plexon 
software products. To illustrate the underlying concepts behind the look-and-feel, 
this appendix uses screenshots from Plexon’s CinePlex® Studio and Editor 
applications. Although there will be differences in menus and toolbars between 
different applications, how to use, handle, and operate the user interface 
components will be fundamentally the same across future generations of Plexon’s 
software products including:

• CinePlex Studio

• CinePlex Editor

• Offline Sorter™

This appendix covers common functionality of the look-and-feel between 
different Plexon software applications. The discussion includes the following 
sections:

• Screen Elements

• Standard Menu Items and Dialogs

• Customization

E.2 Screen Elements

E.2.1 Menus

The menu bar of the application contains the names of all of the menus for the 
application. Each menu name has a letter underlined which indicates the hot-key 
combination for that menu. To activate a particular menu, click the left mouse 
button on the name or press and hold the ALT key while pressing the underlined 
letter. The image below is the main menu of CinePlex Editor.
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Each menu of the Plexon User Interface contain menu commands and may also 
contain Icons, Hot Keys and a Tear-off Menu Handle as shown by the illustration 
below of the Edit menu of CinePlex Editor.

While all Plexon applications are shipped with their available menu commands 
organized into a set of menus, the contents of the menus can be customized and 
new menus can be created.

• Icons - Icons may be located immediately to the left of the menu commands. 
These icons will be displayed on the toolbar associated with the menu. In the 
example menu, there are icons associated with all but the last three of the 
menu commands. The presence of an icon next to a menu command means 
that the icon is also a label on a toolbar button and will execute the same 
command when clicked as the menu command on the menu.

• Hot Keys - Hot Keys are key combinations that will cause a menu command 
to execute without having to click the command on the menu. Typically, hot 
keys will contain two keys that must be pressed simultaneously for the 
combination to execute. The area at the far right of the menu commands may 
display the hot key combinations for the menu commands. In the example 

Icons

Tear-off Handle
Menu Commands

Hot Key
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menu, there is a hot key combination (CTRL + C) for the Copy command. 
Hot keys may be added or customized via the Tools-Customize dialog.

• Tear-off Menu Handle - The Tear-off Menu Handle is an area (the one con-
taining the dots) at the top of the menu, present on many menus. The tear-off 
feature allows the quick creation of a toolbar that contains all of the com-
mands in the menu that have command icons. You can hover the mouse over 
the tool to highlight it, drag the mouse to the toolbar area and place the menu 
as a toolbar there. The illustrations below show highlighting the Tear-off 
Menu Handle to begin dragging the toolbar, dragging the toolbar across the 
screen, and finally docking the toolbar in place.

E.2.2 Toolbars

Each toolbar has a dropdown button at the right that will allow you to add or 
remove buttons from toolbars and will also allow you to access the Customize 
dialog box. When you click the dropdown button the Add or Remove Buttons 
dropdown menu will appear as shown below.
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The dropdown menu also has a dropdown button. Clicking that button displays a 
menu list of the available toolbars and a menu command to allow access to the 
Customize dialog box.

Expanding one of the toolbar menus will display all of the available toolbar 
buttons for that particular toolbar and a checkbox beside each one that will 
indicate whether or not the button is visible on the toolbar. There is also an option 
to reset the toolbar back to its factory default setting.

Clicking the Customize menu command will open the Customize dialog box. 
This dialog box is common to Plexon software applications but may have 
different content on the tabs according to the software application.
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For details on using the Customize dialog box, see “Customization” on page E-
17.

E.2.3 Windows

The image below shows a typical window title bar. It contains (from left to right) 
a Title, a Auto Hide button, a Maximize button, and a Close button.

• Auto Hide Button  - The Auto Hide button “pins” a window to the 
screen to keep it visible or “rolls up” a visible window into a tab. When the 
window is pinned, the Auto Hide button points in a vertical direction. If the 
window is rolled up, the Auto Hide button points in a horizontal direction.

• Maximize Button  - The Maximize button may not appear on all 

windows. It is the standard Windows® maximize button. Clicking the 
Maximize button on a window will maximize the original window and hide 
other windows occupying the same horizontal or vertical space. Clicking the 
Maximize button again will restore the previous layout. When clicked the 
image on the button toggles between one window and overlapping windows.

• Close Button  - The Close button closes the window.
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Plexon software applications often display several windows simultaneously. 
These windows may be resized by using standard resizing methods and may also 
be repositioned by dragging and dropping and by using Docking Stickers. The 
image below shows the repositioning of a window (denoted by the blue 
transparent rectangle) and various Docking Stickers (with red circles around 
them). These Docking Stickers allow you to dock the window being moved in 
one of several ways described below.

You can position a window by floating it, docking it at the desired docking sticker 
at a window edge or in a tab.

• Floating a Window - You can drag a window by the Caption Bar near the 
center of the screen and release it causing the window to float. Holding down 
the CTRL key while dragging will always float the window. Double-clicking 
on the Caption Bar will also float a window. Note that the size and position of 
the floating window is remembered.

— Rolled-up Windows - Floating windows may be enabled for roll up up 
by pressing the Auto Hide button. The window will roll up when the 
focus is changed to a different window. The first image below shows a 
floating window before rolling it up. The second image below shows 
the rolled-up window after the focus has changed.
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• Docking a Window at the Application Frame - When you begin to drag 
a window, a transparent blue rectangle appears to indicate the position of the 
window and the four Docking Stickers appear individually at each edge of 
the application frame to allow you to dock the window to the respective edge. 
To dock just move the mouse to the desired Docking Sticker and release the 
mouse button. The docked window will extend along the entire length of the 
edge to which it is docked. The image below shows all four screen Docking 
Stickers.

• Docking a Window at a Window Edge - When you move the window 
inside another window, the window Docking Stickers appear inside the 
window grouped together near the center of the window. Releasing the mouse 
button while it is over one of these stickers (except the center one) will dock 
the moving window to the respective edge of the window associated with the 
window Docking Stickers. The image below shows the window Docking 
Stickers. Note that the shading of these Docking Stickers is different that the 
shading of the Docking Stickers in the previous image.

• Placing Windows into Tabs - Releasing the mouse button over the center 
Docking Sticker will allow the moving window to occupy the same space as 
the window beneath and will create tabs along the bottom for switching the 
view between the two windows. The image below shows the Marker Occur-
rences window without sidebar tabs on the left. On the right, a Channels win-
dow has been placed into the same space by using the center docking sticker. 
Note that there are two sidebar tabs at the bottom of the window.
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— Hidden Windows - Docked windows whose access is not needed often 
can be hidden or “rolled up” by pressing the Auto Hide button. When 
hidden, the window is represented by a sidebar tab. Sidebar tabs may 
be located at the left, right, or bottom of the screen and indicate hidden 
windows. To show one of these windows, just hover the mouse over 
one of the tabs and the window will appear. The File Info window of 
CinePlex Editor opened by the sidebar tab is shown below on the left. 
If you click the Auto Hide control, the window will be pinned and 
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remain open after you move the mouse away from the sidebar tab as 
shown on the right. The Auto Hide button will also have changed 
direction and be pointed downward. Note also that the File Info sidebar 
tab is gone on the right image.

E.3 Standard Menu Items and Dialogs

In Plexon software applications, some menu items may have the same 
functionality across several applications. These items are standard menu items 
and consist of the Window menu, the Run menu, and the Help menu.

E.3.1 Window Menu

The Window menu contains three items: Theme, Layout, and Customize.
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• Theme - Clicking on Theme displays a menu as shown below. A theme is a 
color scheme that is part of the look-and-feel of the user interface.

— Theme Group - The top group of items are theme toggle items that 
may be selected to apply to the user interface look-and-feel. Only one 
of the themes may be selected at a time. 

— Text Below Toolbar Icons - This item is a toggle item to show or not 
show text below the toolbar icons.

— Hide Window Title Bars - This item is a toggle item to hide or show 
window title bars.

• Layout - Clicking on Layout displays a menu as shown below. A layout is 
the size and placement of the windows on the screen. It also remembers the 
number and placement of toolbars.

— Reset to Default Layout - Clicking on this item resets the layout to the 
factory default.

— Load Layout Group - Clicking on Apply Layout 1 or Apply Layout 
2 applies one of the standard layouts to the user interface. Clicking on 
Load Layout From File will allow you to select a layout file to apply 
to the user interface.

— Save Layout Group - Clicking on Save As Layout 1 or Save As Lay-
out 2 saves the current screen layout as one of the two standard layouts. 
You can also click Save Layout to File to save the current screen lay-
out to a file that can be loaded by the Load Layout From File item.
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• Customize - Clicking Customize displays the Customize dialog box as 
shown below

For details on using the Customize dialog box, see “Customization” on page E-
17.

E.3.2 Run Menu

The purpose of the Run menu is to launch other applications quickly. The Run 
menu will be populated by default with some common Plexon applications. To 
launch other applications from within the current application, you can add new 
entries to the Run menu. A sample Run menu is shown below. For additional 
information about customizing the Run menu, see “Run Menu Customization” 
on page E-21.

E.3.3 Help Menu

The Help menu contains four items: Help, Quick Reference, Web Update, and 
About XXXXX where XXXXX is the name of the application.
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• Help - Clicking Help displays the User’s Guide for the application.

• Quick Reference - Quick Reference may be missing in some applications. 
When present, clicking Quick Reference displays a dialog box similar to the 
one shown below. The purpose of the Quick Reference dialog box is to show 
keys and mouse buttons that control some of the commonly used functions in 
various views. You can print it by clicking Print or close it by clicking OK.

— Print – Click Print to print a copy of the Quick Reference. 

• Web Update - This item allows you to update software via the internet. 
Clicking Web Update will first check to see if an update is available. If an 
update is available, it will be downloaded and installed.

• About - Clicking the About item displays the About dialog box. The text of 
the About item varies according to the application. The About dialog con-
tains the version number and build data of the application, links to the Plexon 
website and support e-mail, and buttons for Licensing, System Report, and 
Manage File Extensions.
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— Licensing - Clicking the Licensing button displays the Plexon License 
Management dialog box. The Plexon License Management window 
includes the complete licensing information for Plexon products. The 
window includes the following three areas: information, key testing, 
and code entry.
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– The information area includes information on license keys and a list 
of all the Plexon products and their licensed status on this computer. 

– If you have moved or added a key, the Test the Key Again button 
provides a convenient tool to test license keys to ensure they func-
tion correctly.

– If you have more than one key installed, the Next Key>> and 
<<Prev Key buttons appear. You may use these buttons to cycle 
through and test all keys.

– The code entry area is used to enter the unlock codes for optional 
programs and features. If you have licensed optional items, instruc-
tions for entering codes and testing keys are included with Plexon 
installation programs.

— System Report - The purpose of the System Report button is to help 
Plexon Support diagnose problems by listing system information. 
Clicking the System Report button will first display a dialog box to 
allow you to display the system report on the monitor or save the report 
to a file that can be sent via E-mail to Plexon Support. 

– After selecting a choice, clicking OK will launch the standard 

Microsoft® System Information tool. The image below shows the 
System Information report displayed on the monitor.
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— Manage File Extensions - Clicking the Manage File Extensions 
button opens the Manage File Associations dialog box. The Manage 
File Associations dialog box allows you to review and select which file 
types are associated with Plexon software applications. For example, 
when the PLX file type is associated with Offline Sorter, double-click-
ing on a PLX file will open Offline Sorter and load that PLX file. If 
you have not installed some of the applications, their file extension 
radio buttons will be disabled.

E.3.4 Messages Window

The Messages window displays a log of timestamps and associated application 
events that Plexon Support can use for troubleshooting purposes.

Note: The Messages window is not available for all applications.
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Right-clicking the mouse in the Messages window will display a right-click menu 
with the following items:

• Erase - This item clears the window of all messages

• Pause - This item stops the logging of messages

• Show Debug Messages - This item is a toggle to show or hide debug 
messages

• Select and Copy All - This item allows you to copy all of the messages to 
another application - such as a word processor

• Save Log to File - This item allows you to save the messages to a log file.

• Mail Log to Plexon - This item allows you to send the message log to 
Plexon for troubleshooting purposes

E.3.5 Right-click Menus

Most windows have right-click menus that control their behavior and options. To 
open a right-click menu, place the cursor inside a window and click and release 
the right mouse button. The right-click menu appears where the mouse is clicked. 
To select a menu item, move the cursor over it and click the left mouse button.

E.3.6 Current Selections

In grid-based windows, the currently selected item always appears with a >> or 
> in the left column of the appropriate grid-based window.

E.3.7 Undo

Plexon applications provide multiple undo levels. To undo an operation, on the 
Edit menu, click Undo or click the Undo button on the toolbar. You can undo 
operations that change the contents of the project file but may not undo 
operations that change the user interface options or colors.

E.4 Customization

Although the menus and toolbars offer a rich set of commands and functions that 
should meet the needs of most Plexon customers, the Customize dialog box also 
allows you to customize several areas of the interface should the need ever arise. 
This section describes the uses of the Customize dialog box.
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To open the Customize dialog box, from the Tools menu, select Customize. The 
Customize dialog box contains several tabs. The images below show the 
Customize dialog box from CinePlex Editor and displays five tabs - Toolbars, 
Commands, Keyboard, Run Menu, and Options. Although the content of the 
tabs will vary according to the application, the functional operation of each tab is 
respectively the same across all Plexon software applications.

E.4.1 Toolbars Customization

An image of the Toolbars tab follows:

• Toolbars - This box contains a list of the toolbars for the application. Click a 
toolbar checkbox to have it appear in the main application window. 

• New - This button opens the New Toolbar dialog box. You can use this 
feature to create a custom toolbar for commands frequently used. Enter a 
toolbar name in the Toolbar name box.

• Rename - If you have selected a toolbar that was previously defined, click 
Rename to change the name of the toolbar. The Rename Toolbar dialog box 
displays.

• Delete - If you have defined a new toolbar and selected it, click Delete to 
remove that toolbar. There are no default values for newly defined toolbars. 
Standard toolbars may not be deleted. A confirmation dialog box displays.

• Reset - If you have selected a standard toolbar, click Reset to restore the 
toolbar to its default contents. If new buttons have been dragged to a toolbar, 
click Reset to restore the default version of the toolbar. A confirmation dialog 
box displays.
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E.4.2 Commands Customization

The Commands tab is used to customize which commands are available in 
toolbars. An image of the Commands tab follows:

• Categories - This is a list of all the toolbar categories. Select a toolbar 
category to see the buttons in the Commands area.

• Commands - This area shows all the buttons and the associated menu com-
mands that belong to the selected category. You can select the desired com-
mand and drag it to the toolbar.

E.4.3 Keyboard Customization

The Keyboard tab allows you to bind keystrokes to commands. An image of the 
Keyboard tab follows:
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• Category - This is a list of all the main menu headings. Select a menu 
heading to category to see the associated commands in the Commands area.

• Commands - This is a list of all the commands associated with the selected 
main menu heading in the Category area.

• Key assignments - This displays the current key assignment for the 
command selected in the Commands area.

• Press new shortcut key - This allows you to enter a shortcut key 
combination for the command selected in the Commands area.

• Description - This area displays a description of the currently selected 
command in the Commands area.

• Assign - This button assigns the shortcut in the Press New Shortcut Key 
area to the selected command in the Commands area. If the shortcut key is 
already assigned to another command, a confirmation dialog box displays to 
allow or cancel the reassignment.

• Remove - This button removes the selected shortcut key in the Key 
Assignments area from the selected command in the Commands area.

• Reset All - This button removes all custom key assignments. A confirmation 
dialog box displays to allow or cancel the operation.



 

Version 3.7 E-21

Procedure for Customizing Keystroke Shortcuts

1 From the Window menu, select Customize, and then click the Keyboard tab 
of the Customize dialog box.

2 Choose a category from the Category dropdown and from the Commands 
list, select the desired command to bind to a keystroke shortcut.

3 If there is already a key assignment listed in the Key assignments area, 
remove it by clicking the Remove button if so desired. You can also just 
reassign a new key combination to the selected command. (See Step 5)

4 Click the mouse in the Press new shortcut key area.

5 Click the CTRL or ALT key and hold it down while clicking another key. The 
dual key combination will be displayed in the Press new shortcut key area. 
This combination will be the key assignment for the selected command.

6 Click the Assign button to assign the key combination to the selected 
command. If there already is a key assignment for the command, a 
confirmation box will display to confirm or cancel the reassignment.

Note: In CinePlex Editor, do not bind menu operations to keystrokes that 
are associated with markers. Use only CTRL- or ALT- key 
combinations to bind to menu items, as these key combinations 
cannot be associated with markers.

E.4.4 Run Menu Customization

The Run Menu tab allows you to manage menu items on the Run Menu. An 
image of the Run Menu tab follows:

• Menu contents - This is a list of all the menu items in the Run Menu. 
Select an item to see its characteristics in the Command, Arguments, and 
Initial Directory areas.
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• Buttons - The toolbar buttons allow you to add a new menu item, delete a 
selected menu item, move the selected menu item upward in the list, and 
move the selected menu item downward in the list.

• Command - This area contains the name of the file that runs when the menu 
item is selected from the Run Menu. The browse button opens the standard 
Open dialog box filtered for executable files.

• Arguments - This is a list of all the arguments to be passed to the file in the 
Command area, if any. The browse button opens the standard Open dialog 
box filtered for all files. When applicable, the symbol “%1” can be used to 
denote the current document.

• Initial Directory - This contains the path of the file in the Command area. 
The path allows the system to find the file and execute it. The Browse button 
opens the standard Browse For Folder dialog box.

Procedure for Customizing the Run Menu

1 From the Window menu, select Customize, and click the Run Menu tab.

2 To add a menu item, click the New icon, enter the command in the Command 
text box, enter any arguments in the Arguments text box, and set the 
applications directory in the Initial Directory text box. In each case use the 
appropriate Browse button at the right of the text box. The Browse button for 
the command opens the standard File Open dialog box filtered for executable 
files. The Browse button for the arguments opens the standard File Open 
dialog box filtered for all files. Then Browse button for the initial directory 
opens the Browse for Folder dialog box.

3 To delete a menu item, select it and click the Delete button.

4 To reorder the menu items, select a menu item and use the Up and/or Down 
arrow buttons to reorder.

E.4.5 Options Customization

An image of the Options tab follows:
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• Personalized Menus and Toolbars - This area contains two check boxes 
and a button. The application will hide infrequently used menu items, but you 
may customize the display of menu items using these two checkboxes. If you 
check the Always show full menus checkbox, the application will always 
show full menus and the Show full menus after a short delay checkbox will 
be disabled. If you do not check the Always show full menus checkbox, 
there will be the option of checking or clearing the Show full menus after a 
short delay checkbox. The Reset menu and toolbar usage data button will 
allow you to delete the record of commands used in the application and 
restore the default set of visible commands to the menus and toolbars. A 
confirmation dialog displays.

• Other - This area contains three checkboxes and a dropdown list. If you 
check the Large icons checkbox, the application will use large icons on the 
toolbar. If you check the Show Screentips on toolbars checkbox there will 
be the option of checking the Show shortcut keys in Screen Tips checkbox. 
The Menu animations dropdown list allows you to select the type of anima-
tion to be used on menus that have animation.
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